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Introduction

n the last few years, the Internet has experienced extraordinary growth

and has gone through incredible changes. As more and more users access
the web with smartphones, tablets, Apple TVs, dashboard-mounted touch-
screens in cars, and even tiny head-mounted displays on Google Glass, web
designers have been forced to design sites that work on devices from tiny
mobile screens to giant television sets.

Simultaneously, the technologies that work best on the web are changing.
The once popular design tool Adobe Flash is losing its audience because
videos and animations created in Flash don’t work on the iPad or iPhone.
Fortunately, HTML5 and CSS3 (the latest flavors of the Hypertext Markup
Language and Cascading Style Sheets, respectively), make it possible to add
new design features and greater interactivity without the need for Flash.

[ can’t cover every detail of all these technologies in this book, but I do give
you a solid introduction to modern web design. You discover how the newest
features in Dreamweaver CC make it easier to create web pages that meet
modern standards and adapt to all the screens used to view websites today.

In this fully updated version of Dreamweaver For Dummies, | added a new
chapter to show you how to create responsive web page designs that adjust
to fit different screen sizes, using Dreamweaver’s fluid grid layout features.

Over the years, web design has evolved into an increasingly complex field,
and Dreamweaver has evolved with it, adding features that go way beyond
the basics of combining a few words and images. Adobe’s dedication to keep-
ing up with changing standards and adding new features with each new ver-
sion is why Dreamweaver is such a popular program among professional web
designers, as well as among a growing number of people who want to build
sites for their hobbies, clubs, families, and small businesses.

In the 15-plus years that I've been writing about web design, I've seen many
changes — from the early days (before Dreamweaver even existed) when
you could create only simple pages with HTML 1.0, to the elaborate designs
you can create with Dreamweaver today using HTML5, CSS3, jQuery, multi-
media, and more.

If you're not sure what those acronyms mean yet, don’t worry. | remember
what it was like to figure out all this stuff, so I designed this book to introduce
you to the basic concepts before you get into the more advanced features.
To prepare you for the ever-changing world of web design, I show you how

to use Dreamweaver to create websites that take advantage of the latest
advances in web technology — including CSS3, covered in the Chapter 7, and
responsive design, covered in the brand-new Chapter 8.
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One of the challenges of web design today is that web pages are not only
displayed on different kinds of computers but also downloaded to comput-
ers with monitors as big as widescreen televisions — or as small as the

little screens on cell phones. As a result, creating websites that look good to
all visitors is a lot more complex than it used to be — and standards have
become a lot more important. This book shows you not only how to use all
the great features in Dreamweaver but also how to determine which of those
features best serve your goals and your audience.

About This Book

Using

[ designed Dreamweaver CC For Dummies to help you find the answers you
need when you need them. You don’t have to read through this book cover
to cover, and you certainly don’t have to memorize it. Consider this a quick
study guide and a reference you can return to. Each section stands alone,
giving you easy answers to specific questions and step-by-step instructions
for common tasks.

Want to find out how to change the background color in page properties,
design CSS style rules to align images, or add an interactive photo gallery
with the Swap Image behavior? Jump right to the pages that cover those fea-
tures. (Hint: the Table of Contents and index can help you find the sections
that interest you most.) Don’t worry about getting sand on this book at the
beach or coffee spilled on the pages at breakfast. I promise it won’t complain!

You find templates, artwork, and other goodies to use with this book at
www.DigitalFamily.com/bonus.

Dreamweaver on a Mac or PC

Dreamweaver works almost identically on Macintosh or Windows computers.
To keep screenshots consistent throughout this book, I've used a computer
running Windows 7. However, I've tested the program on both platforms, and
whenever I find a difference in how a feature works, I indicate that difference
in the instructions.

Conventions Used in This Book

Keeping things consistent makes them easier to understand. In this book,
those consistent elements are conventions. Notice how the word conventions
is in italics? I frequently put new terms in italics and then define them so you
know what they mean. It just makes reading so much nicer.
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When I type actual URLs (web addresses) in regular paragraph text, they look
like this: www.digitalfamily.com.

[ also assume that your web browser doesn’t require the introductory
http:// for web addresses. If you use an older browser, remember to type
that quaint prefix before the address (also make sure you include that part of
the address when you’re creating links in Dreamweaver).

Even though Dreamweaver makes understanding HTML pages easier, you
may want to wade into HTML waters occasionally. [ include HTML code in
this book when I think it can help you better understand how things work in
Design view. Sometimes it’s easier to remove or edit a tag in Code view than
Design view. When [ do provide examples — including filenames, file exten-
sions, attributes, and tags, such as the following code that links a URL to a
web page — I set off the HTML in monospaced type:

<a href="http://www.digitalfamily.com">Learn more about
Dreamweaver at Janine's DigitalFamily website</a>

When I introduce you to a new set of features, such as options in a dialog
box, I set those items apart with bullet lists so you can see that they're all
related. When [ want you to follow instructions, I use numbered step lists to
walk you through the process.

What You've Not to Read

If you're like most of the web designers [ know, you don’t have time to wade
through a thick book before you start working on your website. That’s why I
wrote Dreamweaver CC For Dummies in a way that makes it easy for you to find
the answers you need quickly. You don’t have to read this book cover to cover.
If you're in a hurry, go right to the information you need most and then get
back to work. If you’re new to web design or you want to know the intricacies
of Dreamweaver, skim through the chapters to get an overview — and then go
back and read what’s most relevant to your project in greater detail. Whether
you're building a simple site for the first time or working to redesign a complex
site for the umpteenth time, you find everything you need in these pages.

Foolish Assumptions

Although Dreamweaver is designed for professional developers, I don’t
assume you're a pro — at least not yet. In keeping with the philosophy
behind the For Dummies series, this book is an easy-to-use guide designed for
readers with a wide range of experience. If you're interested in web design
and want to create a website, that’s all I expect from you.
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If you're an experienced web designer, Dreamweaver CC For Dummies is

an ideal reference for you because it gets you working quickly with the
program — starting with basic web-page design features and progressing to
more advanced options. If you're new to web design, this book walks you
through all you need to know to create a website, from creating a new page
to publishing your finished project on the web.

How This Book Is Organized

To ease you through the learning curve associated with any new program,

I organized Dreamweaver CC For Dummies as a reference. This section pro-
vides a breakdown of the four parts of the book and what you can find in
each one. Each chapter walks you through the features of Dreamweaver step
by step, providing tips and helping you understand the vocabulary of web
design as you go along.

Part I: Getting Started with Dreamweaver CC

Part I introduces you to the basic concepts of web design as well as the

main features of Dreamweaver. In Chapter 1, I give you an overview of the
many approaches to web design, so you can best determine how you want

to build your website before you get into the details of which features in
Dreamweaver are best suited to any particular design approach. In Chapter 2,
[ start you on the road to your first website — including creating a new site,
importing an existing site, creating new web pages, applying basic formatting,
and setting links. To make this chapter more interesting and help you see
how all these features come together, I walk you through creating a real web
page as I show you how the features work.

In Chapter 3, I move on to graphics, with an introduction to creating graph-
ics for the web, an overview of the differences in formats (GIFs, JPEGs, and
PNG files), and detailed instructions for adding and positioning graphics in
your pages. In Chapter 4, you discover Dreamweaver’s testing and publishing
features, so you can make sure that all your links work and that your website
will look good in the most important web browsers. You also find everything
you need to start uploading pages to the Internet.

Part II: Creating Page Designs with Style

Chapter 5 provides an overview of how Cascading Style Sheets work and
how they can save you time. CSS has become the way to create page designs
and manage formatting on web pages, and these features have been dramati-
cally improved in Dreamweaver CC. In this chapter, you find descriptions of
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the style definition options available in Dreamweaver as well as instructions
for creating and applying styles. In Chapter 6, I take you further into CSS,
introducing you to the power of <div> tags, how to create CSS layouts, how
to create centered CSS designs, and how to use Dreamweaver’s newest CSS
testing features. In Chapter 7, | show how Dreamweaver CC has more fully
integrated some of the hot new design options, such as drop shadows and
gradients, which were made possible by CSS3.

In Chapter 8, I introduce fluid grid layouts, which make it easier to create
websites using a new technique called responsive design. The advantage of
responsive design, sometimes called adaptive design, is that it enables you
to create page layouts that adjust to different screen sizes so that they look
as good on tiny smartphone screens as they do on giant desktop monitors.

In Chapter 9, I cover the use of templates and Dreamweaver’s Library items,
which come in handy for commonly used elements, such as the copyright

on all your web pages. In Chapter 10, I take a look at HTML Tables, and show
where and how this time-honored technique is still relevant with modern web
design.

Part 1II: Making Your Site Cool
with Advanced Features

In Part III, you discover how cool your site can look when you add interactive
images, audio, video, and drop-down menus. In Chapter 11, you find instruc-
tions for creating an interactive photo gallery with the Swap Image behavior,
as well as how to use other features in Dreamweaver’s Behaviors panel —
including the Open New Browser behavior. In Chapter 12, you discover how
great the Spry features are for adding AJAX interactivity to your site. You
find instructions for creating and customizing drop-down lists, collapsible
panels, and more. In Chapter 13, you find out what it takes to add multimedia
to your web pages, including how to insert and create links to a variety of file
types — from Flash to HTML5 animations, and video and audio files.

Part IU: The Part of Tens

Part IV features two quick references to help you develop the best websites
possible. Chapter 14 provides a collection of online resources where you can
register domain names and find hosting services, as well as a few services
that can help you take care of more advanced challenges (such as setting up
interactive forms and e-commerce shopping carts). In Chapter 15, you find
ten ways to promote your website, from search engine optimization to social
media and beyond.

5



Dreamweaver CC For Dummies

Icons Used in This Book

This icon points you toward valuable resources on the web.

This icon reminds you of an important concept or procedure that you’ll want
to store away in your own memory banks for future use.

This icon signals technical stuff that you may find informative and interest-
ing, though it isn’t essential for using Dreamweaver. Feel free to skip over this
information.

This icon indicates a tip or technique that can save you time and money —
and a headache — later.

This icon warns you of any potential pitfalls — and gives you the all-important
information on how to avoid them.

Where to Go from Here

To familiarize yourself with the latest in web design strategies and options,
don’t skip Chapter 1, which guides you through the many ways to create web-
sites that you have to choose from today. If you're ready to dive in and build

a basic website right away, jump ahead to Chapter 2. If you want to find out
about a specific trick or technique, consult the Table of Contents or the index;
you won’t miss a beat as you work to make those impossible web design dead-
lines. Most of all, I wish you great success in all your web projects!

Occasionally, we have updates to our technology books. If this book does
have technical updates, they will be posted at

dummies.com/go/dreamweaverccfdupdates
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In this part . . .

Compare different layout techniques you can use in
Dreamweaver.

Explore the toolbars, menus, and panels that make up
Dreamweaver's interface.

Set up a website, create web pages, and add text, links, and
meta data for search engines.

Optimize web graphics, with instructions for using Photoshop
(or Photoshop Elements) to covertimages to GIF, PNG, and
JPEG formats.
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The Many Ways to Design
a Web Page

In This Chapter

Comparing static and dynamic site options
Organizing your site’s design and files

Saving time with static and dynamic templates
Choosing between tables, frames, layers, and CSS
Handling browser differences in web design
Customizing your Dreamweaver workspace

n the mid-1990s, learning to create websites — and teaching J—

others how to do it — was easy. Almost 20 years and as - - ‘
many books later, the process has become much more = !
complex. I've come to realize that one of the first things
to understand about web design is that there isn’t just
one way to create a website anymore.

In this chapter, I being with an introduction to the
many ways you can create a website and the tools
Dreamweaver offers to make those designs possi-
ble. I also introduce you to the basics of HTML and
how websites and browsers work. At the end of this
chapter, you find a quick tour of the Dreamweaver
CC interface to help you get comfortable with the
workspace.
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Compatring Static and Dynamic Sites

A\\S

Websites fall into two very broad categories: static sites, which are generally
built with a program such as Adobe Dreamweaver, and dynamic sites, which
combine advanced programming with a database to generate web pages
dynamically.

A static site is like a unique book, where each page has been created by hand.
The process can be compared to illuminated manuscripts, where monks
toiled for years and each page was an individual work of art. Static websites
are made up of a collection of individual pages with the .html or .htm exten-
sion. You might think that all websites are made up of individual pages (and
in a way they are), but with a static site, each page is saved as a separate file.

In contrast, a dynamic site works more like a warehouse full of words, images,
videos, and colors with a super-fast clerk who can run at light speed through
the aisles, grabbing items and assembling them into pages as you read them.
With a dynamic site, the pages you view in a web browser are created as they
are delivered to the browser, so they're not saved as individual pages but

as pieces of pages that can be mixed and matched. That gives dynamic sites
many advantages, but it also makes them a lot more complicated to create.
On a large website such as Amazon.com, for example, this dynamic process
makes it possible for Amazon to create a page with recommended books for
you that looks different from the page it recommends to me, even though
we’re both entering the same URL into a web browser.

If you're just creating a simple profile or small business site, go with a static
site. Dynamic websites are often not worth the extra effort, unless you'’re cre-
ating a site that you expect to grow to 100 pages or more.

Although you can create custom dynamic websites in Dreamweaver using
popular technologies such as PHP or ASP.NET, most programmers who are
creating sites with Amazon.com levels of complexity use more advanced pro-
gramming tools, such as Eclipse or Microsoft Visual Studio.

[ used to teach the basics of dynamic site creation in Dreamweaver, but
today better options exist. Instead of reinventing the wheel by creating their
own dynamic site system with Dreamweaver, many web designers are using a
content management system (CMS), such as WordPress and Drupal.

Following are some of the most popular content management systems:

1 WordPress (www.wordpress.org of www.wordpress . com): One of the
most popular and powerful blogging tools, WordPress is increasingly used
as a CMS for more complex sites. You'll find many great extensions for
WordPress. After a site is built, teaching people to use the administrative
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tools to update the site (even if they don’t know HTML) is relatively easy,
making this an especially popular tool among web designers who are cre-
ating sites that they want their clients to be able to update themselves.

v Joomla! (www.Joomla.org): Joomla! offers many of the features of
WordPress. Joomla! is a good choice for magazine-style sites and direc-
tories because it enables you to create categories and subcategories far
more easily than in WordPress.

* Drupal (www.drupal .org): Designed by programmers for program-
mers, Drupal offers more advanced functionality for creating highly
complex, interactive websites. Sites where security is a concern (such as
the sites for the U.S. State Department, Congress, or many universities)
often use Drupal. Drupal is a powerful CMS, but the learning curve is
steeper than for WordPress or Joomla!.

You can use Dreamweaver to create and edit templates for any of the content
management systems listed here. Before you do, however, you have to set up
a web server on your local computer. You learn more about how to work with
these programs in the section, “Working with Templates in Dreamweaver,”
later in this chapter.

If you're interested in learning more about WordPress, check out WordPress
For Dummies, 5th Edition, by Lisa Sabin-Wilson (Wiley).

Most of this book is dedicated to helping you create static websites — but
that doesn’t mean you can’t get many of the same benefits of dynamic sites,
including the capability to update pages quickly. As you find in this book, you
can combine Cascading Style Sheets, or CSS (covered in Chapters 5-8), with
Dreamweaver’s .dwt template features (covered in detail in Chapter 9) and
get many features of a big-budget website without all the complicated pro-
gramming skills. (You find a general description of Dreamweaver’s template
features, as well as a look at the differences among templates, later in this
chapter.)

Static pages work well for small- and medium-sized websites, such as a
professional profile or online gallery. Because static web pages are writ-

ten in plain text, you can create them in a program as simple as Notepad or
SimpleText, although tools such as Dreamweaver make designing pages a lot
easier because you don’t have to remember all the cryptic HTML tags.

A static website offers a few advantages, especially if you're just starting
out. A static website

1~ Is easy to learn to develop: Anyone who can resize a photo has a head
start on the skills needed to create and arrange graphic elements on a
static page.

11
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1 Gives you complete control over the design of each page: You can
tweak the size, colors, fonts, and arrangement of the elements on each
page individually, and you can edit templates for these kinds of sites
more easily than the templates for dynamic sites.

1~ Is easy to build, test, and publish to a web server: You can create and
test static web pages on any personal computer and then host them on
any commercial web server — and you need only FTP access (built in to
programs such as Dreamweaver) to publish pages to the Internet.

Working with Templates in Dreamweaver

NNG/
Vg‘

The term template is used in different ways for different kinds of design work
(on and off the web), but essentially a template is a shortcut in the design
process. By working with Dreamweaver templates, you can set or adjust
almost any aspect of a site’s design or functionality, including a header, logo,
navigation bar, or sidebar. Whatever you include in a Dreamweaver template,
you can then apply to any new page based on the template, which automati-
cally applies the settings you want to appear throughout your site. Moreover,
if you want to adjust the overall settings in your site, you can make those
updates once in the template, update your pages, and — voila — all pages
based on the template are updated automatically.

But not all templates are created equally. Although they all share those basic
characteristics, many kinds of templates are in use on the web today. For
example, templates for static websites (which you find instructions for creat-
ing in Chapter 9) are quite different from the kinds of templates you would
use if you were creating a blog with WordPress.

You can download many kinds of templates from the web, but they don’t all
work in all programs. For example, if you download templates designed for

Adobe Flash, you won’t be able to use them in Dreamweaver (although you

can insert Flash files in Dreamweaver, as you discover in Chapter 13).

You can edit many kinds of templates in Dreamweaver. Before you start
using Dreamweaver to create or edit templates, however, it’s helpful to
better understand how they are different. The following sections cover two
of the most common types of templates in use on the web today (and what
you should know about how they differ). See the nearby sidebar, “So many
Dreamweaver template options,” for a complete list of template options.
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Creating and editing Dreamweaver templates

Dreamweaver templates (extension . dwt) offer many advantages without
requiring advanced programming skills. When you create Dreamweaver tem-
plates with the . dwt extension, you can use HTML and CSS to create static
websites that include many of the high-end features found on dynamic sites —
such as the capability to create new pages quickly and to update every page

in your site with the click of a button.

Although you can use Dreamweaver to create templates that use advanced
programming (such as PHP or Java), the .dwt Dreamweaver template is a

much simpler option that’s ideal for small- to medium-size websites — which
is why I've dedicated much of Chapter 9 to making the most of Dreamweaver

templates.

Editing WordPress, Joomla!, and Drupal templates

Templates like the ones you get with a blogging program such as WordPress

use the extension . php because they’re written in the PHP (Hypertext
Preprocessor) programming language. Although you can create PHP pages

and templates in Dreamweaver and use them for more than just WordPress,
these types of files are far more complex to create than . dwt Dreamweaver

templates.

Because so many people use WordPress (such as the blog shown in
Figure 1-1) and so many sites offer WordPress template downloads,
many people are confused about why WordPress templates don’t work in
Dreamweaver in the same way that . dwt Dreamweaver templates work.

So many Dreamweaver template options

Dreamweaver supports many kinds of technolo-
gies, as well as the templates that go with each.
When you create new pages in Dreamweaver
by choosing File=>New, you have the option
of creating a blank page or a blank template.
When you create a simple HTML template,
Dreamweaver uses the .dwt extension.
Dreamweaver also supports Microsoft ASP
and ASP.NET, and you can create templates
using either ASP JavaScript or ASP VBScript
(both of which use the . asp extension) — or

you can use ASP.NET C# or VB (which use the
. aspx extension). The templates for a site cre-
ated using Java end in . jsp. And if you use
Adobe’s ColdFusion technology, your templates
endin .cfm.

The big lesson is this: Make sure you have the
right kind of template for the kind of site you're
creating— and rest assured that Dreamweaver
supports just about any kind of technology you
can use to create a website.

13
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Figure 1-1: | used WordPress to create this blog on my
DigitalFamily.com site.

WordPress templates offer many of the same benefits as Dreamweaver
templates — except that templates for blogs such as WordPress draw their
content from a database. As a result, they include HTML and CSS (as do the
Dreamweaver templates), plus much more complicated code in the PHP pro-
gramming language, which describes how content from the database should
be displayed in a web page.

As a result, to make WordPress, Joomla!, or Drupal templates work in
Dreamweaver, you must first set up your computer as a web server and
install MySQL and WordPress. Because so many people are using these
programs, you can get all the software you need in one nifty package from
MAMP.com (for Mac) and XAMP.com (for Windows). You will find links to
these tools, as well as instructions for using them to set up your computer
as a web server, at wow.digitalfamily.com/tutorials/set-up-a-
testing-server-on-your-computer/.

Assessing Other Web Design Tools

People who just want to set up a web page as quickly and simply as pos-
sible can turn to services that offer what designers call a “website in a box.”
Web-based services such as SquareSpace, Sitegrinder, and Zenfolio provide
templates you can use to design your site and as well as basic customization,
usually for a monthly fee.
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http://www.digitalfamily.com/tutorials/set-up-a-testing-server-on-your-computer/
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Although this approach works for simple sites, these services often promise
more than they deliver, especially when it comes to customization or adding
new features. Your site may also be vulnerable: If the service ever changes
their business model or goes out of business, you can be left at their mercy.

In contrast, Dreamweaver enables you to create a completely custom website
and host it on your choice of hundreds of hosting services. If your hosting
service raises rates or goes out of business, you can simply move your site to
a new host.

Understanding How to Build a
Website in Dreamweaver

In a nutshell, building a website involves creating individual pages and linking
them to other pages. You need to have a home page, the first page visitors
see when they arrive at your web address (also known as your URL), and that
page needs to bring them into the rest of the pages of the site, usually with
links to each of the main sections of the site. Those pages, in turn, link to sub-
sections that can then lead to deeper subsections.

After you create a website, you can test all the links on your own hard
drive and then upload the pages to a web server when everything is ready
and working well. You can read more about setting up a site and using
Dreamweaver to create pages on your local computer in Chapter 2. In
Chapter 4, you discover how to upload your pages to a web server when
you'’re ready to publish your site on the Internet.

The most important thing to remember is that you need to create a folder on
your local computer that will mirror your website on your web server when
you publish your site. The site setup process in Chapter 2 is so important
because it sets up Dreamweaver to help you create these two versions of your
site: the version you create and edit on your computer and the copy you need
to maintain on the web server.

Although you have to save all the files in your site in one main folder, you can
create subfolders to organize the site. Thus, a key part of planning a website

is determining how to organize the pages of your site into sections and how
those sections should link to one another. Dreamweaver makes creating pages
and setting links easy, but how you arrange the pages and links is up to you.

<P If you're just planning to create a small website, you may think you don’t
need to worry about how your site will grow and develop. Think again. All
good websites grow, and the bigger they get, the harder they are to manage.
Planning the path of growth for your website before you begin can make a

15
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tremendous difference later. Neglecting to think about growth is probably
one of the most common mistakes among new designers. This oversight
becomes even more serious when more than one person is working on the
same site. Taking a little time to organize the structure of your site, and
developing a few consistent conventions for tasks such as naming files, can
make everything else go more smoothly.

Managing your site’s structure

Managing the structure of a website has two sides: the side that users see,
which depends on how you set up links, and the side that’s behind the
scenes, which depends on how you organize files and folders.

What the user sees

The side that the user sees is all about design and navigation. When users
arrive at your home page, where do you direct them? How do they move
from one page to another in your site? A good website is designed so that
users navigate easily and intuitively and can make a beeline to the informa-
tion most relevant to them. As you plan, make sure that users can

1 Access key information easily from more than one place in the site
1 Move easily between pages and sections

1 Return to main pages and subsections in one step

Setting links is easy in Dreamweaver; the challenge is to make sure that those
links are easy for visitors to follow. One of the best ways to ensure that visi-
tors can easily move around your site is to create on every page of your site a
navigation or menu bar that includes links to the main pages of your site. You
find instructions in Chapter 6 for creating a menu bar with CSS. In Chapter 12,
you find out how to use Dreamweaver’s jQuery Ul features to create interac-
tive menus with tab groups and collapsible panels. And in Chapter 9, you find
instructions for using Dreamweaver’s template and library features, which
make menus easier to include on your pages — as well as faster to update if
you add or change a menu link later.

What's behind the scenes

The second side to managing your website structure happens behind the
scenes (where your users can’t see the information, but you want some kind
of organizational system to remember what’s what). Before you begin design-
ing and linking the pages in your site, think about how to keep track of all the
text, images, animations, and other files that make up your site. At minimum,
consider the following:
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1~ A file-naming system: For example, naming image files consistently can
make them easier to find if you need to edit them later. For example, if you
use thumbnail images as well as bigger versions, give both files similar
names to make it easier to match them later. An easy way to do that is to
add th to the thumbnail versions, like this: bird. jpg and bird-th. jpg.
Similarly, giving the main section pages in your site names that match
the text of the links on your pages can make setting the links easier. For
example, if the navigation bar on your home page includes an About Us
page and a Contact page, you can easily figure out what page a link should
point to if your pages are named aboutus.html and contact.html.

1~ A folder structure: When your website grows past a handful of pages,
organizing them in separate folders or directories can help you keep
track. Fortunately, Dreamweaver makes this easy by providing a Files
panel where you can see all the files of your site — and even move
and rename files and folders (see Chapter 2 for more on how to use
Dreamweaver’s Files panel).

Exploring HTML, XHTML, and HTML5

Contrary to popular belief, HTML isn’t a programming language. Rather, it’s a
markup language: That is, HTML is designed to mark up a page, or to provide
instructions for how a web page should look. HTML is written by using tags,
which are markup instructions that tell a web browser how to display the
page. For example, to apply italic formatting to text, you (or Dreamweaver)
insert the HTML tag <em>, which stands for emphasis, where you want the
italics to begin and end. Most tags in HTML include both an open tag and a
close tag, indicated by the forward slash /. Thus, to make the name of this
book appear in italics, I would write the code like this:

<em>Dreamweaver CC For Dummies</em>

Another challenge of HTML is that the tags have changed over time, and so
has the acronym. When I'm referring to the code in a general way, I use the
acronym HTML, but the two most popular versions of HTML today are really
called XHTML and HTMLS5.

XHTML, a stricter version of HTML, is still in use on a majority of websites.
HTMLS5, which has garnered lots of hype, is the newest version, and most
forward-thinking designers or people who are redesigning older sites are
moving to HTML5. Although HTML5 hasn’t been officially approved as a stan-
dard, most of the new tags introduced in this latest version are already sup-
ported by the latest versions of all major web browsers.

17
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You have two ways to see what the code behind a web page looks like:

+~ In most browsers, choose Viewr>Source.

v~ 1f you're using Dreamweaver (as shown in Figure 1-2), you can click the
Split button (upper-left corner of the workspace) to see the code and the
design areas of the program at the same time in Split view.

If you want to see only the code, click the Code button. However, while I'm
working on the site design, I find Split view is a useful way to keep an eye on
what’s going on behind the scenes — and, as a bonus, you can learn a lot of
HTML as you go along. Split view also makes it easy to find code related to

a specific element or section of text. In Figure 1-2, for example, I've selected
the headline in Design view, and Dreamweaver automatically highlighted the
same text in Code view, making it easy to see that the headline is formatted
with the <h1> tag.
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Photos by Casey Stoll
Figure 1-2: Use Split view in Dreamweaver to display the page design and the code behind
the page.
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How web browsers work

Web browsers such as Internet Explorer,
Firefox, Chrome, and Safari are designed to
decipher HTML, CSS, JavaScript, and other
code — and display the corresponding text,
images, and multimedia on a computer screen.
Essentially, browsers read the code in a web
page and interpret how to display the page to
visitors. Unfortunately, because web brows-
ers are created by different companies and the

code they display has evolved dramatically over
the years, not all web browsers display web
pages the same way. Differences in browser
display can lead to unpredictable (and often
frustrating) results because a page that looks
good in one browser may be unreadable in
another. For more information on browser dif-
ferences and testing your pages to make sure
they look good to all your visitors, see Chapter 4.
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Dreamweaver offers four view options:

1 Code view: In Code view, you see only the HTML and other code.

v~ Split view: In Split view, the page is divided so you can see the code in
one part of the workspace and a view of how the page should be dis-
played in a web browser in the other part.

1~ Design view: In Design view, you see only the page as it should be dis-
played in older web browsers.

v~ Live view: In Live view, you get a more accurate preview of how your
pages will look in the latest web browsers, and you get an interactive
view, where you can test rollovers and other interactive features with-
out having to leave Dreamweaver and launch another program.

In Dreamweaver’s Split view, the Code and Design views are integrated. If you
select something in Design view — say, the headline shown in Figure 1-2 —
you see the same text highlighted in Code view, enabling you to find your
place easily in the code.
\\3
Here are a few points to help you better understand the similarities and dif-
ferences among older versions of HTML as well as XHTML and HTMLS5:

v~ All versions of HTML include tags that are designed to be hierarchi-
cal. Examples are the <h1> (heading 1) through <hé6> (heading 6) tags,
which are ideally suited to formatting text according to its importance
on a web page. Reserve the <h1> tag for the most important text on the
page, such as the top headline. The <h2> tag is ideal for subheads or
secondary headings, <h3> for the third level of headings, and so on. A
headline formatted with the <h1> tag looks like this:

<hl>This is a headline</hl>
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1 HTML5 adds new tags. HTML5 adds a collection of tags designed to
make webpages more semantic, or more meaningful. New tags, including

<header> and <footer>, can be used to identify the type of content in
a webpage.

1~ XHTML tags must be written in lowercase. HTML5 and older versions
of HTML are not case sensitive.

1 In XHTML, all tags must include the closing slash. A few tags can
stand alone, such as the <br /> tag, which adds a line break. As a rule,
XHTML tags must have a close tag, even if there’s only one tag, and the
close tag must always contain a forward slash (/). Thus the line break
tag is <br> in HTML and <br /> in XHTML.

1~ Some tags are more complex, and the open and close tags don’t
always match. More complicated tags, such as the tags used to create
links or insert images into pages, are more challenging to use because
they include link information, and the close tag doesn’t always match

the open tag. For example, the code to create a link to another website
looks like this:

<a href="http://www.digitalfamily.com">This is a link to
DigitalFamily.com</a>

At their heart, all versions of HTML are just text — and believe it or not,

you can write HTML in a plain-text editor as simple as Notepad, SimpleText,
or TextEdit. However, you have to be careful to type all the code perfectly
because there is no room for error or typos in HTML. After writing code your-
self, even to create a simple page, you're sure to appreciate how wonderful it
is to let Dreamweaver write the code for you.

MBER If (at first glance) you think that HTML code looks like hieroglyphics, don’t
give up too quickly. With just a little practice, you can start to recognize at
least the most common tags, such as <h1> (heading 1) tag used to format the
headline shown in Figure 1-3.
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Figure 1-3: A heading 1 tag highlighted in Code view.
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Comparing Tables, Frames, and Layers

If you've already done a little web design, you may be wondering what hap-
pened to some of the old ways of creating web page layouts. For years, web
designers used the HTML feature called tables to create page layouts. Then
frames came along, and many people were excited by the capability to dis-
play multiple pages in one browser window (which frames and iFrames make
possible). Then came layers, which were especially popular among designers
because they seemed to offer precise design control.

Today, most professional designers agree that the best way to create a

web page design is to use HTML with Cascading Style Sheets, which are
covered in detail in Chapters 5-7. In Chapter 8, you find out how to use
Dreamweaver’s new fluid grid layouts to combine one HTML file with mul-
tiple sets of style sheets to create responsive designs that work well on both
small mobile screens and large monitors.

Over the years, all these other options have become less desirable except in
a few special cases. In this section, you find a quick review of when tables,
frames, and layers may still be useful.

Creating page designs with HTML tables

In the early days of web design, most page layouts on the web were created
with tables. By merging and splitting table cells and even adding background
images, designers created complex web designs. CSS expands upon this con-
cept by adding many new design options — including the capability to add
precise margins and padding around elements, which offers better control of
how and where background images appear.

Figure 1-4 provides an example of an old-school site created with the HTML
table tag. Most designers turn off table borders by setting the table border
to 0 to create cleaner layouts, but in Figure 1-4, I've set the borders to 2 pixels
so you can see the outline of the table. Table cells surround each of the
photos and captions in this two-column layout; I've merged the columns at
the top of the design to make room for the banner image, which spans the full
width of the page.
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Figure 1-4: In the old days, complex web page designs used
HTML tables to control text and image placement.

Although tables are no longer recommended for creating page layouts,
they’re still considered the best way to format tabular data like that you'd
find in a spreadsheet program. You can use tables to format a consistent col-
lection of information — such as the table listing the winners of the chocolate
game, as shown in Figure 1-5. (You find out how to create tables to format
tabular data, like the table shown in Figure 1-5, in Chapter 10.)

Although I recommend that you redesign sites like the one shown in Figure 1-4
with CSS and <div> tags, [ do understand that some designers still find it
easier to create layouts with tables, and not everyone has time to redesign
their websites right away. I have to admit, I've been guilty of leaving online

a few sites designed with tables long after I knew better. | recommend using
only CSS today for all your web page layouts — except when you’re creating a
layout for tabular data. Even then, [ still urge you to use CSS to add any styling
(such as background colors or padding) that you might want in your tables.
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Figure 1-5: Tables are still the best way to display tabular data in columns and rows.

Considering design options with HTML frames

You won't find any instructions in this book for creating websites that use
frames, such as the website about flamingos shown in Figure 1-6. Frames
enable you to display multiple web pages in one browser window. Although
frames are still used on a few sites on the web, most designers don'’t like
them because they can make navigation confusing to site visitors.

Frames are also problematic because when you use frames, the URL at the
top of a web browser does not change, even when you click links and change
the pages displayed within the frames. As a result, you can only bookmark
(create a link to) the first page of a site that uses frames. Worse yet, search
engines have a hard time properly indexing a site designed with frames —
which can diminish your site’s search engine ranking.
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Figure 1-6: Frames enable you to display multiple web pages in
one browser window.

For all these reasons, Adobe removed the features that supported frames in
Dreamweaver CC. If you discover that a website you're redesigning was cre-
ated with multiple pages displayed in one browser window, [ suggest that you
redesign the site to remove the use of frames. Using CSS is a far better way to
create page layouts today.

Appreciating the Benefits of
Cascading Style Sheets

The concept of creating styles has been around since well before the web.
Desktop publishing programs (such as Adobe InDesign) and even word pro-
cessing programs (such as Microsoft Word) have long used styles to manage
the formatting and editing of text on printed pages. In a word processor, you
can create and save styles for common features, such as headlines and cap-
tions. In print design, styles are great timesavers because they enable you to
combine a collection of formatting options (such as Arial and bold and italic)
into one style — and then apply all those options at once to any selected
text in your document, using only a single style. The advantage is that if you
change a style, you can automatically apply the change everywhere you've
used that style in a document.



Chapter 1: The Many Ways to Design a Web Page

On the web, you can do all that and more with CSS — because you can use
style sheets for more than just text formatting. For example, you can use
CSS to create styles that align images to the left or right side of a page, add
padding around text or images, and change background and link colors. You
can even create more than one style sheet for the same page — say, one that
makes your design look good on computers, another for cell phones, and a
third for a printed page.

For all these reasons (and more), CSS has quickly become the preferred
method of designing web pages among professional web designers. One of
the most powerful aspects of CSS is that it enables you to make global style
changes across an entire website. Suppose, for example, that you create a
style for your headlines by redefining the <h1> tag to create large, blue, bold
headlines. Then, one fine day, you decide that all your headlines should be
red instead of blue. If you aren’t using CSS, changing all your headlines could
be a huge undertaking — a matter of opening every web page in your site to
make changes to the font tags around every headline. But if you’re using CSS
in an external style sheet, you can simply change the style that contains for-
matting information for the <h1> tag in the style sheet and all your headlines
turn red automatically. If you ever have to redesign your site (and believe
me, every good site goes through periodic redesigns), you can save hours (or
even days) of work if you created your design with CSS in the first place.

A website designed with CSS separates content from design. Keeping the con-
tent of your site (such as the text and headings) separate from the instruc-
tions that tell a browser how the content should look benefits both you as a
designer and your site visitors. Here are some of the advantages:

1~ CSS simplifies design changes. CSS styles can be saved in the header
section at the very top of an HTML page, or they can be saved in a sepa-
rate file that can be attached to multiple HTML pages. Either way, if you
use a style to format many headlines, you can make formatting changes
by simply editing the style.

1~ Separating content from design enables you to create different style
sheets for different audiences and devices. Today’s websites are as
likely to be viewed on giant, wall-size screens as they are to be seen on
screens small enough to hide in the palm of your hand during a lunch
date. CSS enables you to create web page designs that are more adapt-
able so they look good on big and small screens, as well as everything in
between.

As you get more advanced with CSS, you can even create multiple style
sheets for the same web page. For example, you can create one that’s
ideally suited to a big computer monitor, another that’s designed to get
the best results when the page is printed, and yet another designed with
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a larger font size for anyone who may have trouble reading the small
print that’s so common on web pages.

1~ Using CSS makes your site comply with the current standards. Today,
the W3C, which sets standards for the Internet, recommends using CSS
for nearly every aspect of web design because the best CSS designs are
accessible, flexible, and adaptable.

1~ Websites designed in CSS are accessible to more visitors. Today, a
movement is growing among some of the best designers in the world to
get everyone to follow the same standards, create websites with CSS,
and make sure sites are accessible to everyone.

When web designers talk about accessibility, they mean creating a site
that anyone who might ever visit your pages can access — including
people with limited vision who use special browsers (often called screen
readers) that read web pages aloud, as well as many others who use spe-
cialized browsers for a variety of other reasons.

If you work for a university, a nonprofit, a government agency, or a simi-
lar organization, you may be required to create accessible designs. Even
if you're not required to design for accessibility, know that pages that
meet accessibility standards also tend to score better in search engine
rankings because accessible designs also enable search engines to
access and interpret site content more easily.

In Chapters 5 and 6, you find an introduction to creating styles and page
designs with CSS. In Chapter 7, you find an introduction to some of the new
features introduced in CSS3. In Chapter 8, you find out how to use the latest
web design techniques to create responsive designs that work on small
mobile screens as well as large monitors by targeting multiple style sheets
based on the size of the browser window.

Understanding Browser Differences

HTML was created to share information in a way that could be displayed on
every computer on the planet — one of the greatest advantages of the web.
However, for web designers, this advantage is also a challenge because not
all those computers use the same browsers, the same fonts, or the same
monitor size. On top of that, a lot of older web browsers that can’t display
the latest web features are still in use and even newer browsers don'’t all
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display pages that use those features in the same way. So before you start
creating web pages, know that no matter how carefully you create your
designs, your pages will never look exactly the same to every possible visitor

to your site.
<MBER If you want to create page designs using the latest technology and reach the
S broadest possible audience, pay special attention to Dreamweaver’s Live

view, browser preview, and compatibility features — and be prepared to
move on to training that’s more advanced than this book. Entire books and
websites are dedicated to teaching you how to create highly complex CSS
layouts that are displayed well on various computers and browsers — and to
combining CSS and other special code to make complex pages look good in
older and newer web browsers.

In Chapter 4, you find more information about browser differences, as well
as Dreamweaver’s testing and compatibility features, which can help ensure
that your pages work well for a broad audience.

Introducing the Dreamweaver CC Workspace

Dreamweaver can seem a bit overwhelming at first. You can easily get lost
with so many features spread among so many panels, toolbars, and dialog
boxes. If you prefer to build an understanding by poking around, have at it
(and feel free to skip to Chapter 2, where you start building your first web
page). If you want a tour before you get started, read this last section, which
introduces you to the interface and gives you a quick overview of the fea-
tures in this powerful program.

When you launch Dreamweaver, the Welcome screen, shown in Figure 1-7,
appears in the main area of the program (and reappears anytime you don'’t
have a file open, unless you close the Welcome screen by selecting the Don’t
Show Again option). After you select an option on the Welcome screen (these
options are explained in Chapter 2), Dreamweaver creates a new blank HTML
page in the main workspace, the main area of the program where you design
your page. The workspace consists mainly of a Document window, which
displays the page you're working on and is where you add text, images, and
other elements that will appear on your web pages. The Document window is
surrounded by a collection of panels, toolbars, and menus that provide easy
access to Dreamweaver’s many features. Details of these controls follow.
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Figure 1-7: When Dreamweaver opens, the Welcome screen provides easy access to
commonly used items, such as recently opened files.

Changing workspace layouts

One of the bigger changes in Dreamweaver CC is the simplification of the
various workspace layout choices. In the past, many choices were available
from the layout drop-down list (located in the top right of the workspace). In
Dreamweaver CC, most of the layouts, which were designed to meet the dif-
ferent work styles of programmers and designers, were removed. The layout
drop-down list has been reduced to just two workspace layouts: Classic

and Expanded. However, you're not limited to these two ways of using
Dreamweaver. Almost every panel and toolbar in Dreamweaver CC is highly
customizable, making it easy to change the workspace to best match the way
you work. And because you can save your own workspace layouts, many
designers create multiple layouts, each optimized for different tasks.

You can create your own custom layout by following these steps:

1. Open, close, move, or resize any of the panels, toolbars, inspectors,
and other features in Dreamweaver’s workspace.
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2. Choose Window~>Workspace Layout~>New Workspace.
The Manage Workspaces dialog box opens.

3. In the Manage Workspaces dialog box, give your new workspace a
name and click OK.

Your custom workspace is added to the layout drop-down list, so you
can easily reset the program to match your favorite settings.

The name that the layout drop-down list displays matches the last layout you
chose and used. If your last choice was Classic, it says Classic; if your last
choice was a custom layout you named My Layout, it says My Layout.

If you move a panel or an inspector and then want to return it to the location
you saved in the layout, click Reset [layout name] in the layout drop-down
list. Dreamweaver will restore the workspace to match the layout you saved.

Create a collection of workspace layouts optimized for common tasks, such
as creating and applying CSS, or working with database content, and save
them so you can easily arrange the program to best suit your preferences.

The menu bar

As with most programs you’ve used, the menu at the top of the screen pro-
vides easy access to most program features, including the options you find in
the Insert bar, Property inspector, and panels, as well as a few others that are
available only from the menu.

The Document toolbar

Across the top of the workspace — just under the menu bar and document
tabs, and just above the workspace — is the Document toolbar. Here you find
the following options:

1~ Code, Split, Design, and Live views: This series of options controls how
Dreamweaver displays a document that’s open in the Document window.
Code view displays only the code editor, Design view displays only the
visual editor (which hides the code), Split view cuts the page in half and
displays both the Code and Design views. Note: In Split view, you can drag
the edge of the Document window to reveal more or less of the code.

Live view, the newest view option, displays a preview of how the page
will appear in the latest versions of the Safari and Chrome web brows-
ers, which display most of the new CSS3 and HTML5 options not sup-
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ported by many older web browsers. The Safari and Chrome web
browsers and the Dreamweaver Live view feature are built on webkit,
the open-source browser engine. When Live view is selected, a Refresh
button is added to the toolbar that looks like a circle with an arrow in it.
The Refresh button works like the refresh button in a web browser and
can be used to reload the contents of the Document window.

v~ Live Code: Available only when Live view is activated, the Live Code
option displays both Code and Design views with the Live preview
activated.

+~ Inspect button: Available only when Live view is activated, the Inspect
option helps you identify and troubleshoot CSS by highlighting the
styles that apply to any element you select in the page.

1~ Preview/Debut in Browser: Provides quick access to a drop-down list of
all the web browsers you can use to preview a page open in the Document
window. Choose Edit Browser List, at the bottom of the drop-down list, to
add more browsers (see Chapter 4 for detailed instructions).

1~ Title field: Displays the page title, which is the text that appears at the
top of a browser window when a page is displayed. The title page text
also identifies the page when bookmarked.

The Document window

The big, open section in the main area of the workspace is the Document
window, which is where you work on new and existing pages.

If you use the Classic workspace layout, the Document window is displayed
in Split view, showing the code on the left and the Design view on the right.
To change the Split view from left-right to top-bottom, choose View=>Split
Vertically to deselect the Split Vertically option (which is selected by default
in version CC). If you want to hide the code to focus only on your design,
click the Design view button in the Document toolbar.

The docking panels

The docking panels are located to the right of the work area .The docking
panels display a variety of features, including the following:

~ The CSS Designer panel displays the style sheets, media queries, selec-
tors, and properties associated with any page open in the Document
window.

~ The Insert panel is described in detail in the following section.
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1~ The Files panel displays all the files and folders in a site.

1~ The CSS Transitions panel displays a list of all transitions as well as the
New Transition panel, to allow you to animate elements on your page
using CSS3.

You work with the panels in the following ways:
+~ To open and close panels, double-click the gray bar. Or single-click a

specific tab in a panel to open or close it.

+~ To move panels anywhere on the screen, click the dark gray bar at the
top of the panel and drag it to the desired location.

1~ To display more panels, select the panel name from the Window menu.

~ To expand or collapse all the visible panels at once, click the double
arrow just above the top-right corner of the topmost panel, as shown in
Figure 1-8.

1~ To expand or collapse a single panel when the panel collection is col-
lapsed, click the name of the panel.
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Figure 1-8: Expand or collapse all the panels at once by clicking the double arrow at the
top-right corner of the topmost panel.
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The Insert panel

The Insert panel, located at the top of the panel section, includes eight sub-
categories, each with a different set of icons representing common features.
Click the small arrow to the right of the name to access the drop-down list
and switch from the buttons of one subcategory to the buttons for another.
The options are

1 Common Insert panel: Displays icons for many of the most common fea-
tures, including links, tables, and images

1~ Structure Insert panel: Displays Div, List, Paragraph, and Navigation
options (essential for creating page layouts)

1~ Media Insert panel: Allows you to simply and quickly insert Edge anima-
tions, HTML5 video, or multimedia plug-ins

+~ Forms Insert panel: Features the most common form elements, such as
radio buttons and boxes

” jQuery Mobile panel: Displays options for adding jQuery functionality
to web pages that are intended to be viewed on mobile devices

+ jQuery Ul panel: Allows you to insert common jQuery functions, such as
a progress bar, a slider, or an accordion menu that expands or collapses

1~ Templates Insert panel: Displays common functions that allow you to
create or edit templates

1~ Favorites Insert panel: Enables you to right-click (Windows) or Control-
click (Mac) to add any icons from the other Insert bar options as a favor-
ite, so you can create your own collection of favorite features, such as
symbols for foreign currency or even ASP functions

At the end of the drop-down list is the option that controls the display of the
list of options in the Insert panels:

+~ Hide Labels/Show Labels: Enables you to display the names of the
Insert panel features next to each icon, or to remove the names

The Property inspector

The Property inspector is docked at the bottom of the workspace in
Dreamweaver. If you prefer, you can click the gray bar at the top of the
inspector and drag it to detach it so it floats in the workspace. You can
move the inspector anywhere on the screen or you can drag and dock it
in the panel group. When you dock the Property inspector with the other
panels, you can expand and collapse it just as you would any other panels.
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To restore the inspector to its location in the saved workspace, choose
Window>Workspace Layout=>Reset [layout name]. (I rather like that the
Property inspector is handy but out of the way, at the bottom of the screen.)

The Property inspector displays the properties, or options, for any selected
element on a page, and it changes based on what’s selected. For example, if
you click an image, the Property inspector displays image properties. If you
click a Flash file, the Property inspector displays Flash properties.

For many elements, the Property inspector is split into two sections, one for
HTML features and the other for CSS. Use the CSS and HTML buttons on the
left side of the Property inspector (as shown in Figure 1-9) to switch from one
to the other. (You find detailed instructions for how to use these two modes
of the Property inspector in Chapters 5-7.)

l<body> <div.container> [<h1>| [l 897 % 506 I

g
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z
]
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SYHTML - Targeted Rule v | Fort 2 DefadtFont — ~ v M

(B css | EditRule S5 Panel size - -1
Page Properties. ..

Figure 1-9: The status bar and the Property inspector in CSS mode.

The Property inspector is divided into top and bottom parts. If the bottom
part is not open, as shown in Figure 1-9, double-click in the bottom-right
corner of the inspector to reveal additional attributes, such as the image map
options when a graphic is selected. Double-click the gray bar at the top of the
inspector to close and open the entire inspector.

The status bar

The status bar is located at the bottom of the Document window and just
above the Property inspector, as shown in Figure 1-9. As with the workspace
layout list, the status bar has been simplified, and some features that users
of previous versions of Dreamweaver may have grown accustomed to, have
been removed. The status bar includes access to a number of features that
control the display of a page in Dreamweaver’s workspace:

1~ Tag selector: On the far left of the status bar, as shown in the top of
Figure 1-9, you find the tag selector, which displays the HTML tags and
CSS rules that apply to any selected element on the page. In Figure 1-9,
the cursor is inside a text block that’s formatted with the <h1> tag,
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which is inside a <div> tag with a #container ID, which is inside the
<body> tag.

e Clicking any tag in the tag selector selects the tag and its contents
in the workspace.

e Right-clicking (Control-clicking on a Mac) a tag opens a pop-up
menu with options to add, edit, or remove tags and CSS rules.

1~ Mobile, Tablet, and Desktop Size buttons: These buttons provide a
quick view of what your web design might look like when viewed using
one of these three platforms. The results are not exact: So many pos-
sible screen resolutions exist that your computer screen couldn’t hold
buttons for them all.

Changing preference settings

The more you use Dreamweaver, the more you're likely to appreciate how
readily you can customize its features. Remember that you can always change
the workspace to better suit the way you like to work, and you can easily alter
Dreamweaver’s preference settings using the Preferences dialog box.

To open the Preferences dialog box, choose Edit=>Preferences on a Windows
computer, or Dreamweaver—Preferences on a Mac. Dreamweaver includes 19
categories in the Preferences dialog box and makes it possible to change the
appearance, default settings, and many other options throughout the program.
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Opening and Creating Sites

In This Chapter

Starting with the site setup process
Creating new web pages

Inserting and formatting text
Creating links

Adding search engine keywords to meta tags

thher you’re building a new site or need to make changes to an
existing site, this chapter is the place to start. Here you discover an

important preliminary step: the site setup process that enables Dreamweaver
to keep track of the images and links in your site. After you set up your web-
site in Dreamweaver, you're ready to create web pages. (You find

instructions for creating a page, inserting text and images, and
setting links in this chapter, too.) But whatever you do,
don’t skip the first step of defining a site — the process
takes only a minute or two.

‘x‘gN\BEI? Although you can use Dreamweaver without doing
& this initial site setup, you run the risk of breaking
links when you publish your site using the built-in
FTP features. Other features, such as templates,
automated link checking, and the library, won’t
work at all if you don’t first define each site in the
Site Setup dialog box, covered in this chapter.

QQ,N\BER The best approach to web design with Dreamweaver is
>y to first create a website on your computer’s hard drive.

If you're working on an existing site, start by copying it to
your computer’s hard drive. (In Chapter 4, you find detailed
instructions for downloading an existing website from a web
server.) Then you can edit your site, add pages, and set links, in the privacy
of your own computer and use Dreamweaver’s preview options to test your
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work before you publish it on the Internet. When you’re ready, you can use
Dreamweaver’s built-in publishing features to transfer your site (or individual
pages of your site) to a web server.

A web server is a computer with a permanent connection to the Internet and
special software that enables it to communicate with web browsers, such as
Internet Explorer and Firefox. Find detailed instructions for previewing and
publishing a website in Chapter 4.

Setting Up a New or Existing Site

WMBER
@ﬁ
&

To set up a site in Dreamweaver, you need to store all your site’s resources
in one main folder or directory on your hard drive. Dreamweaver calls this
folder the local site folder, and when you set up a new site, you essentially
just identify that folder in Dreamweaver. The site setup process is a crucial
first step because all the elements of your site must remain in the same rela-
tive location on your web server as they are on your hard drive for your
links, images, and other elements to work properly. Identifying the local site
folder on your computer and keeping all images, text, and other files in your
website in that one main folder help Dreamweaver set all your links properly
and ensure that they still work when you publish your site to a web server
(which you find out how to do in Chapter 4).

In earlier versions of Dreamweaver, the local site folder was called the local
root folder and the site setup process was called the site definition process.

The Site Setup dialog box also contains a category called Servers (acces-
sible by a link on the left side) where you can set up your site to use
Dreamweaver’s file transfer features, including its FTP (File Transfer
Protocol) capabilities to transfer files from your computer to a web server
(and vice versa). FTP is a common method of copying files to and from com-
puters connected across a network, such as the Internet, and one of the most
popular options for publishing a website online. To keep things simple for
now, you can skip all the categories except the Site category covered in the
section that follows. In Chapter 4, you find detailed instructions for using
Dreamweaver’s FTP and other publishing features, as well as instructions for
downloading an existing website hosted on a remote web server.

If the site setup process seems a little confusing at first, don’t worry. Site
setup is a quick, relatively painless process that you must do only once
for each site. After you've set up a site in Dreamweaver, the site is stored
in the Files panel, where you can easily load the site into Dreamweaver
whenever you want to work on it. You can set up one site or many sites in
Dreamweaver.
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Whether you'’re creating a site or working on an existing site for the first time,
the following steps walk you through the process of defining the local site
folder, a folder where you store all the images, text, and other files in your site:

1. Choose Site~>New Site.
The Site Setup dialog box appears.

2. On the left side of the dialog box, click the Site category.

When you open the Site Setup dialog box, the Site category should be
selected by default. This dialog box contains three other categories
(shown in Figure 2-1), where you can manage server connections and
other options, but you don’t need to open these categories to complete
the basic site setup process.

Site Setup for Cinbemargo website =

ore A Dreamweaver site is a callection o all of the files and assets you use in your
website, A Drearmweaver site usually has two parts: a local folder on your

version Control momputer where you store and work on files, and a remote folder on a server
» Advanced Settings where you post the same files o the weh,

Servers

Here you'l select the lacal folder and a name For your Dreamieaver site.

Site Mame: | Cinbemargo website |

Local Site Felder: [ C:\Users|Janine|Documentsi8-2012 web sites|Cinembargol, | &5

Figure 2-1: Use the Site Setup dialog box to identify the
local site folder for any new or existing website.

3. In the Site Name text box, type a name for your site.

You can call your site whatever you like; this name is used only to help
you keep track of your sites in Dreamweaver. Many people work on
more than one website. The name you enter here is listed in the Files
panel, where you select which site you want to work on in Dreamweaver.
(The next section discusses moving among sites using the Files panel in
more detail.)

4. Click the Browse (file folder) icon, which is next to the Local Site
Folder text box, and browse your hard drive to locate the folder you
want to serve as the main folder for all the files in your website.
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If you’re working on an existing site, select the folder that already con-
tains the files for that site. If you're creating a site, you can create a new
folder as follows:

e In Windows: Click the Create New Folder icon at the top of the
Choose Root Folder dialog box.

e In Mac OS X: Click the New Folder icon at the bottom of the
Choose Root Folder dialog box.

The goal is to simply select the folder so that Dreamweaver can identify
where all the files and folders for your site will be stored. When you’ve
completed this step, the name of the folder and the path to that folder’s
location on your hard drive appear in the Local Site Folder field.

. Click Save to close the Site Setup dialog box and save your settings.

If the folder you selected as your local site folder already contains files
or folders, all the files and folders in your site are displayed in the Files
panel. As you see in Figure 2-2, | already had many files in my personal
profile site, which I'm using as the example in this chapter, so they’re
listed in the Files panel. If [ were creating a new site with a new empty
folder, the Files panel would contain only the main site folder.

Files | Assets | =
|EI Cinbermargo v| ‘Local wiew j
% G[E o 6
Local Files | size| Type
20 site - dnbemar... Folder
-2 Carlos-varela Folder
=32 galery Folder
=0 Great-Day Folder
w0 images Folder
w3 Templates Folder
.. about-usht..  SKB Chrom.
- contacthtml  3KB Chrom.
T events.htm 4K Chrom,
- fims.html SKE Chrom.
T indeschtml 4KB Chrom.
. arder.html SKE Chrom.
- order2 html EKB Chrom.
L styles.css TKE Casca...
L shyles2.css SKB Casca...
T testhtml SKE Chrom,
T ravel.html FKE Chrom.,
4 I 2
_(@ Log

Figure 2-2: When site setup is complete,
the files and folders are displayed in
the Files panel.
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Switching among Sites

You can set up as many sites as you like in Dreamweaver and change from
one site to another by selecting the site name in the Files panel. To load a dif-
ferent site into the Files panel, use the drop-down arrow next to the site name
and choose the name of the site you want to display. If you're editing more
than one website in Dreamweaver, make sure you switch to the site you want
so that it’s displayed in the Files panel.

In Figure 2-3, I'm selecting the Cinbemargo website from a list of sites I've
defined in Dreamweaver. When you select a site, the files in that site replace
the ones of any currently open site in the Files panel.

Files
[[ED Cinbermarge vl [Local Wi _v]
M Desktop fil
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[ Janine’s Profile Site H%r;;
2 sandbox Chrom.
e Chrom.
ah Manage Sites... Chrorm.
= index.html 4KB Chrom,
= order.html SKE Chrom.
= order2.html BKE Chrom.
L styles.css TKE Casca...
"2, shyles2.css SKB Casca...
T testhtml SKB Chrom.
= travelhtml KB Chrom,
« i r
@ Log,

Figure 2-3: Use the drop-down list
in the Files panel to choose among
defined sites.

Managing Sites in Dreamweaver

After you complete the site setup process covered in the preceding exer-
cise, you can make changes and additions to the site setup by choos-

ing SitecoManage Sites to open the Manage Sites dialog box, as shown in
Figure 2-4.
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Manage Sites ==
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Figure 2-4: You can edit any site setup by selecting it from the
Manage Sites dialog box.

To edit a site that you've already set up, select the name of the site in the
Manage Sites dialog box, and then click an icon at the bottom left of the
dialog box to make changes. Your options using the icons, from left to right,
are as follows:

+~ The minus sign icon deletes a site from the Manage Sites dialog box.
When you delete a site from the list, you don’t delete the site’s files
or folders from your hard drive; you simply remove the site setup in
Dreamweaver.

~ The Edit icon looks like a pencil and opens the site in the Site Setup
dialog box, where you can change the name by replacing the text in the
Site Name field and change the local site folder by clicking the Browse
icon (which looks like a file folder) and selecting a different folder. In
Figure 2-4, I selected the Cinbemargo site.

+~ The Duplicate icon (the third icon from the left) makes a copy of the
site setup but does not make a new copy of the files and folders of the
site on your hard drive. To make a copy of all files in a website, dupli-
cate the site folder on your hard drive (outside Dreamweaver), just as
you’d make a copy of any other folder or file on your computer.

~ The Export icon (the fourth icon from the left) exports the site setup
definition. Similar to the duplicate option, the option does not create a
copy of the files in the site. Instead, the Export icon exports the .ste
file, which can be used to share site setup information from one com-
puter to another. This feature is especially useful if you've set up the
web server information as part of your site setup, which is covered in
Chapter 4.
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At the bottom of the Manage Sites dialog box, you find four buttons:

+~ Import Site: The Import Site button lets you import a . ste file to add
site setup information to Dreamweaver.

1~ New Site: Click this button to define a new site. (The process is the same
as choosing Site>New Site, as explained in “Setting Up a New or Existing
Site,” earlier in this chapter.)

~ Business Catalyst buttons: You also find two buttons specifically for
importing and creating new sites using Adobe’s Business Catalyst ser-
vice. Business Catalyst is a hosted web service that extends the features
of Dreamweaver to include advanced features, such as a shopping cart
e-commerce service. You can learn more about this optional service at
www.BusinessCatalyst.com.

Creating Pages

Every website begins with a single page. Visitors are first greeted by the front
page — or home page — of your site, and that page is usually a good place to
start building.

Dreamweaver makes creating pages easy: You can work from the Welcome
screen or use the New Document window, which provides more options. The
following sections explain both methods, and you find details about the best
names to use for new pages so that they’ll work well when you publish your
site to the web.

Starting from the Welcome screen

When you open Dreamweaver, a Welcome screen greets you with shortcuts
to many handy features for creating pages in a variety of formats:

1 The left column provides a list of shortcut links to recently opened files.
Click the name of any file in the list to open the file in Dreamweaver.

v~ If you want to create a simple, blank web page, choose HTML from the
Create New list in the middle column (see Figure 2-5). Remember that
choosing HTML doesn’t mean that you have to write the HTML code
yourself. Rather, you're just telling Dreamweaver that you want to create
a page written only with HTML, not with one of the more complex tech-
nologies, such as PHP. You still have the option to work in the code
editor or the design editor and let Dreamweaver write the underlying
HTML for you.
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1 Choose one of the other page format options under New to create a CSS,
JavaScript, PHP, XML, or other more complex file type.

1 The Top Features (videos) list on the right side of the dialog box
includes links to a collection of video tutorials where you can learn more
about Dreamweaver’s most popular features.

Dreamweaver CC

Open a Recent ltem Create New Top Features (videos)
0] Templatesimain.ciwt T HmML Elvvm's Mew in Dreamuweaver
") Towver Bricge of.the-brige Html T css
= Tower Bridoe o..d-shad0w ktmi = |Ess WVisual Styling with CSS Designer
™| Tower Bridge 0. on/Preview ktml ™ Sass Enhanced Respansive Design
") Tower Bridge o..ndonindex Htmi T Javascriot
= Tower Bridge o.. cross-fads himl = pHp I il et prs
"] Tower Bridge 0. ndon/about hitml ML @ Enhanced juery Support
" Tower Bridge of...-day-night html 3 Fluid Grid Layout...
- £ More
Tower Bridge of.. ridge-calor html % Dreamweaver Site. ..
£ Open.. £ More...
|| Getting Started »
|| Mew Features » m
|| Resources » —
|| Don't show agsin

Figure 2-5: View a list of shortcuts for creating files or opening pages.

If you prefer not to use the Welcome screen, you can turn it off by selecting
the Don’t Show Again check box in the bottom-left corner. If the Welcome
screen is not visible, you can turn it back on by choosing Edit=>Preferences
(Windows) or Dreamweaver=Preferences (Mac), and then selecting the first
check box in the General settings next to Show Welcome Screen.

Creating an HTML page with
the New Document window

You can also create a new HTML page by using the New Document window,
which offers more options than the Welcome screen, including access to any
templates you've created with Dreamweaver (covered in Chapter 9) as well
as a collection of predesigned layouts, which can give you a head start on
your designs.

You can create many kinds of files using the New Document window, and you
can mix and match the options. This versatility can be confusing at first because
you have so many choices. In Dreamweaver CC, this dialog box was simplified
so that you need to choose only one option from each of the three sections.
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To create a new HTML page, follow these steps:

1. Choose Filez>New.

The New Document window opens, as shown in Figure 2-6. In the first
section, on the far left, you choose the type of page you want to create:

e Blank Page: Choose this option to create HTML pages, as well as
pages in the more complex PHP or JSP format.

e Fluid Grid Layout: This option opens the fluid grid layout features,
which you can use to create responsive web designs that adjust to
different screen sizes automatically. These features are covered in
Chapter 8.

e Starter Templates: If you create templates using Dreamweaver’s
.dwt template format, you can create pages based on those tem-
plates using this option. Templates are covered in Chapter 9.

e Site Templates: Choose this option to create customizable mobile
web app designs using jQuery Mobile. To learn more about creat-
ing mobile web apps with jQuery, read jQuery For Dummies by

New Document =
Page Type Layout:
D Blank P = HTML <none>
iank Page - CsS 2 column fixed, right siclebar, header and foc
= LEsS 3 column fixed, header and footer
L[ Fhid Grid Loyaut = Sass
™. Scss
Starter Templates - ;iv;Scnpt <No preview>
= XML
[E] site Templates T SVG
= HTML template
= Libraryitem
= PHP template
HTML document
DocType: HTMLS. A
dd to Head -
Attach S5 fle =
Hep Preferences, create ([ Cancel

Figure 2-6: The New Document window offers many options when
you are creating a file.

2. From the left side of the screen, select Blank Page.

3. In the Page Type list, select HTML.
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3

4. In the Layout section, choose <none>.

The layouts are included to provide a head start on designing HTML
pages with CSS. How to create pages using these layouts is covered in
Chapter 6.

5. If you want to change the document type, use the drop-down list next
to DocType.

By default, Dreamweaver CC creates pages using HTML 5, which most
designers consider the best option for web pages today. If you’re work-
ing on a site that uses an earlier version of HTML, such as XHTML 1.0
Transitional, make sure to change this setting.

6. Click Create, in the bottom right of the window.

The New Document window closes, and a new blank page is created and
opened in the workspace.

Note: If you're using a Macintosh, the Create and Cancel buttons are
swapped.

7. Choose File>Save to save your page and give it a filename.

Dreamweaver automatically names all new files Untitled, followed by

1, 2, and so on in the order created. I highly recommend that you get in
the habit of giving your files names that have more meaning to you. Also
note that filenames in websites should not include spaces or special
characters (although the hyphen and underscore are okay). For more

on how best to name files and folders in your website, see the upcoming
sections “Naming new page files” and “Naming the first page index.html.”

Get in the habit of saving new web pages in your local site folder as
soon as you create them, even though the pages are still blank. As you
create links or add images to your pages, Dreamweaver needs to be able
to identify the location of your page within your site folder. Although
Dreamweaver sets temporary links until your page is saved (and will
give you a warning about this when it does), saving a page first is best
because many Dreamweaver features won’t work until a page is saved.

Naming new page files

Over the years, I've received many e-mail messages from panicked web
designers because of broken links caused by filename conflicts. These prob-
lems usually don’t occur until after a website is published on a server, so they
can be especially confusing and difficult to understand. If you’re publishing
your website to a web server that runs on a Mac or under Windows, the fol-
lowing may not apply to you. But if you're using a web server that runs Unix
or Linux (used by many commercial web-hosting companies), the following
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instructions are especially important. If you're not sure, be safe and follow
these rules when you save web pages, images, and other files on your site:

+ Include an extension at the end to identify the file type. Examples

include . html for HTML files and . gif for GIF images. Dreamweaver
automatically adds the .html file extension to the end of HTML

files, which works for most web servers. However, in the rare case

that you need to change the extension to . htm for your web server,
you can do so in Dreamweaver’s Preferences dialog box by choosing
Edit>Preferences (Windows) or Dreamweaver=>Preferences (Mac). See
the “Displaying file extensions in Windows” sidebar for tips on how to
view file extensions, which are hidden in Windows.

1 Don’t use spaces or special characters in filenames. For example, don’t

name a web page with an apostrophe or spaces, such as cat's meow
page.html. If you want to separate words, you can use the underscore
() or the hyphen (-). For example, meow-page . html is a fine filename.
Numbers are okay in most cases, although it’s best not to start a file
name with a number. Capital letters generally don’t matter, but most
designers stick with lowercase. Doing so keeps filenames consistent and
makes setting and checking links easier because the name of the file and
its reference in any links must match.

Displaying file extensions in Windows
When you view pages in Windows Explorer, you [ “oider options =
won't see the file extension of your GIFs, JPEGs, [General] View |Seareh]
or H_TML pages (alth_ough thes_e extensions will e ooty thovio (o Dl o oty
be displayed in the Files panel in Dreamweaver) [ZE) e singforihisfolderto allfolders of histype
unless you change the settings on a Windows £ ez ResaiFe i
computer. To change the settings so that you
can see extensions in Windows Explorer, open A“’V;ﬁmey"g‘gzmm .
the Folder Options dialog box, as shown in the Bl sl tloiconon bl
figure, choose the View tab, and then look ] iy el i i b it k)
through the |0ng list of Options and deselect (© Don'tshaw hicden files, foldlers, or drives 3
Hide Extensions for Known File Types. How you ) i ot dves e Contpuer
open the Folder Options dialog box depends on B« Rocommondec)
which version of Windows you're using. You | e e o @ et proceas
should be able to find the dialog box easily if you 1] Show st et <
search for Folder Options in the Help section.

ok | [ cencel || Apy |

b5
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The reason for all this fuss? Filenames are especially important in websites
because they're included in the HTML code when you set links. A link from
one page to another, as you discover later in this chapter, is essentially made
up of the name of the file. Links with names that include spaces and special
characters work just fine in most browsers when you test pages on a Mac or a
PC computer, but many web servers on the Internet use software that doesn’t
accept spaces or special characters in links. Thus, links that don’t follow
these rules may get broken when you publish the site to a web server. By fol-
lowing these three simple rules — no spaces, no special characters, and keep
everything lowercase — you ensure that your links will work on any system.

Naming the first page index.btml

Another confusing rule — and one of the most important — is that the main
page (or the front page) of your website must be called index.html (on
some Windows-based servers, the first page should be named default.
html). Most servers on the Internet are set up to serve the index.html

or default.html page first, but you should check with your web-hosting
service or the administrator who managers your web server to confirm the
name required for your server.

Essentially, when a web browser comes to a domain name, such as
DigitalFamily.com, the first page that opens is index.html. Similarly, when a
web browser is directed to a subfolder within a site, it also displays the index
page first. As a result, if you create a subfolder with the name books, for exam-
ple, and inside that subfolder you create a page named index.html as the
main page, you can tell visitors to your site to simply enter www.DigitalFamily.
com/books to arrive at the books page within your site. If you name the

first page anything else, such as books . html, visitors have to type www.
DigitalFamily.com/books/books.html to open the page. The rest of the pages
in your site (or any subfolder) can be named anything you like. Just remember:
Don’t include spaces or special characters (except the hyphen or underscore).

It doesn’t matter if you use uppercase or lowercase letters when typing a
domain name, but everything that comes after the . com (or .net, or what-
ever the ending of your domain name) must match the case of the file and
folder names. Thus, www.DigitalFamily.com and www.digitalfamily.
com are the same, but if you create a folder named books, the address typed
into a browser must use a lowercase b, as in www.DigitalFamily.com/
books. If someone enters www.DigitalFamily.com/Books in a browser,
he or she will get a 404 error, indicating that the link is not valid.

Bestowing a page title

When you create new pages, adding a page title right away is also good prac-
tice. A page title is the text that appears in the title bar when a visitor opens
your site in a browser window.
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In Dreamweaver, you can add a page title by changing the text in the Title
box at the top of the workspace. This detail is easy to forget, but page titles
play an important role in your site’s appearance as well as behind the scenes:

1~ The title won’t appear in the main part of your web page, but it does
appear at the top of a browser window, usually just to the right or left
of the name of the browser. Pages on the web look unfinished when the
words untitled document appear at the top of the browser window.

1 The page title is also the text that appears in a user’s Favorites or
Bookmarks list.

1 Many search engines give special priority to the words that appear in
the title of a web page and display title text in the list of search results,
so including the name of your site and a few keywords can help you
score better in search results.

Changing Page-Wide Styles with
the Page Properties Dialog Box

You can change many individual elements on a page in the Property inspec-
tor. If you want to make changes that affect the entire page — such as chang-
ing the background color of the entire page or changing the way links and
text are formatted — use the Page Properties dialog box.

As shown in Figure 2-7, the Page Properties dialog box includes a list of cat-
egories on the left. Each of these reveals different options for specifying page
settings. Some of these options are covered in other parts of the book, such
as the Background Image feature, covered in Chapter 3.

Page Properties =
Category Appearance (CSS)
pearance (HTML) Page font: @ Cambria, Hoefler Text,| v norma = normal =
HZ:Z\SEES()CSS) Size: 14 -
:r‘jaiﬁg?;qd;g% Textcolor: Il #009
Background color: Q #CCC
Background image: \ Browse...
Repeat: -
Left margin: pix - Right margin: px v
Top margin: px - Bottom margin px -
OK l l Cancel ] l Apply

Figure 2-7: Use the Page Properties dialog box to change text color,
font face, font size, background, and margins for the entire page.
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Changing background and text colors

This section focuses on changing the background and the text colors avail-
able from the Appearance categories, as shown in Figure 2-7. Note that

the CSS options are recommended over HTML options. When you use the
Appearance (CSS) options, Dreamweaver creates corresponding styles

for the body tag automatically. When you use any CSS options in the Page
Properties dialog box, Dreamweaver creates corresponding styles automati-
cally and lists them in the CSS Styles panel. You find more about editing CSS
in Chapters 5-7.

\&Q,N\BEH Although you can apply global settings, such as text size and color, in the

>y Page Properties dialog box, you can override those settings with other for-
matting options in specific instances. For example, you could set all your
text to Helvetica in Page Properties and then change the font for headlines to
Arial using CSS (covered in Chapter 5).

To change the font settings, background color, text color, and page margins
for an entire page, follow these steps:

1. Choose Modify-~>Page Properties.

The Appearance (CSS) category of the Page Properties dialog box
appears (refer to Figure 2-7).

2. In the Page Font drop-down list, specify the fonts you want for the text
on your page.

In this example, I set the font face to the collection that begins with
the Cambria font. If you don’t specify a font, your text appears in the
font specified in your user’s browser, which is usually Times. (You find
instructions for using custom fonts in Chapter 7.)

3. If you want all the text on your page to appear bold or italic, choose
the corresponding font options in the drop-down lists to the right
of the Page Font options.

If you select one of these options, all your text appears bold or italic in
the page. Most designers leave these two fields blank because they want
to limit the use of bold or italics to drawing special attention to a word
or words.

4. In the Size drop-down list, specify the font size you want for the text
on your page.

Again, you can override these settings for specific text on the page, such
as headlines. In Chapter 5, you find more information about the many
size options you can use when formatting text with CSS.
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5. Click the Text Color swatch box to reveal the color palette. Choose
any color you like.

The color you select fills the color swatch box but won’t change the text
color on your page until you click the Apply or OK button.

6. Click the Background Color swatch box to reveal the color palette.
Choose any color you like.

The color you select fills the color swatch box, but the color doesn't fill
the background until you click the Apply or OK button.

7. If you want to insert a graphic or photograph into the background of
your page, click the Browse button next to the Background Image box
and select the image in the Select Image Source dialog box.

When you insert a background image, it automatically repeats, or tiles,
across and down the page unless you choose an option from the Repeat
drop-down list. No-Repeat prevents the background image from repeat-
ing at all. Repeat-X and Repeat-Y repeat the image vertically (x axis) or
horizontally (y axis), respectively, across the page.

8. Use the margin options at the bottom of the dialog box to change the
left, right, top, or bottom margins of your page.

Most web browsers add a little space to the top and left sides of the
browser window around any web page. Entering 0 in all four of these
fields removes any default margin space, enabling you to create designs
that begin flush with the edge of a browser.

9. Click the Apply button to see how the colors look on your page.
10. Click OK to finish and close the Page Properties dialog box.

Changing link styles with Page Properties

If you're like many designers, you probably don’t like the underline that auto-
matically appears under all the linked text in a web page. In this section, you
discover how easy it is to remove that underline and change the color, font,
and size of your links with Dreamweaver’s Page Properties dialog box. You
can also change other page-wide settings, such as the background color and
page margins, from the Page Properties dialog box.

The easiest way to alter all your link styles at once is to change them in the
Page Properties dialog box. When you use this option, Dreamweaver creates
the corresponding tag selector styles automatically and lists them in the CSS
Styles panel. Other page-wide settings in this dialog box work similarly, and
you can edit all these options by using the CSS tools covered in Chapters 5-7.
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To change hyperlink and other styles with the Page Properties dialog box,
open an existing page or create a new one and follow these steps:

1. Choose Modify-~>Page Properties.

Alternatively, you can click the Page Properties button in the Property
inspector. The Page Properties dialog box appears.

2. On the left of the Page Properties dialog box, select the Links (CSS)
category, as shown in Figure 2-8.

Page Properties =
Category Lirks (CSS)
Appearance (CS5)
Appearance (HTML) Lirk font: & (Same as page forr v v v
Headings (C5S) Size vPx hd
Title/Encoding
Tracing Image Lirk color: Q #OOF Rellover links: Q #FC3
Visited ks E #3900 activeinks: ||| #FC3
Underline style: [Show underline only on rollever v]

Always underline

Never underline

Hide underline on rollover s

Help QK l | Cancel ‘ ‘ Apply

Figure 2-8: Change the style definitions for all four hyperlink states.

3. Specify a font and size for your links.

3 If you want to use the same font size and face for your links as you use in
the rest of the text on your page, it’s best to leave these options blank.
Then, if you change the text settings for the page, you won’t have to
remember to change them for your links as well.

4. Specify colors for each hyperlink state by clicking the corresponding
color well and selecting a color from the Color dialog box.

You can change any or all link color settings. If you don’t specify a link
color, the browser uses the default link color. Here’s an explanation of
each of the four link states:

e Link Color: The color in which your links appear when the page
is first loaded and the linked page hasn’t yet been visited by the
browser. The corresponding HTML tag is <a: 1ink>.

e Visited Links: The color your links change to after a browser has
already viewed the linked page. The corresponding HTML tag is

<a:visited>.
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* Rollover Links: The color a link changes to as a user rolls a cursor
over a link. The corresponding HTML tag is <a:hover>.

e Active Links: The color a link changes to as a user is actively click-
ing a link. The corresponding HTML tag is <a:active>.

5. Select a style from the Underline Style drop-down list.

By default, links displayed in a web browser are underlined. Many
designers prefer to remove the underline that automatically appears
under linked text by choosing Never Underline. I like to give visitors the
visual cue of the underline, but only as they roll a cursor over a link, so
I generally prefer the option Show Underline Only on Rollover option
(refer to Figure 2-8).

6. Click OK.

The Page Properties dialog box closes, the style settings are applied
automatically to any links on the page, and the corresponding styles are
added to the CSS Styles panel.

To fully test link styles, preview your page in a web browser or click the Live
View button at the top of the workspace. It’s good practice to test link set-
tings in a browser when you make changes like the ones in the preceding
exercise. Take a look at how your links appear. For example, check whether
the active and visited link colors look good against the background color of
the page. Remember that any styles you create using the Page Properties
dialog box affect all links on your page unless you specifically apply a differ-
ent style to an individual link that overrides the redefined tag style. If you
want to use different link styles in different parts of the same page, you can
create compound styles to create different link styles (see Chapter 6 for
instructions on creating compound styles).

Adding and Formatting Text

Many people are pleasantly surprised by how easily they can create a basic
web page with text and images in Dreamweaver. This section focuses on text
and the next section describes images.

In this chapter, I do basic text formatting by using Dreamweaver’s HTML
formatting options, including the heading and paragraph tags. I start with
these basic HTML tags to keep things simple at this stage and to introduce
you to what many designers consider the fundamental building blocks of a
good web page. In Chapters 5-7, you find detailed instructions for using CSS
to change the size, color, font, and other style options of text formatted with
these HTML tags.
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Adding text to a web page

To add text to a page, you can simply click to insert your cursor at the top of
a page and type. If you want to add text that you have somewhere else, such
as in a file created in Microsoft Word, you can copy and paste the text into
Dreamweaver instead of retyping it.

Dreamweaver offers many ways to maintain formatting when you copy and
paste text from another program. This feature is especially important when
you copy text from Microsoft Word because if you just paste text as is, you
risk including a lot of extra code that is unique to Microsoft Word and can
cause problems in your web page.

You can change the default for how Dreamweaver handles formatting when
you choose Edit=>Paste by altering the Preferences in the Copy/Paste cat-
egory. You can also choose Edit=>Paste Special to display these options any
time you paste new content.

Following are your four main options for inserting text when you choose
Edit=>Paste Special as well as three ways to refine your choice:

1 Text Only: Dreamweaver strips any formatting and inserts plain text.

1~ Text with Structure: Dreamweaver includes paragraphs, lists, tables,
and other structural formatting options. (This choice is my favorite
because it removes any code specific to a program such as Word if you
use the Clean Up Word Paragraph Spacing check box, described a little
later, while preserving basic formatting.)

1 Text with Structure Plus Basic Formatting: Dreamweaver includes
structural formatting as well as basic formatting, such as bold and italic.

1 Text with Structure Plus Full Formatting: In addition to the previous
options, Dreamweaver includes formatting created by style sheets in
programs such as Microsoft Word.

+~ Retain Line Breaks: Line breaks are preserved, even if you don’t keep
other formatting options. This option is not available if you choose Text
Only.

1 Clean Up Word Paragraph Spacing: This option removes special for-
matting code unique to Microsoft Word and is unnecessary (and not
recommended) for text on the web.

1~ Convert Smart Quotes to Straight Quotes: Smart quotes — the common
name for those fancy curly quotes that designers love to use in print
documents — require a special character to be displayed properly on
the web, and that special character does not work in all web browsers.
As a result, smart quotes are often displayed as strange characters in
documents and look terrible. To avoid this potential problem, select this
box and convert all your smart quotes to straight ones.
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[ describe many more text formatting options in Chapter 5, which covers CSS,
because formatting on the web is best done with CSS and you need to under-
stand the basics of CSS before you start using styles to format text beyond
the basic HTML tags covered in the next section.

Formatting text with the heading tags

One of the best formatting options for headlines is the collection of head-

ing tags. In HTML, using heading tags (<h1>, <h2>, and so forth) to format
text that serves as a title or headline offers many advantages. Heading tags
are designed to be displayed in relative sizes, with <h1> the largest, <h2>
smaller, <h3> smaller still, and so on through <h6>. So no matter what a web
page’s default text size is (and text sizes can vary due to browser settings
and computer platform), any text formatted with an <h1> tag is always larger
than text formatted with <h2>.

In Chapter 5, you find instructions for creating styles that can change the
appearance of heading tags while preserving these benefits. So even if you're
using CSS, you'll still want to start by formatting your headlines using the
heading tags.

Popular belief is that many search engines give priority to keywords in text
formatted with an <h1> tag because the most important text on a page is gen-
erally included in the largest size headline. Similarly, search engine experts
will tell you that you should use the <h1> tag only once per page.

To format text with a heading tag, follow these steps:

1. Highlight the text you want to format.

2. In the Property inspector, at the bottom of the workspace, make sure
the HTML button on the left side of the inspector is selected.

3. Use the Format drop-down list to select a heading option.

In Figure 2-9, I'm applying the <h1> tag to a headline. When heading tags
are applied, the text automatically changes to become big and bold in
Design view.

In general, I find the Property inspector the easiest way to apply basic for-
matting, but you can find these HTML formatting options also by choosing
Format=>Paragraph Format and then selecting a heading option from the sub-
menu that appears.
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Copper Bridge Foundation — htf

Cuban Art Space — Center for ¢
http :/Avww.cubanartspace .net/gy

AfroCubaWWeb — Cultural Events
http:#afrocubaweb.com/mews/cy

Havana Film Festival — Dec 2-1
http :/Avww . habanafilmfestival.co

Bienal de La Habana — Havana
http :/Avww . bienalhabana.cult.cu.

Heading 3
« | Heading4

e . |
< mminstance fleinstal ::Zg::gg > <mminstance editable> <di.,.> <hl.yelow> o W
P""“Tﬁ Preformatted

<PHTML|  Format |Heading 1 = Class  yelow + B 1 = = £ =
By CSS D Mone - Lirk M= i

Photo by Casey Stoll
Figure 2-9: The Property inspector provides easy access to common
HTML formatting features, such as the Heading 1 tag.

Adding paragraphs and line breaks

When you create page designs for the web, you must work within many
limitations that may seem confusing at first. Web design and print design

are fundamentally different, and that can make even seemingly simple tasks
more complicated than you might expect. How you create paragraph and line
breaks is a good example.

If you're working in Design view in Dreamweaver and press the Enter key
(Windows) or the Return key (Mac), Dreamweaver inserts a paragraph tag,
or <p>, in the code, which creates a line break followed by a blank line. If you
want a line break without the extra blank line, hold down the Shift key while
you press Enter (or Return) to tell Dreamweaver to insert the <br /> tag
into the code, creating a single line break.

Best practice is to avoid using multiple paragraph or break tags to create
extra space in a web page (and not all browsers will maintain the blank space
if you create it that way). If you want to add a lot of space between para-
graphs or other elements on a page, your best option is to use CSS, which I
cover in Chapters 5-7.
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If you're working in Code view and add space using the Enter or Return key,
you add blank space within the code. Extra space in HTML code can be useful
because extra space can make code easier to read, but in general, it doesn’t
affect the way a page is displayed in Design view or in a web browser.

Setting Links in Dreamweaver

Dreamweaver is truly a dream when it comes to setting links. As you set
links, remember that a link is essentially an address on the Internet (a URL,
or Universal Resource Locator) that tells a viewer’s browser what page to
open and where it is located when a viewer clicks the text or image contain-
ing the link.

To link to a page within your website, you can create a relative link that
includes a path describing how to get from the current page to the linked
page within your local site folder. A relative link doesn’t need to include the
domain name of your site; this type of link just has instructions for a browser
to get from one page within your site to another.

Linking to a page on another website — called an external link — is even
easier than linking to an internal link. All you need is the URL of the page to
which you want to link, and you’re most of the way there.

In the following sections, you find step-by-step instructions for creating inter-
nal and external links, and e-mail links.

Linking pages within your website

Linking from one page to another page in your website is easy. Just make
sure to save your pages in your local site folder (as described in the “Setting
Up a New or Existing Site” section, at the beginning of this chapter) before
you start setting links.

Here’s how you create a link from one page in a website to another:

1. In Dreamweaver, open the page where you want to create a link.

2. Select the text or image that you want to serve as the link (meaning
the text or image that a user clicks to trigger the link).

Click and drag to highlight a section of text or click once to select an
image.
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Creating multiple pages to set links

Creating a new page to start a website may
seem obvious, but consider this: Before you get
too far in your development, you may want to
create a few new pages and start organizing the
new pages in subdirectories, even if you don't
add text or images to them. Doing so enables
you to organize the structure of your site before
you start setting links. After all, you can’t use
Dreamweaver's link features to link to a page
that doesn't exist. If you plan to have three links
on your front page that link to the three main
sections of your site, go ahead and create those
three main pages, even if you don't put anything
but a little text on each page as you create it.
(You can always edit or replace those pages
later and add more pages to each section, but
setting up the main links to the main sections is
a great way to start designing the structure of
your site.)

For example, say you’re creating a site for your
small business. You likely want a few main pages,
such as a page about your staff, another page
about your products or services, and a third page
with general information and resources. At this
initial stage, you could create four pages — one
for the front page of the site and one for each
subsection. Name the front page index.html

and the other pages staff.html, about.
html, and general .html.

If you expect to create many related pages in
each section, consider creating subfolders for
each, with a main page in the subfolder. For
example, you could create a main index.
html page inside a services subfolder and
another index.html page inside a staff
subfolder. Remember, naming the main page
within a subfolder index.html enables you
to use addresses to subpages that include the
folder name, such as www.domain.com/
services. Your site can include as many
index.html pages as you like, as long as
each is in a separate subfolder.

As you start creating your site, setting up all
these main section pages helps you to organize
your site and makes setting up the main links on
all the site pages easier.

Note: If you're adding more than a few pages to
a website, creating a template and then using
it to create the rest of your pages can save you
time and make updating your site much faster.
You find instructions for using Dreamweaver’s
template features in Chapter 9.

3. Click the Hyperlink icon in the Common Insert panel (see Figure 2-10),

at the top right of the workspace.

Alternatively, you can set a link by clicking the Browse icon (which looks

like a file folder) just to the right of the Link field in the Property inspec-
tor, or choose Insert = >Hyperlink.

4. In the Hyperlink dialog box, shown in Figure 2-11, click the Browse
(file folder) icon to the right of the Link drop-down list.

The Select File dialog box opens.
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Figure 2-10: Click the Hyperlink
option to create a link.
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Photo by Casey Stoll
Figure 2-11: The Hyperlink dialog box has several link settings not
available when setting a link from the Property inspector.

. Click the filename to select the page that you want your image or text

to link to, and then click OK (Windows) or Choose (Mac).

When you click OK, the Select File dialog box closes, but the Hyperlink
dialog box remains open.

. (Optional) Use the Target field in the Hyperlink dialog box to define

where your linked page opens.

To open the linked page in a new browser window or in a new tab within
a browser, choose the _blank option. The New option is not recom-
mended because it is not standard. Choose _self to open the linked page
in the same window (the default). Choose _top to force the page to open
in a fresh browser window, even if the page is displayed within a frame.
The _parent option is almost never used anymore, but if you page is
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within a frameset, you can select this option to open the linked page a
level above the current page in the frame structure.

. Click OK.

The Hyperlink dialog box closes and the link is set automatically. Note
that to test your links, you have to view your page in a web browser,
such as Google Chrome or Apple Safari. Dreamweaver makes it easy to
preview pages in multiple web browsers, a process I cover in Chapter 4.

Setting links to many pages at once

After you become used to setting links, here’s a great shortcut that is espe-
cially useful if you're setting many links to many pages at the same time:

1. Select the image or text that you want to serve as the link.

2. Click the Point to File icon in the Property inspector.

The icon is a crosshair (a circle with a dot in the middle) and is located
just to right of the Link field and to the left of the Browse icon (which
looks like a folder).

. Drag your cursor across the page (without taking your finger off the

left mouse button) and rest it on the name of any file in the Files
panel.

When you click and drag from the Point to File icon to a filename in this
way, Dreamweaver extends a line to help you visualize that you're set-
ting the link properly, as shown in Figure 2-12.

o
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e - eventshtml 4K
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Figure 2-12: Drag from the Point to File icon to any file in the Files panel
to set a link.

The file must be visible in the Files panel, so you may need to open a
subfolder to reveal the file before you can set a link this way.



Chapter 2: Opening and Creating Sites

SMBER

Linking to another website

To link to a page on another website — sometimes called an external link —
all you need is the URL of the page to which you want to link, and you're
most of the way there.

To create an external link, follow these steps:

1. In Dreamweaver, open the page where you want to create the link.
2. Select the text or image that you want to act as the link.

3. In the Link text box in the Property inspector, type the URL of the
page to which you want your text or image to link.

The link is set automatically. In the example in Figure 2-13, [ created a
link using the text Wikipedia to link to http://wikitravel.org/en/
Cuba, the specific section of the Wikipedia website that covers Cuba.

Travel Information

US Bureau of Consular Affairs

The Center for Cuban Studies

Center for Democracy In The Americas
Global Exchange

The H Magazine

The Washington Office on Latin America

Please review all restrictions carefully as they

may change. Cinembargo Films provides these -
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<OHTML| Format [Paragraph = Class content ~ B I iz ==

B €SS 1D Norie - Lirk L] Target bk~
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Page Properties... | | LstIterm..

B Tite

<

Photo by Casey Stoll
Figure 2-13: In the Link text box, enter the URL of any website to which
you want to link.

Although you don’t have to type the http:// or even the www. at the begin-
ning of a website address to get to a site in most web browsers, you must
always use the full URL, including the http: //, when you create a link to
another website in HTML. Otherwise, the browser can’t find the correct
external site address, and the visitor will probably end up on an error page.

59



60 Part I: Getting Started with Dreamweaver CC

\\3

Setting a link to an e-mail address

Another common link option goes to an e-mail address. Visitors can send you
messages easily with e-mail links. I always recommend that you invite visitors
to contact you because including contact information helps establish credi-
bility on the web and because visitors to your site can point out mistakes and
give you valuable feedback about how you can improve your site. Setting a
link to an e-mail address is just as easy as setting a link to another web page.
All you need to know is the e-mail address you want to link to and what text
or image you want to use when you set the link.

To create an e-mail link, select the text you want to link and then click the
Email Link icon in the Common Insert panel. In the Email Link dialog box,
enter the e-mail address in the Email field and then click OK. If you want to
use an image as an e-mail link, select an image in Dreamweaver’s main work
area, click the Email Link icon in the Common Insert panel, and then type the
e-mail link into the Email field.

You can also set e-mail links using the Link field in the Property inspector,
but you must enter the codemailto: (no //) before the e-mail address. For
example, if you typed a link to my e-mail address into the Property inspector,
you’d need to type mailto:janine@digitalfamily.com. Here’s what the full line
of code behind that e-mail link would look like:

<a href="mailto:janine@digitalfamily.com">Send a message to
Janine</a>

When visitors to your website click an e-mail link, their computer systems
automatically launch their e-mail program and create a blank e-mail message
to the specified e-mail address. Although this trick is cool, your users may find
an e-mail’s sudden appearance disconcerting if they don’t expect it to happen,
and the e-mail link won’t work if your users don’t have e-mail programs on
their computers. That’s why I always try to let users know when I use an
e-mail link. For example, instead of just linking the words Contact Janine, 1 link
the words E-mail Janine. Even better, I often link the actual e-mail address.

Linking to PDFs

Adobe’s Portable Document Format (PDF) is popular on the Internet, and
with good reason. Now that Adobe’s Acrobat Reader is widely distributed
and even built into more recent browser versions, you can assume that most
of your audience can read files in PDF.

PDF is a great option for files that you want to make easy to download in their
entirety to be saved on a hard drive, as well as documents that you want
printed exactly as they're designed. Because the PDF viewer is free, your
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users don’t need expensive software, such as Microsoft Word or Lotus Notes,
to view your documents.

In the early days, PDFs were limited to text and images, but the most recent
versions support audio, video, and even Flash files, so you can now create
complex multimedia presentations in PDF format.

To add a PDF file to your website, simply copy the file into your local site
folder and link to it as you’d link to any other web page on your site. When
you upload the page with the link to your PDF file, make sure to upload the
PDF as well.

Adding Meta Tags for Search Engines

If you've heard of meta tags, you probably associate them with search
engines, and you’d be right. Meta tags are used for a variety of things, but
one of the most common uses is to provide special text in the code at the
top of the page. This code doesn’t appear in a web browser when your page
is viewed but can be read by crawlers, bots, and other programs that scour
the web cataloging and ranking web pages for Bing, Google, and a long list of
other search-related sites.

In Dreamweaver you find features that help you add meta tags for keywords
and descriptions. Here’s a brief explanation of each tag; the steps for filling
each tag with text are coming up:

1~ Meta keyword tag: A meta keyword tag enables you to include a list of
keywords you would like search engines to match if someone searches for
those words. Unfortunately, meta keywords have been so abused by web
designers attempting to mislead visitors about the true content of their
web pages that most search engines ignore the meta keyword tag and its
contents. That said, using this meta tag won’t hurt your ranking with any
search engines and many search engine experts still include them.

1~ Meta description tag: This tag is important and should be included in
every page in your website. The meta description tag is designed to let
you include a written description of each page — a worthwhile endeavor
because most search engines, including Google, use the meta descrip-
tion as the brief description that appears in search results pages. Make
the description a call to action, almost like a short advertisement, for the
page that will get potential visitors to click your link when they are read-
ing through a list of matches to a search. If you don’t include your own
text in a meta description tag, many search engines use the first several
words that appear on your page as the description. Depending on your
design, the first few words may not be the best description of your site.
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The advent of social media has made the meta description tag even
more important. When someone posts your web page by entering the
URL into a social media site, the text you include in the meta description
tag is included automatically with their post. Similarly, the meta descrip-
tion is included when someone shares a page on your site using a social
media icon. (See Chapter 15 for tips on adding social media icons to
your website.)

You can include the same meta description on every page of your site, but
the best strategy is to include a description specific to the contents of each
page on your site.

Follow these steps to add a meta description tag to your page:

1. Open the page where you want to add a meta description.
2. Choose Insert>Head~>Description.

(Alternatively, you can use the Head option from the Common Insert
panel.) The Description dialog box appears.

3. In the Description text box, enter the text you want for your page
description.

Don’t add any HTML to the text in this box. Most search engine experts
recommend that you limit this text to no more than 160 characters
because that is all that will be included in the search results page on
sites such as Google.

4. Click OK.

The description text you entered is inserted between the <head> tags
area at the top of the page in the HTML code. Meta content doesn’t
appear in the body of the page, but you can find it just below the
<title> tag if you look at the code behind the page.

If you want to add keywords, repeat Steps 1-4, choosing Insert Head =
Keywords in Step 2. Type a list of keywords, separated by commas, in place
of a description in Step 3.

Dreamweaver’s meta tag tools are somewhat limited. You can use them to
add these tags but not to edit them. To edit the text in meta description

or keyword tags after you've inserted them, you have to view the code in
Dreamweaver and edit the text in Code view. You’ll find this text near the top
of the HTML code, just below the <title> tag in the area surrounded by the
<head> tags.
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Creating Web Graphics

In This Chapter

Creating and optimizing images for the web
Inserting and aligning images
Editing images in Dreamweaver

Including a background image

N o matter how great the writing on your website may be, the graph-
ics always get people’s attention first. The key to making a good first

impression is to use images that look great and download quickly.

If you're familiar with using a graphics-editing program, such as Adobe
Photoshop or Fireworks, to create graphics for the web, you're a step
ahead. If not, you'll appreciate this chapter’s pointers on how

to convert images for the web, what image formats to use,

and how to optimize images for faster download times.
The examples in this chapter were created using Adobe
Photoshop CS6, but the features I used are nearly
identical in both Photoshop CS6 and Photoshop
Elements, so you can use the same instructions
in either program. (See the sidebar “Comparing
Adobe web graphics programs” to find out more
about the differences.)

If your images are already in GIF, JPEG, or PNG
format and ready for the web, you can jump ahead

to the “Inserting Images in Dreamweaver” section,
where you find out how to place and align images and
use an image as a background. You also discover some of
Dreamweaver’s built-in image-editing features, which enable
you to crop images and even adjust contrast and brightness with-
out ever launching an external image-editing program.
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Comparing Adobe web graphics programs

Most professional designers strongly prefer
Adobe Photoshop, although | have to say I've
been impressed with Photoshop Elements,
which is a light version but offers many of the
same features for a fraction of the cost. The
following is a list of some of the most popular
image-editing programs on the market today.
All these image programs are available for both
Mac and Windows:

+~ Adobe Photoshop (www.adobe.com/
photoshop): By far the most popular
image-editing program on the market,
Photoshop is a widely used standard among
graphics professionals. With Photoshop,
you can create original artwork, edit and
enhance photographs, and so much more.
Photoshop has a wealth of powerful paint-
ing and selection tools, special effects, and
filters that enable you to create images
far beyond what you can capture on film
or create with many other illustration
programs.

Adobe Photoshop Elements (www . adobe .
com/elements): If you don't need all the
bells and whistles offered in the full-blown
version of Photoshop, Photoshop Elements is
a remarkably powerful program — for about
a sixth of the price. If you're a professional

designer, you're best served by Photoshop.
But if you're a hobbyist or small-business
owner and want to create good-looking
images without the high cost and learning
curve of a professional graphics program,
Elements is a great bargain.

Adobe Fireworks (www.adobe.com/
fireworks): Fireworks was one of the
first image-editing programs designed to
create and edit web graphics. Created by
Macromedia, the program is now part of
Adobe Web Suite and is fully integrated
with Dreamweaver. Fireworks gives you
everything you need to create, edit, and
output web graphics, all in one well-
designed product. Fireworks lacks many of
the advanced image-editing capabilities of
Photoshop but shines when creating web
graphics and is especially popular among
web designers who rave about the capabil-
ity to create a design in Fireworks that can
easily be sliced and converted into a web
page in Dreamweaver.

If you have an Internet connection and want
to do basic image editing for free, visit www .
gimp.org. The site makes it possible to edit
and optimize images online without purchasing
a software program.

Creating and Optimizing Web Graphics

The most important thing to keep in mind when creating images for the web
is that you want to optimize your images to make your file sizes as small as
possible so that they download as quickly as possible.

S
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How you optimize an image depends on how the image was created and

whether you want to save it as a JPEG, PNG, or GIF. You find instructions for
optimizing images with Photoshop in the sections that follow, but the bottom
line is this: No matter what program, format, or optimization technique you
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choose, your biggest challenge is finding the best balance between small file
size and good image quality. Essentially, the more you optimize, the faster
the image will download, but the compression and color reduction tech-
niques used to optimize images can make them look terrible if you go too far.

As a general rule, do any editing, such as adjusting contrast, retouching, or
combining images, before you reduce their size or optimize them because
you want to work with the highest resolution possible when you’re editing.
Also, resize an image before you optimize it. You find instructions for resizing
an image in the next exercise and instructions for optimizing in the sections
that follow.

Resizing graphics and photos

Resizing is important for two reasons: The images must be small enough to be
displayed well on a computer monitor, and you want them to download quickly
to a user’s computer. The smaller the image is, the faster it will download.

Although you can change the display size of an image in a web page by
altering the height and width settings in Dreamweaver, you get much better
results if you change the dimensions of an image in a program such as
Photoshop.

When you alter an image’s height and width in the HTML code (by using

the height and width settings in Dreamweaver), you simply instruct a web
browser to display the image in a different size. Unfortunately, browsers don’t
do a good job of resizing images because browsers don’t change the image
itself but just force it to fit in the assigned space when the browser loads the
page. If you set the image to display larger than its actual size, the image is
likely to look fuzzy or distorted because it doesn’t contain enough pixels for
all the details to look good in a larger size. If you set the code to display the
image smaller than it is, the image is likely to look squished, and you're requir-
ing that your users download an image that’s larger than necessary.

Reducing an image’s size for use on the web requires two steps. First, you
reduce the resolution of an image, which changes the number of pixels in the
image. When you’re working with images for the web, you want to reduce the
resolution to 72 pixels per inch, or ppi. (If you’re wondering why 72, see the
sidebar that’s appropriately named “Should I use 72 ppi or a higher resolu-
tion?”) Second, you reduce the image’s physical size by reducing its dimen-
sions. You want to size your images to fit well in a browser window and to
work within the design of your site.
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Should I use 72 ppi or a higher resolution?

For years, most web designers have saved
images for the web at a resolution of 72 pixels
per inch (better known as ppi). Most computer
monitors displayed no more than 72 ppi, so any
resolution higher than that was wasted on the
web and you'd be making your visitors down-
load more pixels than they could see.

One of the emerging questions on the web is
whether designers should start increasing the
resolution of the images we're using to keep
pace with the higher resolution offered by the
new breed of mobile devices, such Apple’s
iPhones with ultra-high-density pixel resolu-
tion, Retina display laptops, and widescreen
monitors.

Of course, other manufacturers followed suit,
and we are now seeing that the old 72 ppi
standard is quickly becoming outdated. Most
modern computer monitors are capable of dis-
playing images at 96 to 100 ppi resolution or
higher.

So what should you do? Well, as with everything
web-related, there are tradeoffs. More pixels
mean better appearance but also an increased
image size — and longer page load times. Here
are your options:

1~ Stick with 72 ppi. Upside: It's what most
designers still use, and it still looks good in
even the latest browsers. You won't have
to go back to all your sites and resize and
resample your photos. Downside: In a few
years, your photos and graphics could look

grainy and pixelated when compared to
higher-resolution sites.

Make an incremental change to 96 or 100
ppi. Upside: The increased resolution will
make your images look better on the more
advanced displays, without really hitting
your page load times. Downside: A few
years from now, you may have to go through
this process again when even higher reso-
lutions are in vogue.

Use the @2x tag. Upside: This option
enables you to swap a lower resolution
image for a higher resolution image using
CSS media queries. Downsides: Not all
devices support this option, so it works only
for a limited audience. And Dreamweaver
does not support this feature, so you'll have
to write the CSS yourself. Here's an exam-
ple of a background image that use the @2x
option:

.background-image {
background: url(../images/cool-
background.png) repeat;
background-size: 100px 100px;
}

@media only screen and (-webkit-min-
device-pixel-ratio: 2) {
.background-image {
background: url(../images/
cool-background@2x.png)
repeat;

Follow these steps to lower the resolution and reduce the size of an image in
Photoshop. (In Photoshop Elements or Fireworks, you follow a similar pro-
cess although the specific steps may vary.)

1. With an image open in Photoshop, choose Image->Image Size.

The Image Size dialog box opens, as shown in Figure 3-1.
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If you don’t want your original image to lose quality (or you just want to
play it safe), make a copy of your image and resize the copy for your
website.

Image Size =
Pizel Dirnensions: 1,200
width: 702 pixels [ cCancel |
Height: 522 pixels auto |
Document Size:
width: 11 Inches A
Height: 73332 Inches h 8

Resolution: Pixels{Inch -

Scale Styles
Constrain Proportions
Resample Image:

BicLbic Autormatic -

Figure 3-1: Change the image resolution to 72 ppi
for a faster download.

2. To change the resolution of your image, first deselect the Resample
Image check box at the bottom of the Image Size dialog box.

For best results, you always want the Resample Image check box dese-
lected when you change the resolution.

3. Click and drag to highlight the number in the Resolution field and
replace it by typing the number 72.

4. Select the Resample Image check box.

With the Resample Image check box deselected, you can’t change the
Pixel dimensions, so it must be checked when you change the image
size.

5. Enter a height and width for the image in the Height and Width fields.

As shown in Figure 3-2, 'm changing the size of this image to 528 pixels
high. If the Constrain Proportions check box at the bottom of the dialog
box is selected (as it is in this example), any changes you make to the
height automatically affect the width (and vice versa) to ensure that the
image proportions remain constant. | prefer to work this way, but if you
do want to change the image and not maintain the proportions, deselect
this box.
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Photo by Casey Stoll
Figure 3-2: Specify a new image size in pixels or as a percentage of the original size.

6. Click OK to resize the image.

If you want to return the image to its previous size, choose Edit~>Undo
Image Size. Beware that when you save the image, the changes become
permanent.

Choosing the best image format

One of the most common questions about images for the web concerns
when to use GIF or PNG and when to use JPEG. Table 3-1 provides the simple
answer.
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Table 3-1 Image Formats for the Web

Format Best Use

GIF For line art (such as one- or two-color logos), simple drawings,

(.gif) animations, and basically any image that has no gradients or
blends. GIF is also the best format when you want to display an
image with a transparent background.

Animated GIF The simplest way to animate a web page. Animated GIFs work

(.gif) in almost every web browser used on the Internet, even very old
browsers. Animated GIFs are a special type of GIF made up of a
series of image frames, displayed in succession. These simple
animations can include time delays between frames and can
loop so that the series of images plays over and over.

PNG PNG generally produces better-looking images with smaller

(.png) file sizes than GIF for the same kinds of limited-color images.
Really old browsers, such as IE 3, dont support the PNG format,
but most web designers today choose the PNG format over GIF
because so few people use such old browsers.

JPEG JPEG is the best format for colorful, complex images (such as

(.jpgor photographs); images containing gradients or color blends; and

. jpeg) any other images with millions of colors.

Saving images for the web: The basics

If you're new to saving images for the web, the following basics can help you
get the best results from your files, your image-editing program, and ulti-
mately your web pages. You can

1~ Convert an image from any format into the GIF, PNG, or JPEG format.
For example, turn all your TIF, BMP, and PSD image files into a web-
friendly file format.

1 Optimize images that are already in GIF, PNG, or JPEG format. Even if
your files are already in a web-friendly format, following the instructions
in this chapter to optimize images with Adobe’s Save for Web dialog box
further reduces their file sizes for faster download over the Internet.

1~ Use many programs to create web graphics. However, Photoshop is
one of the most popular ones to use. Under the File menu in Photoshop
(and Photoshop Elements), you’ll find the Save for Web option. (In
Photoshop CS5, the option was changed to Save for Web and Devices.)
Fireworks provides a similar feature, and although each program’s
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dialog boxes are slightly different, the basic options for compressing
and reducing colors (which are covered in this chapter) are the same.

See the upcoming sections “Optimizing JPEG images for the web” and
“Optimizing images in GIF and PNG formats” for details about using the
Save for Web & Devices feature.

1~ Make image edits before you optimize. When you're editing, using
the highest quality image possible is always best. Make sure to do all
your editing, sharpening, and resizing before you use the Save for Web
option. Similarly, if you want to make further changes to an image after
you’ve optimized it, you'll achieve the best results if you go back to a
higher resolution version of the image rather than editing the version
that’s been optimized for the web. (When you use the Save for Web fea-
ture, Photoshop creates a new copy of your image and leaves the origi-
nal unchanged.)

Optimizing JPEG images for the web

The JPEG format is the best choice for optimizing continuous-tone images,
such as photographs and images with many colors or gradients. When you
optimize a JPEG, you can make the file size smaller by applying compression.
The more compression, the smaller the image, but if you compress the image
too much, the image can look terrible. The trick is finding the right balance,
as you discover in this section.

If you have a digital photograph or another image that you want to prepare
for the web, follow these steps to optimize and save it in Photoshop (in
Photoshop Elements or Fireworks, the process is similar although the spe-
cific steps may vary):

1. With the image open in Photoshop, choose Filer>Save for Web.
The Save for Web dialog box appears.

2. In the top-left corner of the dialog box, choose either the 2-Up or 4-Up
tab to display multiple versions of the same image for easy comparison.

In the example shown in Figure 3-3, I chose 2-Up, which makes it pos-
sible to view the original image on the top and a preview of the same
image as it will appear with the specified settings on the bottom. The
4-Up option, as the name implies, displays four different versions for
comparison (as shown later in this chapter in Figure 3-4).
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Figure 3-3: Use JPEG for photographs and other images with millions of colors.

3. On the right side of the window, just under Preset, click the small
arrow to open the Optimized File Format drop-down list and choose
JPEG (this list is open in Figure 3-3).

4. Set the compression quality.

Use the preset options Low, Medium, High, Very High, or Maximum from
the Compression Quality drop-down list. Or use the slider just under

the Quality field to make more precise adjustments. (The slider appears
when you click the arrow.) Lowering the quality reduces the file size and
makes the image download more quickly, but if you lower this number
too much, the image will look blurry and blotchy.

Photoshop uses a compression scale of 0 to 100 for JPEGs in this dialog
box, with 0 the lowest possible quality (the highest amount of compres-
sion and the smallest file size) and 100 the highest possible quality (the
least amount of compression and the biggest file size). Low, Medium,
and High represent quality values based on the amount of compression.
The more compression applied, the lower the image quality.
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5. Specify other settings as desired (the compression quality and file
format are the most important settings).

6. Click Save.
The Save Optimized As dialog box opens.

7. Enter a name for the image and save it to the images folder in your
website folder.

Photoshop saves the optimized image as a copy of the original and
leaves the original open in the main Photoshop work area.

Repeat these steps for each image you want to optimize as a JPEG.

At the bottom of the image preview in the Save for Web dialog box,
Photoshop includes an estimate of the time required for the image to down-
load at the specified connection speed. In the example shown in Figure 3-3,
the estimate is 32 seconds at 56.6 Kbps. As you adjust the compression
settings, the size of the image changes and the download estimate will auto-
matically adjust. You can change the connection speed used to make this cal-
culation by clicking the small arrow just to the right of the connection speed
and using the drop-down list to select another option, such as 256 Kbps for
cable/DSL modem speed. Use this estimate as a guide to help you decide how
much you should optimize each image.

Optimizing images in GIF and PNG formats

If you're working with a graphic that can be displayed in 256 colors or less,
such as a logo, cartoon character, or drawing, your best bet is to use the PNG
format and reduce the total number of colors used in the image as much as
possible to reduce the file size. (If you're concerned about visitors using a
very, very old web browser, use GIF instead.)

To help make up for the degradation in image quality that can happen when
colors are removed, GIF and PNG use a dithering trick. Dithering involves
alternating pixels in a checkerboard-like pattern to create subtle color varia-
tions, even with a limited color palette. The effect can smooth the image’s
edges and make it appear to have more colors than it actually does.

To convert an image to a GIF or a PNG in Photoshop, follow these steps (in
Photoshop Elements or Fireworks, the process is similar although the spe-
cific steps may vary):
1. With the image open in Photoshop, choose Filer>Save for Web.
The Save for Web dialog box appears.
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2. In the top-left corner of the dialog box, choose the 2-Up or 4-Up tab to
display multiple versions of the same image for easy comparison.

In the example shown in Figure 3-4, I chose 4-Up, which makes it possi-
ble to view the original image (in the upper-left corner), as well as three
different previews of the same image.

3. Select a preview image to begin changing its settings.

Changing the preview images in the 4-Up view enables you to compare
the original image with up to three versions using different color, trans-
parency, dither, and other settings, covered in the steps that follow.

4. On the right side of the dialog box, just under Preset, click the small
arrow to open the Optimized File Format drop-down list and choose
PNG-8.

Although PNG-24 does produce a better quality image, not all web
browsers support PNG-24, so PNG-8 is the safer option if you want the
image to display consistently for the broadest audience on the web.
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24 PNG-8 -
Q Perceptual v Colars: 256 [¥]
i Diffusion v Dither: 100% ||
] [] Transparency Matte: [=]
= Mo Transparency Dither ¥ Amount: -
[]interlaced Wreb Snap: | 0% Iz‘

[] convert ta sRaE

Preview: Monitor Color -

Metadata: Copyright and Cortact Info -
Originals "aniversary.jpg" PNG-2 100% dither -
201K 18.23K Perceptual palette el Tetidy =
dsac@SEsKbps = 256 colors

Image Size

Wi 300 px:l Percent: 100 %
W 220 px =" Guality: Bicubic -
PNGE 100% dither | PNG-2 100% dither
2,259 Parceptual palte | 1.227K Parceptual palette AR
Lsec@ShbKbps = dcolors | 1sec @ ShbKbps = 2 colors
Looping Options: | once -
D] 10w [+] Ri2S5 G & BiZSE Alphat 255 Hext FFFFFF Indext 171 1of1 di
Preview... [* Save... ] ( Cancel ) ( Done )

lllustration by Tom McCain
Figure 3-4: GIF and PNG are best for images with limited colors.
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5.

10.

In the Colors box, select the number of colors.

The fewer colors you use, the smaller the file size and the faster the
image will download. But be careful; if you reduce the colors too much
(as I have in the bottom-right preview shown in Figure 3-4), you lose
details. The ideal number of colors depends on your image; if you go too
far, your image will look terrible.

. If you want to maintain a transparent area in your image, select the

Transparency check box.

Any area of the image that was transparent when you created the image
in the editor appears transparent in the preview window. If you don’t
have a transparent area in your image, this setting has no effect.

Transparency is a good trick for making text or an image appear to float
because a transparent background doesn’t appear on the web page. You
can select transparency as a background option in the New File dialog

box when you create a new image in Photoshop or Photoshop Elements.

. If you choose Transparency, also specify a Matte color.

You want the matte color to match the background of your web page so
that the dithering along the transparent edge will blend with the back-
ground. If you don’t specify a matte color, the transparency is set for a
white background, which can cause a halo effect when the image is dis-
played on a colored background.

. Specify other settings as desired.

The remainder of the settings in this dialog box can be left at their
defaults in Photoshop.

. Click Save.

The Save Optimized As dialog box opens.

Enter a name for the image and save it into the images folder (or any
other folder) in your local site folder.

Repeat these steps for each image you want to optimize as a GIF or PNG for
your site.

Trial and error is a great technique in the Save for Web dialog box. In each of
the three preview windows displaying optimized versions of the cool cartoon
image in Figure 3-4, I used fewer and fewer colors, which reduced the file size
with an increasingly degrading effect.
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How small is small enough?

After you know how to optimize GIFs and JPEGs and appreciate the goal

of making them as small as possible, you may ask, “How small is small
enough?” The answer is mostly subjective, but the following points are good
to remember:

1~ The larger your graphics files, the longer people have to wait for them
to download. You may have the most beautiful picture of Mount Fuji on
the front page of your website, but if it takes forever to download, most
people won’t be patient enough to wait to see it.

1 When you build pages with multiple graphics, consider the cumula-
tive download time of all the graphics on the page. Even if each indi-
vidual image is a small file size, the cumulative image size can add up.
Unlike most things in life, smaller is definitely better on the web.

1~ Most web pros consider anything from about 75K to 150K a good
maximum cumulative size for all the elements on a given page. With
the increasing popularity of DSL and cable modems, many websites are
starting to become a bit more graphics heavy and go beyond that size
limit. However, anything over 150K is pushing the limit, especially if you
expect people with dial-up modems (56K and under) or those surfing on
mobile phones to stick around long enough to view your pages.

Inserting Images in Dreamweaver

Now for the fun part. Adding an image to your web page may seem almost
magical at first because the process is so simple with Dreamweaver. The
challenge with web graphics isn’t adding them to your pages but creating
good-looking images that load quickly in your viewer’s browser. You need
another program, such as Photoshop, Photoshop Elements, or Fireworks, to
create, convert, edit, and optimize images. Optimizing images makes file sizes
smaller so your images download faster. Dreamweaver provides some basic
image-editing tools, but mostly you use Dreamweaver to insert and position
images on your page.

Dreamweaver makes placing images on your web pages easy and provides
multiple ways to do so:

v~ Click the Images icon in the Common Insert panel and then select an
image using the Insert Image dialog box.

+~ In the Files panel, click and drag an image name onto the page where
you want the image to appear.

v~ Use the Insert menu, as [ explain in the following steps.
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If you don’t have a web-optimized JPEG, GIF, or PNG image handy, you can
download free images that are already optimized by going directly to www .
DigitalFamily.com/free. (You find instructions for downloading the free
images when you get to this special page on my website.)

To place an image on a web page using the Insert menu, follow these

instructions:

1. Open an existing page or create and save a new page.

2. Place your cursor where you want to insert the image on the page.
You can insert images into the top left of a new blank file, and you can
insert images into <div> tags and elements in a web page, but you can’t
just place an image in the middle of a page without using additional
HTML tags or CSS formatting to position it. See the “Why can’t I place
images anywhere [ want them?” sidebar, later in the chapter, for more
on how to position images in a page.

3. Choose Insert->Image~>Image.

The Select Image Source dialog box appears.
4. Browse to locate the image you want to insert.

Depending on your computer system, you can preview images as you
insert them in different ways. Here are three common options:

* On a PC with Windows XP, choose Thumbnails from the View
menu drop-down list to the right of the Look In field to display
thumbnail versions of all the images in any open folder. You can
also view a single preview of any selected image in the far right of
the dialog box.

* On a PC with Windows Vista or Windows 7 (as shown in
Figure 3-5), choose one of the icon options (Small Icons, Medium
Icons, Large Icons, or Extra Large Icons) from the View menu drop-
down list to the right of the Look In field to display thumbnail ver-
sions of all the images in any open folder. You can also view a single
preview of any selected image to the far right of the dialog box.

* On a Mac, choose the View As Columns option from the top left
of the dialog box. You can view a single preview of any selected
image in the far right of the dialog box.
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Figure 3-5: Locate and preview images in the Select Image Source

dialog box.

To insert the image, double-click the image name or click once and

then click OK.

If you insert an image into a page and the image isn’t saved in your local
site folder, Dreamweaver prompts you with a warning dialog box and
offers to copy the image into your local site folder. (Find out how to set
up a local site folder in the section in Chapter 2 on setting up new or
existing sites.) Many designers create a subfolder called images inside
the local site folder where they store all the images in their site, but you
can organize images in multiple subfolders if you prefer.

Select the image on your web page to view and edit image properties.

Image options are displayed automatically in the Property inspector at
the bottom of the page when an image is selected, as shown in Figure 3-6.
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Figure 3-6: The Property inspector provides easy access to common image attributes.

Table 3-2 describes the many image attributes available in the Property
inspector when an image is selected. If you don’t see all the attributes listed in
the table on your screen, double-click the bottom-right corner of the Property
inspector to expand it to reveal all the image options shown in Figure 3-6.

Table 3-2 Image Attributes in the Property Inspector

Abbreviation Attribute Function

Image N/A Displays the file size.

D Name Identifies the image uniquely on the page — an
important detail if you use behaviors or other
scripts that target an image. Can be left blank.

Map Map Name Assigns a name to an image map. All image
maps require a name.

Hotspot Image Map Creates image map hotspots for links in the

tools Coordinates shape of a rectangle, an oval, or a polygon.
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Abbreviation Attribute Function

Src Source Automatically sets the source (the filename
and path from the current document to the
desired image). Required.

Link Hyperlink Displays the address or path if the image is
used as a link.

Target Link Target Controls how a link opens in a web browser.
For example, if you want the link to open a
new browser window, choose _blank.

Original N/A Indentifies the original version of the image,
if you're using the Smart Objects features in
Photoshop or Firefox. (See your Photoshop
or Firefox documentation for more on these
features.)

Class CSS Setting Enables you to apply any class styles defined
in Dreamweaver. To use this option, select
any element in the workspace and then
select any class style you want to apply in
the drop-down list.

Edit Edit Launches the image editor associated with
Dreamweaver. (You can change these settings
in Dreamweaver’s Preferences dialog box.)

Edit Edit Image Launches the Image Optimization dialog box,

Settings where you can make basic edits to an image.

Edit Update from Ensures that edits are made using the origi-

Original nal image. Note: This setting works only if
you've used an associated Adobe image
editor to edit the image before inserting the
image on the page.

Icons for Crop; Make minor alterations to an image in

Resample; Dreamweaver. Note: Any changes made
Brightness using these options permanently alter the
and Contrast; image when the page is saved.

and Sharpen

W Width Specifies the width of the image based on the
actual size of the image dimensions.

H Height Specifies the height of the image based on
the actual size of the image dimensions.

Alt Alternate Text Enables you to add or edit alternate text.

79
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Why can’t | place images anywhere | want them?

You can't just place your cursor anywhere on  browser window. To create more complex lay-
a page and insert an image where you want it.  outs and position images precisely on a page,
This isn't a limitation of Dreamweaver; the way  your best option is to create a layout with CSS
HTML s displayed on the web restricts howyou (which | cover in Chapters 5-8). You can also
can place images. use an HTML table to position elements on a

By default, all images, text, and other elements web page (which | cover in Chapter 10}

are inserted starting at the top-left corner of the

Q‘&N\BER When you insert an image file onto a page, you don’t actually add a copy of
& the image to the page; you create a reference to the image. The underlying
code looks much like the code for a link from one page to another. Both
image references and links include the name of the file (the page you link to
or the image you insert) and the path from the page to that file. Essentially,
you're creating an instruction for a web browser to find the image when it
displays the page.

To display an image on your web page, you need to upload both the page and
the image when you publish your website. If your image files and the pages
that refer to those files aren’t in the same relative location on your hard drive
as they are on your web server, you break the reference to your images, and
an ugly Broken Image icon appears on your page. The best way to make sure
that your images and files stay where they’re supposed to in relation to one
another is to let Dreamweaver keep track of them for you. That’s why it’s so
important to complete the site setup process at the beginning of Chapter 2
and to make sure you never move or rename an image, except in the Files
panel.

Image Editing in Dreamweaver

Dreamweaver includes basic image-editing features, including the Crop,
Resample, Brightness and Contrast, and Sharpen options. You find these
tools just below the Class field in the Property inspector, as shown in

Figure 3-7. Image-editing features in Dreamweaver enable you to make minor
changes to images without opening Fireworks, Photoshop, or any other
graphics-editing program.
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Figure 3-7: Use the image-editing tools to do basic image editing.

Before you get carried away editing your images, remember that
Dreamweaver is primarily an application for creating web pages and isn’t
designed to edit graphics. Although these tools can be useful, they shouldn’t
take the place of doing serious work on your graphics in a graphics applica-
tion, such as Fireworks or Photoshop.

When you use Dreamweaver’s image-editing tools, beware that you’re chang-
ing the actual image (not just a copy of it). Make sure you're happy with
these changes before you save the page you're working on. You can use the
Undo feature in Dreamweaver to revert several steps, but after you save the
page, you can’t undo changes made to an image with these tools. To protect
your original image, save a copy before editing it.

Cropping an image

Essentially, cropping an image involves trimming its edges. If you're trying to
fit an image into your design and need the image to be just a touch smaller,
Dreamweaver’s cropping tool can come in handy. To crop a graphic or
photo, open the page that contains the image you want to edit, and follow
these steps:

1. Select the image you want to crop by clicking it.
The Property inspector changes to display the image’s properties.

2. Click the Crop icon.

A dialog box appears, warning you that cropping changes the original
image.

If you're concerned about keeping the entire image available, don’t make
the change. Instead, make a copy of the image before you crop it.
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3. Click OK in the Dreamweaver dialog box.

A solid crop line with selection handles at the sides and corners appears

over the image, as shown in Figure 3-8.

4. Click and drag the selection handles to outline the area of the image

you want to keep.

Any part of the image outside the crop line (and shaded) is deleted

when the crop is completed.

5. Double-click inside the box or press Enter (Return on a Mac).

The image is cropped.

You can undo cropping by choosing Edit=>Undo Crop. However, after you
save the page, changes are applied permanently to the image and can’t be

undone.
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Adjusting brightness and contrast

Adjusting an image’s brightness allows you to change the overall amount of
light in an image. Contrast controls the difference between the light and dark
areas of an image.

“&N\BER . ) . .
& Using Dreamweaver’s editing tools permanently alters the image when the
page is saved. If you're concerned, the best thing to do is to make a copy of
the image and make your adjustments to the copy.

To adjust brightness and contrast, follow these steps:

1. In the Document window, select the image you want to alter.
The Property inspector shows the image properties.
2. Click the Brightness and Contrast icon (labeled in Figure 3-7).

A dialog box appears, indicating that the changes you make will affect
the original file.

3. Click OK in the Dreamweaver dialog box.
The Brightness/Contrast dialog box appears.

4. Use the sliders to adjust the brightness and contrast settings of the
image.

Make sure to select the Preview check box if you want to see how the
changes affect the image as you move the sliders around.

5. Click OK.

The settings take effect permanently when you save the page.

Sharpening an image
When you apply sharpening to an image, you increase the distinction between

areas of color. The effect can increase the definition of shapes and lines in an
image.

q}‘& Using Dreamweaver’s editing tools permanently alters the image when the
page is saved. If you're concerned, the best thing to do is to make a copy of
the image and make your adjustments to the copy.

To sharpen an image, follow these steps:

1. In the Document window, select the image you want to sharpen.

The Property inspector shows the image properties.



8 ﬂ Part I: Getting Started with Dreamweaver CC

A\\S

2. Click the Sharpen icon (labeled in Figure 3-7).

A dialog box appears, warning that your change is made to the original
file.

3. Click OK in the Dreamweaver dialog box.
The Sharpen dialog box appears.
4. Use the slider to adjust the sharpness of the image.

Select the Preview check box to see how the changes affect the image as
you move the slider.

5. Click OK.

The image is sharpened, and changes to the image become permanent
when you save changes to the page.

Opening an image in Photoshop or
Fireworks from Dreamweaver

The Property inspector includes an icon that enables you to easily open

an image in Photoshop or Fireworks from Dreamweaver. The Edit icon
changes to the icon of the program specified in Dreamweaver’s preferences.
To open an image in your preferred program, simply select the image in
Dreamweaver, click the icon in the Property inspector, and watch your image
appear as you've commanded.

Adobe has done great work integrating the Photoshop and Fireworks pro-
grams into Dreamweaver. When you save changes to the image in Fireworks
or Photoshop, they’re automatically reflected in the version you've already
inserted into a page in Dreamweaver.

To specify the image editor you want to associate with a file type in
Dreamweaver’s preferences, follow these instructions:

1. Choose Edit~>Preferences (Windows) or Dreamweaver~Preferences
(on a Mac).
The Preferences dialog box opens.

2. On the left, select the File Types/Editors category, as shown in
Figure 3-9.

3. In the Extensions pane, select an image format.

Dreamweaver lists a wide variety of file types here, and you can associ-
ate any or all of them with your favorite editors. To associate image edi-
tors with these graphic formats, select the GIF, PNG, and JPEG options
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one at a time and then continue with these steps. In the example shown

in Figure 3-9, I've selected the .png format and I'm associating it with
Photoshop.

Preferences

Categery File Types / Editors
General
Accessibiity
Code Coloring
Code Format

Please choose the file types to associate with Dreamveaver:

Code HIrts Cascading Style Sheet (css)
Code Rewriting JavaScript (js)
Copy Paste
5 Styles PHP (o0
File Compare Extensble Markup Language (xml)
Forits
Highlighting Please choose external applications to associate with Dreamueaver !
Invisible Elements - - P —
Mew Document ®= = = = Make Primary
Preview in Browser
Site A
Extensions
Sync Settings Edry
W3C Validator 200 Fireworks
Window Sizes .gif gimp-2.8
1pa Jpe Jpeg &
psd k
fla
wav
aff . aif aifc
.mp3 -

Qpenin code view: 33 .asa .cs5 Ine txt.as asc .asr htaccess htpasswd

MiscellaneoLis:

Reload modified fles: Prompt v
Save on launch:|Prompt -

Fireworks: C:\Program Fles (86 dobeiidobe Fireworks CSB\Freworks. Browse...

Figure 3-9: Use the preferences settings to associate your favorite
image editor.

In the Editors pane, select the editor you want associated with the
.png format.

In the example shown in Figure 3-9, Photoshop is already included in
the list of options, so you can simply click Photoshop to select it. If you
want to associate an editor that isn’t on this list, click the plus sign (+)
just above the Editors pane, browse to find the program on your hard
drive, and select it to make it appear on the list.

With the file type and program name selected, click the Make Primary
button to associate the editor with the file type.

The editor specified as primary is launched automatically when you
select an image in Dreamweaver and click the Edit icon in the Property
inspector.
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6. Select .jpeg from the Extensions pane and repeat Steps 4 and 5.

You can continue with this process for any or all the other formats
listed.

To add additional file formats to Dreamweaver, click the plus sign (+) over
the Extensions pane and type the extension, beginning with a dot (.).

Inserting a Background Image

Background images can add depth and richness to a page design. Used clev-
erly, a background image that downloads quickly and efficiently helps create
the illusion that the entire page is one large image. The trick is to use an image
with a small file size that creates the impression of a large image. One way this
works on the web is to use the default settings for a background image, which
cause the image to tile (repeat) across and down the page (see Figure 3-10).

DW File Edit View Inset Modify Format Commands Site  Window Help Classic - w, @ (== X |

background.htmis  x | =l

Code ‘ Spiit Deswgn] Live = &) Tie: Background example

‘i h ‘i ‘i h b t;i
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<bo(-jy> <h1>
SPHTML  TargetedRule < inline style > ~ | Font & Default Font - - - £ £ £ E
B css | Edit Rule £S5 Panel Size - - J #FFF

Photo by Casey Stoll
Figure 3-10: You can repeat a background image across and down a page.
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Text placed on certain backgrounds (such as the one shown in Figure 3-10)
can be difficult to read. Choose your background images carefully and make
sure your background and your text have plenty of contrast. Reading on a
computer screen is hard enough.

With CSS, you can have far greater control over the display of a background
image. When you create a CSS background style, you can insert a background
image that doesn’t repeat or that repeats only across the Y axis or down the
X axis of the page.

To insert a background image in Dreamweaver, choose Modify=>Page
Properties, click the Browse button to the right of the Background Image field
(see Figure 3-11), and select the image you want to use as your background. If
the image isn’t already in your local site folder, Dreamweaver offers to copy
it there when you click OK.

Page Properties =]

Category Appearance (CS5)

Appearance (HTML) Page font: B Default Font - - -

Lirks (CS5)
Headings {CSS) Size: v e v

Title/Encoding

Tracing Image Text color: D

Background color D

Background image:  images/galery-photos/thumbnails Might-we Browse...

Repeat:
no-repeat
Left mardin: repeat-x % RIGHT margin: px >

repeat-y.
Top margin: px - Bottom margin: px -

Help: 0K ] | Cancel | ‘ Apply

Figure 3-11: Control how a background image is repeated on a page.

When you insert an image using Dreamweaver’s Page Properties feature,
you can use the Repeat drop-down list to specify how the image repeats
on the page, as shown in Figure 3-11. When you specify a repeat option,
Dreamweaver automatically creates a style for the page with these back-
ground settings. If you use the CSS Definition dialog box to further edit the
background options in the body style (covered in Chapter 5), you can also
specify where the background image is displayed on a page.
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Managing, Testing, and
Publishing a Website

In This Chapter
Previewing your site in different web browsers
Testing your site with the Dreamweaver site-reporting features
Finding and fixing broken links
Renaming files and adjusting links
Setting up FTP and other file transfer options
Publishing your site to a web server

rle scenario is shocking: You create a page design that looks
just perfect in your favorite web browser on your own
computer. You publish your site on the Internet and tell
all your friends. And the next thing you know, your
cousin in Chicago and your friends in Italy are telling
you that the site looks terrible, the text is unread-
able, and your video files won’t play at all.

Don'’t let this happen to you. Take time to test your
work before you publish it to ensure that your site
works well in the many different web browsers,
operating systems, and monitor sizes that your visi-
tors are likely to use on today’s increasingly diverse
Internet. Web pages can look very different depending
on the browser, especially older versions, and they can
fall apart if you design on a giant desktop monitor and
then try to use the site on a tiny cell phone screen.

No matter how your pages are viewed, you also want to use Dreamweaver’s
tools to check that your site code is valid, all the links work, and everything
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is in tip-top shape. As you work with the files in your site, you may appreci-
ate that Dreamweaver includes tools for managing files and folders so that
your links stay current as your site grows. And when you’re ready to publish
or update your site on the web, Dreamweaver has tools to help you transfer
files, too. In this chapter, you discover how to test and publish a website, and
you find a few tips I've learned about designing websites that look good to
everyone who visits your site.

If you're looking for information about where to host your website, how
to choose a web-hosting service, or how to register a domain name, find
recommendations and tips for choosing the best services on my site at
www.digitalfamily.com/hosting/.

Understanding Why Web Pages Can
Look Bad in Some Browsers

A confusing and frustrating aspect of web design is that different browsers
and computer systems affect a page’s appearance. You can create a page
that looks great in Dreamweaver and test it in a browser to confirm that it
looks fine only to discover later that the page looks terrible in another web
browser or on a different computer system. Web pages can look different
from one system to another for many reasons, but the following issues are
the most common culprits:

~ Browser differences: Today, dozens of browsers are in use on the web,
not counting the different versions of each browser. For example, at the
time of this writing, Internet Explorer (IE) 10 is the newest release from
Microsoft, but a significant percentage of web users haven’t upgraded
yet and are still using IE7 or even earlier versions. (More on browser dif-
ferences in the next section.)

1~ Mobile phones and tablets: The biggest challenge of today’s web is cre-
ating websites that look good on tiny mobile phone browsers, as well as
giant screens. Just because you can open your website on a smartphone
doesn’t mean it’s usable on the tiny screen. (For more on designing for
mobile and other small screen sizes, see Chapter 8.)

1~ Unsupported design features: One of the most exciting improvements
in web design in the last several years is the addition of design options
such as drop shadows, gradients, transparency, and the capability to
use almost any font. You can add these design features to your web
pages, even though they won'’t be visible on older browsers. However,
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make sure your pages are still readable, even if the drop shadows and
other features don’t work. (See the two upcoming figures for examples
of how CSS3 styles aren’t displayed in older web browsers.)

1~ Hardware differences: Another challenge comes from the differences
between Macintosh and Windows computers. For example, most fonts
appear smaller on a Macintosh than on a PC. (Times 12 on a PC looks
like Times 10 on a Mac, which makes text harder to read and can change
the layout of a page.) Image colors and brightness can also vary from
one computer to another.

+~ Individual preferences: Most web browsers include preference settings
that individual users can adjust to suit their needs. For example, some-
one may increase the text size in his or her browser settings to make
text more readable, which may cause the text on your carefully designed
pages to wrap and ruin the page design.

1~ Monitor resolution settings: In addition, the same web page may look
very different on a 21" monitor than it does on a 15" monitor. And even
on the same monitor, different resolution settings can alter the way a
page looks. On a PC, a common resolution is 1024 x 768; on a Mac, the
resolution is generally set much higher, making the design look much
smaller, even if the monitor sizes are the same.

As aresult of all these differences, the same web page can look very different
to the people who visit a website. For example, Figure 4-1 shows a web page
displayed in Dreamweaver’s Design view with the monitor resolution set to
1024 x 768. The screen is typical for a web page viewed in an old browser on
a relatively small, low-resolution monitor.

To get around the limitations of Dreamweaver’s Design view, Adobe added
the Live view option in Dreamweaver version 5. In version 6, Adobe short-
ened the name to Live and placed the option to the right of the other view
options, Code, Split, and Design. The Live option changes the display engine
to the webkit engine, which is used in the Safari and Chrome web browsers.
In version 7, Adobe updated the Live view options to provide even better
support for CSS3, but Design view still works much like a very old web
browser.

For example, Figure 4-2 shows the same page displayed in Figure 4-1 but

in the Google Chrome browser on a large monitor set to a higher resolu-
tion, 1280 x 800. Note how the Chrome web browser supports my use of an
unusual font and the transparent background in the main text box in the
middle page. Also note that more of the page is visible on a larger monitor
with a higher resolution.
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Figure 4-1: A web page in Dreamweaver's Design view with1024 x 768 resolution.
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This challenging aspect of the web is at the root of many of the limitations and
complications of creating good web designs. People who visit your site will use
different web browsers and some of them may not be able to see the latest fea-
tures. Your website will be viewed on very small screens on mobile phones as
well as on giant television monitors. With patience, testing, and an understand-
ing of the most problematic tags and styles, you can create great websites that
look good to most — if not all — of the people who visit your website.

Understanding browser differences

The many reasons why web pages can look different from one browser to
another can be boiled down to the following:

v~ Over the years, web browsers have evolved to support new web tech-
nologies. Thus, many older browsers still in use have trouble displaying
some of the latest, most advanced features that you can use on your
web pages today, such as rounded corners and drop shadows.

v Compounding this problem, the companies that make web browsers —
including Microsoft, Google, and Apple — don’t all agree or follow the
same rules (although most are getting better at complying with at least
most of the standards in their latest browser versions).

v~ Dozens of browsers are now in use on the web, not counting the dif-
ferent versions of each browser. For example, Google Chrome has
become increasingly popular and is one of the best for supporting pages
designed to follow modern web design standards. Unfortunately, a signif-
icant percentage of Internet users haven’t yet changed or upgraded and
many people are still using the browser that came with their computer.
If that browser is IE6, your pages will face a real challenge because IE6
is notoriously bad at displaying CSS (Cascading Style Sheets) and other
modern web features.

Browser limitations and differences are the root of many complications when
creating and testing websites. Entire books and websites are dedicated to
how best to design for the differences among browsers. I can’t possibly cover
all the issues or tricks to working around them in this book. However, in this
chapter, I do include tips and testing sites to help you ensure that your pages
look their best. In addition, throughout this book I try to stick to design strat-
egies and techniques that most browsers in use today support.

The best way to make sure your site looks good to your visitors is to write
clean code, test it for errors (using the testing tools included in this chapter),
and then preview how the site looks in a variety of web browsers, screen
sizes, resolutions, and operating systems. In the following sections, you find
instructions for adding browsers to Dreamweaver’s preview options and using
online services to test in browsers that you don’t have on your computer.
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Targeting browsers for your design

Some web designers have decided to ignore users with older browsers or

to simply include a warning message, such as: “This page looks best in the
latest version of Firefox; upgrade now.” Other designers carefully test their
pages in dozens of browsers to make sure they look good to as many people
as possible on the Internet. As you decide how to approach this issue, I sug-
gest taking your audience into account. For example, consider the following
scenarios and design accordingly:

 Your visitors are advanced computer users. If you run a website for
high-end game developers or web geeks and are confident that they
update their software regularly, you may not need to concern yourself
with older browsers. Similarly, if you're a photographer or designer
interested in winning over creative directors, you can probably assume
that they have large monitors and fast computers on their desk, but
keep in mind they probably also have iPhones and iPads and may be
using those to review your work.

1 Your site attracts users from large organizations. People at large cor-
porations, universities, or other big organizations often are not allowed
to update their own software. They’re stuck with older browsers until
some official decides to update their systems, which can take a notori-
ously long time. In this scenario, make sure your site is at least read-
able in older web browsers. That said, if you're designing a site for use
by people in only one company or organization, you can often find out
exactly what software they are using and design specifically for their
systems.

+ Your audience is made up of people with older computers who are
unlikely to have upgraded their web browsers. If you're designing a
website for a doctor’s office, real estate agency, little league team, or
another group likely to attract old and young visitors who may be using
older computers at home, you need to design for the broadest possible
audience on the Internet. Although web browsers are generally free and
relatively easy to install, some people are afraid to download any soft-
ware over the Internet, and many don’t appreciate the benefits of using a
newer browser.

The movement toward more standardized web development is growing, but
getting your pages to look exactly the same on every computer on the planet
is still difficult if not impossible. As a result, most designers strive to create
pages that look as good as possible on as many browsers as they consider
important, even if the same pages don’t look exactly the same on all browsers.
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Although Dreamweaver’s Design and Live views display web pages much like
old and new web browsers, not all interactive features work in Dreamweaver.
To test links, for example, you have to preview your work in a web browser.

You can test your pages using any web browser on your computer, but [ rec-
ommend that you set up at least two (and preferably, all four) of the latest
versions of the most popular browsers: Internet Explorer, Firefox, Chrome,
and Safari. (You find instructions for adding browsers to Dreamweaver in the
next section.)

The simplest way to preview your work is to save the page you're working
on and then click the Preview/Debug in Browser icon (it looks like a small
globe), which is located at the top of the workspace, as shown in Figure 4-3.
You can also choose File>Preview in Browser.

= &M Title: | Antonio Gaudi Architact

Preview in Firefox
Preview in Google Chrome F12
Preview in Internet Explorer

Preview in Safari

Edit Browser List

Figure 4-3: The Preview/Debug in Browser icon opens
any Dreamweaver page in the selected web browser.

Adding web browsers to the preview feature

To help you test your pages, Dreamweaver makes it possible to add multiple
browsers to the preview. The first step is to download and install a variety of
browsers on your hard drive (see the sidebar “Downloading new browsers™).

After you've installed one or more new browsers on your computer, follow
these steps to add them to Dreamweaver’s browser preview list:

1. Choose Filez>Preview in Browser and then choose Edit Browser List
from the fly-out menu.

The Preferences dialog box opens with the Preview in Browser settings
displayed. Note: You must have a page open in Dreamweaver for these
menu options to be available.

2. Click the plus sign (+) at the top of the Preferences dialog box.
The Add Browser dialog box opens.
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3. Enter a name for the browser.

To help make sure you're using the latest browsers, include the version
number as well as the name, as [ have in Figure 4-4, where I'm adding the
latest version of Firefox.

4. Click the Browse button.

The Add Browser dialog box opens.

5. Navigate your hard drive until you find the browser you want to add.

Look for the browser’s executable or application file (indicated with an
. exe extension under Windows and stored in the Applications folder on
a Mac). Don’t use a shortcut to the actual program file.

You can add a browser to Dreamweaver only if the browser is on your
hard drive. (See the nearby sidebar, “Downloading new browsers,” for
more about finding and downloading new browsers for testing.)

6. Double-click the name of the program file to select it and add the

browser to the Application field in the Add Browser dialog box.

=
Category Preview in Browser
Gereral
Accessibiity Browsers: [+] (=] Ecit..
Code Coloring
Code Format:
Code Hints Google Chrome  F12
Code Rewrtting Internet Explorer
Copy Paste Safar
S5 Styles
Fie Compare
Fle Types / Editors
Forts
Highlighting _
Invisble Elements Edit Browser =
New Cocument
Site Application: | Ci1Program Fies (86)iMoaila Firefox | Bromss... |
Syne Settings
vjac Valid: atgor OIS s [ Primary browser
indow Sizes iy b e ?1:“: zgﬂg
ewing XSLT,
Help. Ok Cancel

Figure 4-4: Add web browsers to the Preview in Browser list.
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Downloading new browsers

So how do you put new browsers on your hard .~ Microsoft Internet Explorer: www.micro
drive so that you can use them to preview your soft.com/ie

pages? The simplest way is to visit the websites
of the companies that create the most popular
browsers. You can download the latest version .~ Apple Safari: www.apple.com/safari
for free from each of these sites, and all four
browsers are available for Mac and Windows
computers:

v Mozilla Firefox: www . firefox.com

»* Google Chrome: www.google.com/
chrome

7. Click OK to add the browser to the Browsers list in the Preferences
dialog box and close the Add Browser dialog box.

8. If you want this browser to be the first browser listed in the Browser
drop-down list, select the Primary Browser check box. Otherwise,
select the Secondary Browser check box.

You can also launch the designated primary browser by pressing the
F12 key. To launch the secondary browser, press Ctrl+F12 in Windows
or #$+F12 on a Mac.

9. Repeat Steps 2-8 to add more browsers to the list.

10. After you add all the browsers you want, click OK to close the
Preferences dialog box.

Previewing pages in many web browsers

When you’re designing web pages for the broadest audience on the web, it’s
best to test your site by previewing the pages in a variety of web browsers.
The following steps walk you through the process of previewing the same
web page in multiple browsers:

1. Open a web page that you want to preview in Dreamweaver.

2. Choose Filew>Preview in Browser, and select a web browser from the
list of browser options.

You find out how to add more browsers to the Preview in Browser list in
the preceding section, “Adding web browsers to the preview feature.”
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3. Study and test the page.

Carefully test all links, rollovers, and other special effects to make sure
that the page appears the way you want it to in this browser.

4. Close the browser window and return to Dreamweaver to make any
necessary changes to the page.

Often, you can make the page look better with minor changes, such as
swapping the position of an image with a block of text, or adding a para-
graph return using a <p> tag after a video.

5. Preview the same page again in the same browser to make sure the
changes you made had the desired effect.

Return to Dreamweaver to make further changes as necessary.

6. Follow Steps 2-5 to preview the same page in another web browser.

Testing sites with online browser services

Unless you own a dozen computers with different operating systems and a
vast collection of web browsers, you can’t fully test your website — at least
not on your own. Fortunately, a growing number of online services are avail-
able to help you preview your pages on many different operating systems
and browsers — without your having to manage multiple computers and
browsers yourself.

Like many professional web designers, | have three computers on my desk
(Macs and Windows), and many different browsers installed on each. I also
have an Apple iPad, a Samsung Galaxy tablet, and an iPhone because I like
having several options handy to test my pages while I'm developing a design.

After a page design looks good in all the browsers and systems [ have on my
desk, I upload the site to a server and do a final test in even more browsers
using these online services.

Following are some of the best places to test your website online:

1 Browser Sandbox (spoon.net/browsers/): With Browser Sandbox,
you can test a website using any of the eight most popular browsers,
but you do have to go through a time-consuming installation process to
use them. After you’ve set up each browser, you can launch it and surf
the web as if the browser were installed on your computer. That means
you can test interactive features, such as those that require JavaScript,
AJAX, forms, and other advanced programming.
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1~ Cross Browser Testing (crossbrowsertesting.com): The Cross
Browser Testing site takes website testing to another level. Instead of
simply providing screenshots of a web page in different browsers, or let-
ting you launch a few browsers in which to test pages, this site lets you
take over other computers connected to the Internet so that you can do
sophisticated testing of interactive features using a variety of browsers
and operating systems. For example, suppose you use a computer that
runs Windows 7 and want to see what your site will look like on a Mac.
Simply choose to use a computer with the Mac OS and then view your
site on that computer in any of a dozen browsers. This high-end service
requires that you purchase a monthly subscription but also offers a free
30-day trial period at the time of this writing.

1 Browsershots (www.browsershots. org): Browsershots is a popu-
lar online testing tool. You simply enter a page’s URL and choose the
options you want to use for testing. Browsershots then tests the page
you submitted on each computer system selected with the specified
browser and takes a screenshot. Although you can’t test interactive fea-
tures with this service, it’s one of the easiest options and provides the
largest collection of browsers to choose from. The basic service is free,
but testing can take from a few minutes to a few hours. If you don’t like
waiting, you can upgrade to their priority processing for a fee.

Testing your designs with mobile,
tablet, and desktop previews

Dreamweaver CC includes preview features that make it possible to view the
same web page in three screen sizes. This capability is useful when you use
the latest in CSS options to design HTML pages that use more than one style
sheet, each designed for a different screen size.

To switch among the three view sizes, open any page in Dreamweaver, and
then click the three small icons at the bottom right of the workspace in turn,
as shown in Figure 4-5.

In Chapters 5-8, you find instructions on how to use Dreamweaver’s CSS fea-
tures, including how to use the CSS media query options and the fluid grid
layout features to design pages that adapt to different screen sizes. Using
media queries is an advanced topic, even for those familiar with the basics
of CSS, but if you're interested in designing websites that work on mobile
phones, as well as large monitors, it’s worth the extra effort to learn how to
use these features.
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Figure 4-5 shows a web page when viewed on a tablet-sized screen, and
Figure 4-6 shows the same screen on a small mobile device. In Chapter 8, you
find instructions for using Dreamweaver’s fluid grid layouts to design mul-
tiple sets of styles for one page to achieve the kind of variation in page design
you see in these two figures.
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Figure 4-6: A web page as it appears mobile screen size.

Testing Your Work with the
Site Reporting Feature

Before you put your site online for the world to see, check your work using
the Dreamweaver site reporting feature. You can create a variety of reports
to identify problems with external links, redundant and empty tags, untitled
documents, and missing alternate text — important errors that are easily
missed. Before Dreamweaver added this great feature, finding these kinds of
mistakes was a tedious, time-consuming task.
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Designing a simple page for mobile devices

You can follow several approaches when
designing for different screen sizes. If you have
the time, budget, or skills, | recommend that you
redesign your site using one of the two most
popular approaches to designing for multiple
screen sizes: responsive or adaptive, covered
in Chapter 8. If you just want to make sure that
the most important information on your site is
accessible to mobile phone users, | recommend
thatyou create a second very simplified version
of your website designed to best serve the lim-
ited display options of mobhile devices and then
link your main website to the alternate mobile
design. If you have experience writing server
scripts (or can hire someone to do it for you),
create an autodetect script that can determine
whether visitors to your site are using a mobile
device or a computer and then direct them to
the best version of your site. (You can learn
more about autodetect scripts and mobile web
design on my site atwww.DigitalFamily.
com/mobile.)

Consider the following important tips when
designing a version of your website for mobile
devices:

1 The screen size on a mobile device is
extremely limited.

+* Use a minimum of images because down-
load times are much slower on cell phones.

» Avoid outdated HTML styling and layout
options, such as frames and iframes,
which may not be displayed at all on mobile
devices.

1~ Adjust your design to require as little scroll-
ing and user movement as possible and
make your links big and separated so they
can be activated by a fat fingertip. Mobile
phone users point not with a mouse but with
up and down arrows and at best a touch-
screen.

v+~ Always validate your web page code
(numerous validation services are available
for free online, such as the popular one at
validator.w3.org). Mobile browsers
are even less forgiving than traditional web-
site browsers about errors in your code.

v~ Avoid using Flash and Flash video because
many mobile devices don't support them.
Use multimedia sparingly and consider
using video-hosting services such as
YouTube or Vimeo (covered in Chapter 13).
Services such as Vimeo offer sophisticated
video servers and optimize video for differ-
ent devices for you.

To read more about designing for mobile
devices, check out my books iPhone & iPad
Web Design For Dummies and Mobile Web
Design For Dummies (Wiley).

Follow these steps to produce a site report of your entire website:

1. In the drop-down list at the top of the Files panel, select the site you

want to work on.

If you already have the site you want to test open in Dreamweaver, you
can skip this step. Note: Your site appears in the Files panel list only if
you’ve completed the site setup process covered in Chapter 2.

2. Make sure any documents you have open in Dreamweaver’s work-
space are saved by choosing File>Save All.
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3. Choose Site=>Reports.
The Reports dialog box appears, as shown in Figure 4-7.
4. In the Report On drop-down list, choose Entire Current Local Site.

[ regularly use this option to test an entire site just before publishing it
to the web, but you can choose to check only a single page by opening
the page in Dreamweaver and then choosing Current Document in the
Report On drop-down list. You can also run a report on selected files or
on a particular folder. If you choose Selected Files in Site, you must first
select the pages you want to check in the Files panel.

5. In the Select Reports section, click the check boxes to select the
reports you want.

Table 4-1 describes the kind of report you get with each option. You can
select as many reports as you want.

6. Click the Run button to create the report(s).

If you haven’t already done so, you may be prompted to save your file,
set up your site, or select a folder.

The Site Results panel appears, displaying a list of problems found on the
site. To sort the list by category (filename, line number, or description),
click the corresponding column heading.

7. Double-click any item in the Site Results panel to open the corre-
sponding file in the Document window.

The file opens, and the error is highlighted in the workspace.

You can also right-click (Windows) or Control+click (Mac) any line of the
report and choose More Info to find additional details about the specific
error or condition.

8. Use the Property inspector or another Dreamweaver feature to correct
the identified problem, and then save the file.

Reports
Reporton: | Curtent Cocument. A Run
Current Document
o \— Cancel
Selected Fles in Site
Select Teport e er
B Wormow
[ Checked OutBy
¥ Design Notes
™ PRecently Modified
B HTMLRepots
W Combinable Nested Font Tags
@ Missing Alt Text
I Redundant Nested Tags
[ Femovable Empty Tags
~[¢  Untiled Documents
Report Setfings. Hep

Figure 4-7: Run reports on a single page or the entire site.
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Table 4-1
Report Name

Site Report Options
What It Does

Checked Out By

Lists files checked out of the site and identifies the person
who checked them out. This feature is necessary only if
you're working with other web designers on the same site
and there's a risk of overwriting each other’s work.

Design Notes

Lists Design Notes used in the site.

Recently
Modified

Lists files that have been edited within a specified time
period. You can set the time period for the report by selecting
the Recently Modified check box and then clicking the Report
Settings button at the bottom of the dialog box.

Combinable
Nested Font
Tags

Lists all instances where you can combine nested tags.

For example, <font color="#000000"><font
size="2">Great Websites You Should
Visit</font></font> islisted because you can sim-
plify the code by combining the two font tags into <font
color="#000000" size="2">Great Websites
You Should Visit</font>.

Missing Alt
Text

Lists all the image tags that do not include Alt text. Alt text

is a text description for an image tag included in the HTML
code as an alternative if the image is not displayed. Alt text is
important to anyone who uses a special browser that reads
web pages.

Redundant
Nested Tags

Lists all places where you have redundant nested tags. For
example, <hl1>Good headlines <hl>are harder
to write</hl> than you might think</hl>

is listed because you can simplify the code by removing the
second <h1> tag to make the code look like this: <h1>Good
headlines are harder to write than you
might think</hl>.

Removable
Empty Tags

Lists the empty tags on your site. Empty tags can occur when
you delete an image, a text section, or another element with-
out deleting all the tags applied to the element.

Untitled
Documents

Lists filenames that don't have a title. The <title> tag

is easy to forget because it does not appear in the body of
the page. Instead, the <t it 1le> tag specifies the text that
appears at the very top of the browser window and the text
that appears in the Favorites list when someone bookmarks a
page. You can enter a title for any page by entering text in the
Title field just above the work area or in the Title field in the
Page Properties dialog box.
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Finding and Fixing Broken Links
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If you're trying to rein in a chaotic website or you just want to check a site for
broken links, you’ll be pleased to discover Link Checker. You can use this fea-
ture to verify the links in a single file or an entire website. Link Checker can
also automatically fix all the referring links at once if a link is broken. (You
find instructions for creating links in Chapter 2.)

Here’s an example of what Link Checker can do. Assume that someone on
your team (because you would never do such a thing yourself) changed the
name of a file from new.htm to o1d.htm without using the Files panel or
any of Dreamweaver’s automatic link update features. Maybe this person
changed the name using another program or simply renamed it in Explorer
(Windows) or Finder (Mac) the way you would change the name of most
other files on your computer. Changing the filename was easy, but what this
person may not have realized is that the links are now broken if he or she
didn’t change the links to the file when the file was renamed.

If only one page links to the file that your clueless teammate changed, fixing
the broken link isn’t such a big deal. As long as you remember which file the
page links from, you can simply open that page and use the Property inspec-
tor to reset the link the same way you created the link in the first place.

But many times, a single page in a website is linked to many other pages.
When that’s the case, fixing all the link references can be time-consuming and
forgetting some is all too easy, which is why Link Checker is so helpful.

Link Checker may not work properly if you're working on a dynamic website
that uses a database or a content management system such as WordPress,
Joomla!, or Drupal. The Checker works best for sites with static HTML pages
and sites created using .dwt Dreamweaver templates.

Checking for broken links

To check a site for broken links, follow these steps:
1. In the drop-down list at the top of the Files panel, select the site you
want to work on.
If you already have the site open in Dreamweaver, you can skip this step.

You must have the entire site on your hard drive and you must have
completed the site setup process (covered in Chapter 2) for Link
Checker to work properly.
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. Choose Siter>Check Links Sitewide.

The Link Checker tab, shown in Figure 4-8, opens in the Results panel

at the bottom of the page, just under the Property inspector. The tab
displays a list of internal and external links. The tab also lists any pages,
images, or other items not linked from any other page and identifies
them as unused files. Large unused files, such as images and videos, can
waste space on your server, so this list is handy if you want to clean up
old files you no longer use on your site.

Remember, just because you delete a file from your hard drive doesn’t
mean the file is deleted from the server where you host your website.
Make sure you remove files from both the Remote Site window in the
Files panel as well as the Local Site panel. (For more on using FTP and
synchronization to update or delete files automatically on your server,

see the section “Publishing Your Website,” later in this chapter.)
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indexhtmis x| ]
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i i .E Tnsert
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: || sl Files

B Assets

Antonio Gaudi
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Figure 4-8: The Link Checker report displays broken links, external links, and unused files.
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Fixing broken links

Broken links are one of the worst problems you can have on a website.
Nothing turns off visitors faster than clicking a link and getting a File Not
Found error page. After you identify a broken link in a site, fix it as soon as
possible. Fortunately, Dreamweaver makes fixing broken links simple by pro-
viding quick access to files with broken links and automating the process of
fixing multiple links to the same file.

After using the Link Checker tab described in the preceding section to iden-
tify broken links, follow these steps to fix them by using the Results panel:

1. With the Results panel open at the bottom of the page, double-click a
filename that Dreamweaver identifies as a broken link.

The page and its corresponding Property inspector open. The Results
panel remains visible.

2. Select the broken link or image on the open page.

For example, you can fix a broken image by selecting the Broken Image
icon on the page and then reinserting the image using the Property
inspector to find the correct image file.

3. In the Property inspector, click the Browse icon (which looks like a
folder) to the right of the Link text box.

(Instead of using the Browse button to find the correct image, you can
type the correct filename and path in the text box.) The Select Image
Source dialog box appears.

4. Select the filename of the correct image and then click OK.

The link automatically changes to reflect the new filename and location.
If you replace an image, the image file reappears on the page.

If the link that you correct appears in multiple pages and you fix the link
using the broken link’s Results panel, Dreamweaver prompts you with
a dialog box asking whether you want to fix the remaining broken link
references to the file. Click the Yes button to automatically correct all
other references. Click the No button to leave the other files unchanged.
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Finding files by their addresses

If you're not sure where you saved a file or
what you called it, but you can get to it with
your browser, you can determine the filename
and location by looking at the URL in the brows-
er's address bar. Each folder in a website is
included in the address to a page within that
folder. Folder names are separated by the for-
ward slash, /, and each filename can be distin-
guished because it includes an extension. For
example, the URL in the browser's address bar
of the Speeches page on my site tells me that
the file is named speeches . html. (See the
URL in the top of the figure in this sidebar.)

Similarly, you can identify the name and loca-
tion of any image you're viewing on a web

C' [ jewarner.com/speecheshtml

The Art of Mobile Design
Why the fastest growing part of the Internet is mobile
— and how Responsive Design can help you future-
proof your website

Inspect element

From tiny mobile screens to
giaht mehitors, forward-
thinking companies are

‘g [Eachihg out to custotners and
Save image as...

Copy image URL

Copy image

Open image in new tab

8| Evernote Web Clipper 3

page. If you're using Google Chrome or Firefox,
place your cursor over the image and right-click
(Windows) or Control+click (Mac) and then
choose Inspect Element. (In Internet Explorer,
choose Properties.) The Element Properties
dialog box includes the specific URL of the
image, which has the name and folder (path). If
you're using the Safari browser on a Mac, you
won't find this option, but you can Control+click
any image and choose Open Image in New
Window. Then, in the new window, look in the
URL field and you'll find the name and path for
the image.

to

ﬁ.\turrproofyour webaite by trategically creatitiy, protitizing,

and publishing your message so that it resonates with your
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Making Global Changes to Links

If you want to globally change a link to point at a new URL or to some other
page on your site, you can use the Change Link Sitewide option to enter the
new URL and change every reference automatically. You can use this option
to change any kind of link, including mailto, FTP, and script links. For exam-
ple, if an e-mail address that you use throughout your site changes, you can
use this feature to fix it automatically — a real timesaver. You can use this
feature also when you want a string of text to link to a different file. For exam-
ple, you can change every instance of the words Enter This Month’s Contest

to link to /contest/january.htminstead of /contest/december.htm
throughout your website.

To change a collection of links with the Change Link Sitewide feature, follow
these steps:

1. Make sure the site you want to work on is displayed in the Files panel.
See the preceding exercise for instructions on selecting a site.

2. Choose Siter>Change Link Sitewide.
The Change Link Sitewide dialog box appears.

3. Enter the old address and then enter the new address, or click the
Browse button to identify files where you want to change the links.

You can use this feature to change any link, including e-mail links, links
from one page to another within a site, or links to a different website.

4. Click OK.

Dreamweaver updates any documents that include the specified links.

QQ,N\BER Any changes you make to links using Dreamweaver’s automated link features
& occur only on the local version of your site on your hard drive. Make sure
you upload all affected files to your web server to ensure that all changes are
included on your published site. To automatically reconcile changes on your
local and remote sites, use Dreamweaver’s Synchronize Files feature, which I
describe later in this chapter.

Managing Files and Folders in Your Site

Dreamweaver includes a variety of tools that help you manage the files, fold-
ers, and subfolders within a site without breaking links or image references.
You can use the Files panel to rename and rearrange files and folders, as well
as create new folders, all with drag-and-drop ease.



’ ’ 0 Part I: Getting Started with Dreamweaver CC

<P You need to complete the simple site setup process for Dreamweaver’s Files
panel features to work. If you haven’t already set up your site, turn to the
instructions at the beginning of Chapter 2. (If you're getting tired of my
reminding you of this point throughout this book, realize that you’d probably
be even more annoyed if you didn’t know the site setup process was neces-
sary and couldn’t get these features to work.)

Moving and renaming files and folders

To move or rename files and folders in a website, follow these steps:

1. Open the site you want to work on (if it’s not already open in
Dreamweaver) by selecting the site name from the drop-down list at
the top of the Files panel.

When you select a site by clicking the site name, the folders and files in
that site appear in the Files panel.

2. Click the plus sign (Windows) or the small arrow (Mac) to open the
local site folder or any subfolder to display the files within the folder.

Click the minus sign to close a folder or subfolder.
3. To move a file or folder:
a. In the Files panel, select the file or folder you want to move.
b. Drag the selected file, group of files, or folder onto a folder.

Dreamweaver automatically moves the files into the folder and
changes all the related links. The Files panel works much like the
Explorer window on a PC or Finder on a Mac, except Dreamweaver

tracks and fixes links when you move files through the Files panel.

WING/
& If you move or rename files or folders in Finder or Explorer instead

of in the Files panel, you will break any links set to or from those
files and any image references within them.

When you move a linked file into a new folder in Dreamweaver, the
Update Files dialog box appears, listing any linked pages that need
to be updated, as shown in Figure 4-9.

c. To adjust the links so they don’t break, choose Update.

If you choose Don’t Update, any links to or from that file are left
unchanged. Of course, you can always move the file back to its
original location to restore the links.
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Update Files

Update links in the following files? | Update[
foompleted-design/indes.htmil Don't Update

Help

Figure 4-9: You see all files that will be
changed during the update process.

4. To rename a file or folder:
a. In the Files panel, select the file or folder you want to rename.
b. Click twice on any filename or folder name.

Much like Finder or Explorer on your computer, you need to
click twice with a slight pause between clicks to select the name
(instead of double-clicking, which opens the file).

c. Choose Update to adjust the links.

Creating files and creating and deleting folders

In this section, you find out how to create a folder as well as how to delete
folders and files:

1. Open the site you want to work on (if it’s not already open in
Dreamweaver) by selecting the site name from the drop-down list at
the top of the Files panel.

When you select a site by clicking the site name, the folders and files in
that site appear in the Files panel.

2. Click the plus sign (Windows) or the small arrow (Mac) to open the
local site folder or any subfolder to display the files within the folder.

Click the minus sign to close a folder or subfolder.
3. To create a new folder in the Files panel:

a. Right-click (Option-click on a Mac) the main site folder or any
subfolder where you want to create a new folder.

A list of options appears.
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b. Choose New Folder from the list.

A new, untitled folder appears inside the folder just selected in the
preceding step.

c. Name the new folder by typing new text to replace the word
Untitled.

After you've created a new folder, you can drag files or other fold-
ers in the Files panel into the new folder.

4. To delete a folder or file from the Files panel, select the file or folder
and then press the Delete or Backspace key.

This action will permanently delete the folder or file from your hard
drive.

Publishing Your Website

If you're looking for the section where you find out how to upload your site
(or any or all pages in your site) to your web server, you've found it.

After you create and test your website so that it’s ready to publish on the
web, you can put Dreamweaver’s publishing tools to work. Which features
you use depend on the kind of web server you use. If you're using a commer-
cial service provider, you’ll most likely need Dreamweaver’s FTP features,
which [ cover in detail in the following section.

Note that you need the following information from your web-hosting service
before you can configure Dreamweaver’s FTP features. Most service provid-
ers send this information in an e-mail message when you first sign up for an
account. If you don’t have this information, you will need to contact your ser-
vice provider for it, because it’s unique to your account on your web-hosting
service. Here’s what you need:

1 The FTP host name.

1~ The path to the web directory (optional but highly recommended), such
as /web/htdocs/jcwarner.

 Your FTP login or user name.
»* Your FTP password.



Chapter 4: Managing, Testing, and Publishing a Website

1 Any special instructions from your server, such as if you need to use
passive FTP or any of the other advanced settings covered in Step 11 in
the exercise that follows. These settings vary from server to server, so
you need to ask your web-hosting service. (If you're having trouble con-
necting and you’re not sure about these options, you can always experi-
ment by selecting and deselecting these options to see whether a setting
enables you to connect.)

Setting up Dreamweaver’s FTP features

After you gather all your FTP information, you're ready to set up
Dreamweaver’s FTP publishing features. This process can seem daunting and
often takes a few tries to get right, but the good news is that you have to do
it only once. (Dreamweaver saves these settings for you so you don’t have to
set them up every time you want to upload new pages to your site.)

Follow these steps to set up Dreamweaver’s FTP features and publish files to
a web server:

1. Choose Sitec>Manage Sites.
The Manage Sites dialog box opens.

2. In the list of defined sites, double-click the name of the site you want
to publish.

If your site is not listed in this dialog box, you haven’t set up your site.
Refer to the instructions for site setup in Chapter 2 and then return to
complete these steps.

3. Select Servers from the categories listed in the left panel of the Site
Setup dialog box.

The server list appears. If you haven’t yet set up any web servers in
Dreamweaver, this list is blank

4. Click the small plus sign at the bottom left of the server list area, as
shown in Figure 4-10.

The Basic category opens in the servers dialog box and FTP is automati-
cally selected. (If you need to use an option other than FTP, see the list
explaining all the Dreamweaver options by the Technical Stuff icon at
the end of these steps.)
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Site Setup for Gaudi =
Site:
= Here youlll select the server that will host your pages on the web, The settings
for this dialog box come from your Internet Service Provider (ISP) or your web
Version Corrol administrator.
»  Advanced Settings
Note. You db not need to conplete thi step to bean working on your Dreamsveaver site, You
anly need to define & remote server nifien you want to connect to the web and past your
pages.
Hame Address Connection | Remate | Testing
Add new Server

Figure 4-10: Click the small plus sign to open the Basic
server configuration dialog box.

5. Enter a name in the Server Name field.

You can name your server anything you like. Choose a name that will
enable you to easily choose among the servers you've set up. (If you
use only one web server to host your site, the choice doesn’t matter as
much as it does if you host your site on multiple servers — something
generally done only by very large or international sites.)

6. Enter the FTP address for your web server account.

Again this information depends on how your web server is set up, but
most use one of the following: ftp.servername.com, ftp.your
domainname. com, or simply yourdomain.com without anything at the
beginning of the domain.

7. In the Username and Password fields, type your username (sometimes
called a login name) and password.

Again, this information is unique to your account on your web server.

8. Select the Save box to the right of the Password field if you want
Dreamweaver to store your access information.

This step is handy because you can then automatically connect to the
server anytime you want to upload or download pages. However, select-
ing Save could enable anyone with access to your computer to gain
access to your web server.

9. Click the Test button to make sure you’ve entered everything
correctly.

Making a mistake is easy, so the capability to test the connection
and make any needed adjustments before you close this dialog box is
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10.

11.

12.

helpful. If you connect with no problems, you see a message stating that
Dreamweaver connected to your web server successfully. (Note: You
must save the password to use the test feature, but you can deselect the
Save Password box after you test if you prefer not to save the password
in the program.)

If you do have trouble connecting to your site, skip ahead to Step 11 for
a few advanced options that may help.

In the Root Directory field, type the directory on the remote site in
which documents visible to the public are stored (also known as the
local site folder).

The root directory usually looks something like this: public_html/
or www/htdocs/. Again, how your server directory is set up may vary
depending on your service provider.

If you upload your files to the wrong directory on your server, they
won’t be visible when you view your site through a browser. The nearby
sidebar, “Why can’t [ see the files on my server?” helps you work around
this potentially frustrating problem with tips on identifying where to
upload your website after you log into your server and finding the root
directory to enter in this field if you can’t find it in the information you
get from your web-hosting company.

Click the small arrow to the left of More Options, as shown in
Figure 4-11.

You may not need to change any of these settings, but if you're having
trouble connecting to your server, and you're sure you’'ve entered your
user name, password, and FTP address correctly, adjusting these set-
tings may enable you to connect.

[ recommend selecting and deselecting each option in this area in turn,
and then clicking the Test button after each change, to see if any of
these adjustments makes the difference and enables you to connect to
your server.

A little experimentation with settings before waiting on hold with tech
support is usually worth the effort. But if you're really having trouble
establishing a connection with your server, call or e-mail the tech sup-
port staff at your web server. The only people who can help you are
those who run your web server, because the settings are specific to your
service provider and can vary dramatically from one hosting company
to another.

After clicking Test successfully connects to your server, click Save to
save your settings.
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Server Name: | Gaudi Server |
Cannect using: | FTP |
FTP Address: [ftp.artoinogaudi.com | Port:
Username: [anarymos ]
Password: [eeeveses | 4 5ave
Root Directory: | ]
Web URL: [http:jftp.antoinogaudi.com/ |
, Mors Options
[ Use Passive FTP
[] Use IP¥6 Transfer Mode
[ Use Procy, as defined in Preferences
[ Use FTF performance optimization
[] Use alternative FTP move method
e [ o |

Figure 4-11: Enter all the information from
your web-hosting company

Dreamweaver saves all your FTP settings (assuming you opted to save the
password). After you enter these settings properly and know that the con-
nection works, you never have to enter them again. You can then access your
web server from the Files panel in Dreamweaver, as you discover in the exer-
cise that follows.

Dreamweaver provides seven Access options. If you work at a large company
or university, you are likely to use one of these options rather than FTP. The
options available from the Connect Using drop-down list in the Server Setup
dialog box are as follows:

v~ FTP (File Transfer Protocol): Select this option to use Dreamweaver’s
built-in File Transfer Protocol features, which I cover in detail in the fol-
lowing section. You’re most likely to need these settings if you're using a
commercial web-hosting service.

1~ SFTP (Secure File Transfer Protocol): Select this option if your web
server requires a more secure connection.

v FTP over SSL/TLS (implicit encryption): This option provides a more
secure FTP connection, but the server can allow the client to work in an
unsecure mode.

1~ FTP over SSL/TLS (explicit encryption): This option provides a more
secure FTP connection and the server drops the connection if it is not
deemed secure.
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1~ Local/Network: Select this option if you're using a web server on a local

network, such as your company or university server. For specific set-
tings and requirements, check with your system administrator.

1 WebDAV (Web-based Distributed Authoring and Versioning): Select
this option if you’re using a server with the WebDAV protocol, such as

Microsoft IIS.

1~ RDS (Rapid Development Services): Select this option if you're using
ColdFusion on a remote server.

Why can’t | see my files on the server?

Including the root directory in Dreamweaver's
FTP settings is optional, but doing so makes
transferring files using Dreamweaver's Upload
and Download options easier. Thus, you reduce
your chances of uploading your files to the
wrong directory on your server, where they
won't be visible when you try to view your site
through a browser.

To find the root directory and the path to that
directory on your server, you may need to log
into your web server and do a little experi-
menting before you can figure out the path to
the root directory. To perform these tasks, you
need to complete the steps in the “Setting Up
Dreamweaver's FTP Features” and “Publishing
files to a web server with FTP” sections. Trust
me, the effort is worthwhile. Here's why.

When you log into most commercial web serv-
ers using the login information they provide you,
you access your main folder on their server.
This folder often includes several subfolders,
such as a folder that stores your e-mail on the
server, another folder that stores log reports of
traffic to your site, and possibly several others
for storing things such as CGl scripts. Among all
these subfolders, finding the one in which you

need to upload your pages can be tricky. The
subfolder you need is usually named something
like htdocs, web, or webfiles. You have
to upload your web pages to the right folder
so that your website becomes public on the
Internet and your pages are visible when you
open your domain name in a web browser.

If you're not sure which folder you should use,
try uploading just one file to any folder that looks
like a good candidate (using the instructions in
the “Publishing files to a web server with FTP”
section in this chapter). Then visit your domain
with a web browser to see if the page is visible.
(Each time you upload another page, remember
to click the Refresh button in your browser to
see any changes.) After you figure out which
folder corresponds to your domain name,
upload all the rest of your site to that same
subfolder, making sure that you mirror the local
site folder on your hard drive with the main root
folder on your server.

Also note that if you want to use Dreamweaver’s
synchronization features, also covered in this
chapter, you need to include the root directory
in the FTP folder.
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Publishing files to a web server with FTP

You can upload pages to your server and download pages from your server
using the built-in FTP capabilities of Dreamweaver.

To transfer files between your hard drive and a remote server (after you've
successfully set up the FTP features covered in the preceding section), follow
these steps:

1. Make sure the site you want to work on is selected in the Files panel.

2. In the top left of the Files panel, click the Connect to Remote Server

icon (labeled in Figure 4-12).

If you're not already connected to the Internet, the Connect to Remote
Server icon starts your Internet connection. If you have trouble connect-
ing this way, try establishing your Internet connection as you usually do
to check e-mail or surf the web, and then return to Dreamweaver and
click the Connect to Remote Server icon after you're connected to the
Internet. When your computer is online, Dreamweaver should have no
trouble automatically establishing an FTP connection with your host
server.

If you still have trouble establishing a connection to your web server,
refer to the preceding section, “Setting up Dreamweaver’s FTP features,”
and make sure that you specified the server information correctly.

Connect to Remote Server

Get Files PutFiles Expand/Collapse

A= I I

[El Gaudi | | | vl [Local et v]
B GO = [H]
Size| Type  |Modified

Local Files

ALk " 2.
completed-design Folder  3/7/20139:2..
images Folder  3/7/20139:2..
webforts Folder  3/7/20139:2..
incex: hkml 4KB Chrom... 10/30/2012 ...

< [ 111 +

(] Log

Figure 4-12: The row of icons across the top
control FTP functions.
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3. After you establish a connection between your computer and your

web server, click the Expand/Collapse icon (labeled in Figure 4-12).

When you click this icon, Dreamweaver displays both the local folder
with your site on your hard drive and the remote folder with the site

on your server. [ prefer the dual view, because seeing both side-by-side
makes moving files from one place to another easier. It also helps me
visualize the structure of the site on the server, but it does take up more
space on your computer screen.

You can also view your local site folder by choosing Local View from the
drop-down list at the top right (visible in Figure 4-12). Or choose Remote
View to see only the files on the server.

. To upload a file, select the file from the Local View panel and click the

Put Files icon (the up arrow) in the Files panel.
The Local View panel displays the files on your hard drive.

The files are copied automatically from your hard drive to your web
server when you transfer them. You can select multiple files or folders
to be transferred simultaneously.

After you upload files to your server, test your work by using a web
browser to view them online. Sometimes things that look and work fine
on your computer (such as links) won’t work on the server.

. To download files or folders, select the files or folders from the

Remote View panel and click the Get Files icon (the down arrow) in
the Files panel.

The Remote View panel displays the files on your server.

The files are copied automatically from your web server to your hard
drive when you transfer them.

Be aware that when you copy files to or from your server, the files
you're transferring overwrite the files already at the destination.
Dreamweaver notifies you about the overwriting if it notices you're
replacing a newer file with an older one, but it can’t always correctly
assess the proper time differences. Take note of these warnings, but
keep in mind that you can get warnings that aren’t always accurate when
they’re based on the age of a file, especially if you use more than one
computer to work on your website.

When the transfer is complete, you can open the files on your hard drive.

. To close this dual-panel dialog box and return to Dreamweaver’s main

workspace, simply click the Expand/Collapse icon again.
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Downloading an existing website

If you want to work on an existing website and
you don't already have a copy of it on your com-
puter’s hard drive, you can use Dreamweaver
to download any or all files in any website (that
you have the login information to access). Then
you can edit the existing pages, add new pages,
or use any of Dreamweaver's other features to
check links and manage the site’s further devel-
opment. The first step is to get a copy of the site
onto your computer by downloading it from the
server.

To download an existing website, follow these
steps:

1. Create a new folder on your computer to
store the existing site.

2. Use Dreamweaver's site setup features to
specify this folder as the local site folder.

Follow the instructions at the beginning of
Chapter 2 to set up a site, if you're not sure
how to do this yet.

3. Enter the FTP settings in the Basic server
dialog box (refer to Figure 4-11).

| explain how to do this in the “Setting up
Dreamweaver’s FTP features” section.

4. Connect to the remote site by clicking the
tiny Connect to Remote Server icon, which
looks like the ends of two cables, in the
Files panel.

b. Click the Get Files icon, which looks like a
down arrow, to download the entire site to
your local drive.

Sometimes your web host has files on
the remote server that you don't need to
download. If you want to download only
specific files or folders from the site, select
only those files or folders in the Remote
Site pane of the Files panel and click the
Get Files icon. (See the sidebar “Why
can't | see my files on the Server?” to find
the folder on your web server that corre-
sponds to the local site folder on your hard
drive.) Re-creating the folder structure on
your local computer is important because
Dreamweaver needs to know the relative
location of all the files in your site to set
links properly. The safest option is to down-
load the entire site; but if you're working
on a large web project, downloading part
of the structure will enable you to work on
a section of the site without downloading
it all.

If you're working on only one page or sec-
tion of a site, | recommend that you choose
to include dependent files, meaning any
files linked from those pages, as you down-
load them. Choosing this option ensures
that the links are set properly when you
make changes and that all related files are
downloaded to your hard drive.

. After you download the site or specific

files or folders, you can edit them as you
do any other file in Dreamweaver.
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Synchronizing local and remote sites

One of the most valuable features in Dreamweaver’s FTP options is the capa-
bility to automatically synchronize the files on your hard drive with the files
on your server. This cool feature helps you keep track of which pages you've
edited and ensures that they’ve been updated on the server. This capabil-

ity may not matter much to you the first time you upload your site, or if you
have only a few pages in your site. But if you have a large site and make fre-
quent updates, this feature is a wonderful way to make sure you upload all
the changes you make to your server. Dreamweaver also confirms which files
are updated after you complete the synchronization.

Follow these steps to synchronize your website:

1. Make sure the site you want to work on is selected and displayed in
the Files panel.

2. Click the Connect to Remote Server icon (labeled in Figure 4-12), in
the top left of the Files panel, to log on to your remote site.

3. Click the Expand/Collapse icon (labeled in Figure 4-12) to expand the
dialog box and view the remote and local sites simultaneously.

The Files panel displays both the remote and local views of the site. (To
collapse this dialog box, click the Expand/Collapse icon again.)

4. Choose Site>Synchronize.
The Synchronize Files dialog box appears.

5. In the Synchronize drop-down list, choose whether to synchronize the
Entire Site or Selected Files Only.

6. In the Direction drop-down list, choose which option you want to use
to copy the files:

e Put Newer Files to Remote: This option copies the most recently
modified files from your local site to the remote site. Select the
Delete Remote Files Not on Local Drive option only if you're sure
you want those files removed from your web server.

e Get Newer Files from Remote: This option copies the most
recently modified files from your remote site to the local site. If
you want to remove those files from your local copy, select the
Delete Local Files Not on Remote Server box.

* Get and Put Newer Files: This option updates both the local and
remote sites with the most recent versions of all the files.
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Be careful of the Delete Remote Files Not on Local Drive feature when
using Get or Put. As a general rule, | recommend that you leave this
option deselected because you may have folders and files on the server,
such as log files, that don’t exist on your hard drive, and you don’t want
to delete them inadvertently.

7. Click the Preview button.
The Site FTP dialog box displays the files that are about to be changed.

Now you have the option to verify the files you want to delete, put, and
get. If you don’t want Dreamweaver to alter a file, deselect it from the
Site FTP dialog box now or forever live with the consequences.

8. Click OK.

All approved changes are automatically made, and Dreamweaver
updates the Site FTP dialog box with the status.

9. When the synchronization finishes, you can choose to save or not save
the verification information to a local file.

I recommend that you save the verification information because it can
be handy if you want to review your changes after synchronization is
complete.

Setting cloaking options

The Dreamweaver Cloaking option enables you to exclude folders or files
from site-publishing features, meaning they won’t be uploaded to the live
site when you’re synchronizing or uploading a batch of files to the server.

If you're wondering why you might want to prevent files from uploading to
your web server, consider this: The Cloaking feature is a handy way to pre-
vent large graphics, such as Photoshop files, from being uploaded and taking
up room on your server, while still storing your high-resolution graphics in
your local site folder so you can easily keep track of them. This capability is
useful, for example, if you have a layered .psd or . tiff file that you want to
store near the optimized JPEG versions you use in your site. (You find infor-
mation about converting images into JPEG and other web-friendly formats in
Chapter 3.)

You can use the Cloaking feature to save any type of files in your local site
folder, with the assurance that no one can accidentally publish the files with
Dreamweaver until you uncloak them and publish them. This feature is best
used for large files you don’t want on your web server, such as .psd, .tiff,
.avi, and other high-resolution image or video formats.
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Using a dedicated FTP program

If you prefer to use a dedicated FTP program .~ WS_FTP (www . ipswitch.com): A popu-

instead of Dreamweaver’s built-in features, you lar FTP program for the PC, WS_FTP is such
can download the following FTP programs for a sophisticated FTP program that many
the Mac and PC: web designers are willing to pay the cost

of this program. A free trial version is also

1~ FireFTP (fireftp.mozdev.org/):
This nifty little FTP program is an add-on
to Firefox and a great alternative to »~ CuteFTP (www.cuteftp.com): Another
Dreamweaver's FTP features. ldeal for popular Windows FTP program.
fixing things when you’re on the road and
don’t have Dreamweaver handy or just
want to view the files on your server with-
out using Dreamweaver, this program can
be added to any version of Firefox (for free).  »~ Transmit (www.panic.com/

transmit): Transmit is another popular

FTP program for the Macintosh computer.

available.

v Fetch (www.fetchsoftworks.com):
This FTP program is a popular option for
those with a Macintosh computer.

v~ Filezilla (filezilla-project.org):
This popular open source option works on
computers running the Windows, Mac, and
Linux operating systems.

Using Design Notes to Keep in Touch

If you sometimes forget the details of your work or neglect to tell your col-
leagues about updates to pages in your website, the Dreamweaver Design
Notes feature may save you some grief. If you're the only person working on
a website, you probably don’t need the features described in this section
because they’re intended for use on sites developed by a team of people who
need to communicate with each other and make sure they don’t overwrite
each other’s work.

Design Notes are ideal if you want to hide sensitive information from visitors,
such as pricing structures or creative strategies, but make that information
available to members of your development team. Comments, instructions,
and other text saved as a Design Note in Dreamweaver can travel with any
HTML file or image, even if the file transfers from one website to another or
from Fireworks to Dreamweaver.

Essentially, Design Notes enable you to record information (such as a mes-
sage to another designer on your team) and associate it with a file or folder.
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Design Notes work a lot like the comment tag (HTML code that enables you
to embed in a page text that won’t appear in a browser) but with a bit more
privacy. Unlike the comment tag, which is embedded directly in the HTML
code of a page (and can be seen if someone views the source code behind a
page on the web), Design Notes are never visible to your visitors. The only
way for a visitor to view Design Notes is to deliberately type the path to your
notes subdirectory and view the notes files directly. You can even explicitly
block someone from accessing your files directly, but only if you have admin-
istrative access to your server. To be even more secure, you can keep the
notes on your hard drive and prevent them from ever being uploaded to your
server — though, of course, then your team members won’t see your witty
remarks.

To access the Design Notes page, choose Design Notes in the Category list
in the Site Setup dialog box. The settings on this page enable you to control
how Dreamweaver uses Design Notes:

1~ Maintain Design Notes: Select this option to ensure that the Design Note
remains attached to the file when you upload, copy, or move it.

~ Enable Upload Design Notes for Sharing: Choose this option to include
Design Notes when you send files to the server by using FTP.

1~ Clean Up Design Notes: Use the Clean Up Design Notes button to delete
Design Notes that are not associated with any files in the site.

When you create graphics in Adobe Fireworks, you can save a Design Note
for each image file that is also available in Dreamweaver. To use this inte-
grated feature, create a Design Note in Fireworks and associate it with the
image. Then when you save the Fireworks image to your local website folder,
the Design Note goes with it. When you open the file in Dreamweaver, the
Design Note appears when you right-click the image (Control+click on the
Mac). This feature is a great way for graphic designers to communicate with
other members of the web development team.
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In this part . . .

Discover the power and advantages of CSS.
Review all the great CSS features in Dreamweaver.

Create CSS layouts that work well across the most popular web
browsers.

Add drop shadows, gradients, and other advanced design
features.

Create web pages faster and easier and update multiple pages
at once by using Dreamweaver templates.

Create tables, split and merge cells, and use table
attributes.




Introducing Cascading
Style Sheets

In This Chapter
Introducing CSS
Comparing internal and external style sheets
Looking at CSS rule options
Working in the CSS Styles panel
Switching between CSS and HTML
Working with style sheets

Wmt to add a little style to your pages? Cascading Style
Sheets (CSS) offer the best way to create websites that
are accessible, flexible, and designed to work on a wide

range of screen sizes and devices. Today, CSS is the clear
choice when it comes to formatting web pages.

Unfortunately, most people find working with styles
far more complicated and confusing than previous
approaches to web design. In my experience, this
confusion fades after you learn the basics and start
working with styles, but brace yourself as you start
into these next few chapters. CSS is confusing to
everyone at first. Until you start to understand all
the basics, none of it makes much sense.

If you've used a previous version of Dreamweaver, you
should note that the CSS features were completely redone in
version CC. Many of the dialog boxes that were in previous ver-

sions have been removed, and all CSS panels have been revised. The good
news is that the new CSS Designer panel is a definite improvement, most
notably because all style tools are consolidated into one area of the program,
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which makes adding and editing styles more efficient. If you've used previous
versions of Dreamweaver, however, you may have to unlearn a few habits as

you work with the new features. Either way, CSS is a fundamental part of any

modern website.

This chapter explains how styles work, the different kinds of styles (and what
they’re best used for), and how to use the features in Dreamweaver to create
and edit styles. In Chapter 6, you apply these basic skills to creating CSS lay-
outs and complete page designs, and in Chapter 7, you discover how to add
the latest CSS3 features, including drop shadows and gradients.

Introducing Cascading Style Sheets

The concept of creating styles has been around long before the web. Desktop
publishing programs, such as Adobe InDesign, and even word processing pro-
grams, such as Microsoft Word, have long used styles to manage the format-
ting and editing of text on printed pages. In a word processor, you can create
and save styles for common features, such as headlines and captions. In print
design, styles are great timesavers because they enable you to combine a col-
lection of formatting options, such as Arial, bold, and italic, and then apply all
those options at once to any selected text in your document using a single style.
In addition, if you change a style, you can apply the change automatically — and
everywhere you've used that style in a document.

On the web, you can do all that and more with CSS because you can use style
sheets for more than just text formatting. For example, you can use CSS to
create styles that align images to the left or right side of a page, add margins
and padding space around text and images, and change background and

link colors. For all these reasons (and more), CSS is the preferred method of
designing web pages among professional web designers.

CSS is a powerful tool because you can use it to make global style changes
across an entire website. Suppose, for example, that you create a style for
your headlines by redefining the <h1> tag to create large, green, bold head-
lines. Then one fine day, you decide that all your headlines should be purple
instead of green. If you aren’t using CSS, changing all your headlines could
be a huge undertaking — a matter of opening every web page in your site

to make changes to the font tags around your headlines. But if you're using
CSS in an external style sheet, you can simply change the style that controls
the headline in the style sheet and — voila — your headlines all change from
green to purple automatically.

If you ever have to redesign your site (and believe me, every good site goes
through periodic redesigns), you can save hours or even days of work if
you've created your design with CSS.
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Understanding the basics of styles

Many people find CSS confusing at first because it’s such a different approach
to design than what they may be used to if they’ve worked in print. Following
are four of the more confusing aspects of CSS for beginners:

1 Getting used to thinking about the styles on your site separately from
your text, images, and other content: For example, you can type text
right into the design area in Dreamweaver, and you can format that text
with HTML tags, such as the heading 1 tag, which adds the <h1> tag to
the code next to the text. However, if you want to change the size or
color of your text beyond these basic HTML tags, you do that in a sepa-
rate area of the program (using the CSS panels covered in this chapter)
and that style information is not saved anywhere near the text that if for-
mats in the HTML code. In the early days of the web, we used HTML attri-
butes to format text in a page, but the latest versions of Dreamweaver
won’t even let you use HTML attributes anymore. If you want to change
things such as the size or color of text, you have to use CSS.

1 Understanding how you combine CSS and HTML to create web pages:
It’s easy to confuse HTML and CSS because they are used so closely
together, but they are very different animals and the better you appre-
ciate the difference, the more all of this makes sense. Think of HTML
as the building blocks that you use to create the structure of your web
page and to put basic space and just a little formatting around your text.
For example, when you format a headline with the <h1> tag, it changes
to 24 pt and bold because that basic formatting is included in the HTML
tag. Similarly, the <div> tag divides elements on a page. However, if you
want to change the spacing between the content in <div> tags, or add a
border around each box created by a <div> tag, you do that by defining
a style and applying it to the <div> tag.

~ Understanding all the different kinds of style selectors you can choose
from, such as class, ID, and tag selectors: No matter how you create
your styles, each style definition, or rule, contains a selector and a dec-
laration. The selector identifies the name and type of style, for example,
#container or .caption. (Multiple types of style selectors are
available so that you can create different kinds of styles depending on
what kind of formatting you want to do with the style.) The declaration
defines the style and describes its properties, such as bold, blue, or 300
pixels wide. If those terms don’t mean much to you yet, don’t worry —
Dreamweaver'’s four selector types are described later in the chapter in
the “Understanding style selectors” section. And as you discover how
styles work, new terms such as selectors and declarations begin to make
a lot more sense.
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 Understanding when it’s best to create external style sheets, internal
style sheets, or inline styles: Internal style sheets are saved in the HTML
file where the formatting is applied. External style sheets are saved as
separate files that can be attached to the pages in your website. External
style sheets offer the greatest advantages because they enable you to
use the same styles across any or all pages in a website. Sometimes,
however, internal style sheets are useful, such as when you want to
apply a style to only a single page. The section “Using internal versus
external style sheets” explains how best to use the different types of
style sheets.

If you're starting to feel baffled already, hang in there. I'm just giving you an
overview before I take you farther and farther down the rabbit hole. CSS is a
topic that’s hard to grasp until you learn a number of basic concepts. Even if
you're not quite sure you understand everything I've described, keep read-
ing. As you make your way through the three chapters on CSS, it should all
start making more and more sense.

Combining CSS and HTML

Essentially, web pages are created by combing HTML and CSS. You can also
add more advanced programming, such as PHP or JavaScript, but the basic
structure and formatting of just about every page on the web is created using
HTML and CSS. Here’s the simplified version of how the two work together:

1. Use HTML to create the structure of a page with tags, such as division
(<div>), heading (<hl>, <h2>, and so on), and paragraph (<p>).

2. Create styles in CSS that specify the size of these elements, where they
appear on a page, and a variety of other formatting options, such as the
color, size, and font face.

Similarly, you use HTML to insert images and create links, and then add
styles to change formatting options, such as adding more space around your
images or removing the underline from your links.

Understanding style selectors

When you create new styles, you first have to choose which selector to use
for which job. The selector corresponds to the kind of style you create. Each
selector option has its own naming conventions, restrictions, and uses. If
you’re completely new to working with styles, this may not make much sense
yet, but understanding the basics of selectors is a fundamental part of work-
ing with styles. I encourage you to read through all these descriptions of
selectors so you can appreciate your options before you move on.
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Don’t feel you have to memorize all this, however. Instead, consider folding
down the corner on this page so you can refer to this list of selectors as you
create and edit styles later. If you don’t have this book handy, you can refer to
this page [ created as a CSS selector reference on my website: www.digital
family.com/tutorials/css-selectors/.

The following sections offer descriptions of each of the four selection types
that you can use when you create styles.

Class selectors

The class selector is the most versatile selector option. Class styles can
format any element (from text to images to multimedia), and you can use
them as many times as you like on any page in a website.

Class style names always begin with a period (often called a “dot”). You

can create class styles with any name as long as you don’t use spaces or
special characters. (Hyphens and underscores are okay.) Thus, if you create
a style called caption for the text that appears under your pictures, it should
be written like this with the dot followed by the name:

.caption

When you create styles with the class selector, you must include a dot at the
beginning of the name, but don’t include any space between the dot and the
style name. In the style sheet, and in Dreamweaver’s CSS panels, class style
names appear with the dot in front of the name.

However, the dot appears only in your style sheet code. When you apply a
class style to a <div> tag, or to any other element in a web page, the dot
doesn’t appear with the name in your HTML code. If you think that’s incon-
sistent, you're not alone, but upon closer inspection of the HTML code, you
will notice that all class styles are indicated by the word class in HTML code.
Thus, if you applied the . caption style to a paragraph tag to format the text
under an image, the HTML code would look like this:

<p class="caption">Flooding is on the rise, even in places
that have never flooded before.</p>

é“(" Class styles must be applied to an element, such as the paragraph tag shown
in this example. Class tags can also be used in combination with other styles,
making it possible to apply more than one style to an element.

When you create a class style in Dreamweaver, the style is displayed in the
CSS Designer panel on the right side of the workspace, as shown in Figure 5-1.
You can apply class styles by using the CSS drop-down list in the Property
inspector at the bottom of the workspace, also shown in the figure.
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Figure 5-1: Styles created with class selectors are available from the CSS drop-down list in
the Property inspector.

For more details and step-by-step instructions for creating and applying
styles with class selectors, see Chapter 6.

1D selectors

Think of styles created with the ID selector as the building blocks of most

CSS page layouts. ID styles, unlike other styles, must be unique, so they can
be used only once per page. This characteristic makes them well suited to
formatting <div> tags and other block-level elements that are used to create
distinct sections, such the header or footer of a page, which will be used only
once. You can create as many ID styles as you want for each page, and you
can use them on as many pages as you like, but you can use each one only
once on each page.

Being unable to use ID styles more than once per page has some advantages,
especially when you are creating complex websites with many compound
styles, because this rule can help you avoid style conflicts. But this limitation
is also the reason why many designers use the ID selector sparingly, opting
instead to create most styles with the class selector, which can be used as
many times as you want on any page.
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ID styles must begin with a pound, or number, character (#). Similar to class
styles, you can name ID styles anything you like as long as you don’t use
spaces or special characters (again, hyphens and underscores are okay). An
ID style used to identify the bottom section of a page could look like this:

#footer

Similar to class styles, # isn’t used in the HTML code. When a style is applied
to an element, such as a <div> tag, the HTML code looks like this:

<div id="footer">Between these tags with the footer ID
style, you would include any information you want
at the bottom of the page, such as copyright
information.</div>

Although using ID styles is common practice in many websites, the prede-
signed CSS layouts included in Dreamweaver were created by combining a
series of <div> tags with class styles using names such as .container,
.header, and . footer to identify the main sections of the design. In
Figure 5-2, you can see how a collection of class, tag, and compound styles
are displayed in the CSS Designer panel.
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Figure 5-2: The CSS Designer panel displays all class, tag, ID, and compound styles available
on any open page.
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Tag selectors

The tag selector is used to redefine existing HTML tags. Use this option if you
want to change the appearance of an existing HTML tag, such as the <h1>
(heading 1) tag or the <ul> (unordered list) tag.

In many cases, redefining existing HTML tags with your desired formatting
using CSS has advantages over creating new styles with the class or ID selec-
tors. For example, content formatted with the heading 1 tag is presumed to
be the most important text on a page. For that reason, many search engines
give priority to text formatted with the <h1> tag. Similarly, the hierarchical
structure of the <h1>—<h6> tags helps ensure that, even if visitors to your
site change the text size in their web browser, text formatted with the head-
ing 1 tag is still larger relative to text formatted with a heading 2 tag, which is
larger than text formatted with the heading 3 tag, and so on.

When you use the tag selector, the style definition is applied automatically to
any text or other element that’s been formatted with the corresponding tag.
Thus, if you’ve formatted a heading with an <h1> tag and then create a new
<h1> style, the formatting you used to define the style will apply automati-
cally to the heading as soon as the style is created.

As you type the name of any HTML tag in the selector panel in Dreamweaver,
a drop-down list appears providing easy access to the HTML tags. This short-
cut can save on typing and help ensure that you enter the name correctly.
After the tag names appear, simply choose the tag you want to use, as shown
in Figure 5-3.

Creating compound styles

The compound selector can be used to combine two or more style rules to
create a style definition that is displayed only when one style is contained
within another. Compound styles are useful, for example, when you want to
use the heading 2 tag multiple times to format headlines in different ways on
the same web page. For example, you could create one style for headlines that
appear in the main story area of a page and another style for headlines that
appear in the sidebar on the page but use the heading 2 tag to format both.

Compound styles are created by combining ID, class, or tag styles. Following
is an example:

.sidebar h2
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Figure 5-3: Redefine the appearance of any HTML
tag by creating a style with a tag selector.

See Figure 5-4 for an example of how the list item tag, the <1i> tag, appears
when it is defined within a class style named .navbar. For a compound
style, you must

+ Include a space between each name or tag in a compound style

~ Not include the brackets around the tag in a style name
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Figure 5-4: Use the compound style selector to
combine styles to apply more specific formatting.

In this example, the style definition will apply only to <11i> tags that appear
within another element, such as a <div> tag with the .navbar class style.
Combining styles in this way enables you to use the same HTML tags with differ-
ent formatting in different parts of the same page. For example, you might define
one set of styles for text in an unordered list in your navigation bar, and another
set of styles for text in an unordered bulleted list set off in the main text.

If a compound style combines more than one tag, it’s written like this:
#sidebar hl a:1link

Again, you must include a space between each style name or tag. In this
example, you see a style that defines the appearance of the active link tag
only when the link is located inside an element formatted with the <h1> tag
that’s also inside an element formatted with an ID style named #sidebar.
A compound style like this enables you to create links in a sidebar headline
that look different than links in another part of the sidebar.
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Replacing ID and class styles with HTML5 tags

Dreamweaver CC includes two CSS layouts these and several other new tags standard.
designed with the new HTML5 tags. So many  Most of the new HTML5 tags are designed, in
people create class or ID styles with the names  part, to help make the formatting in web pages
headerand footerthat the W3C decided to make  more consistent.

After you figure out the differences among these style selector options and
when they’re best used, you're well on your way to mastering the art of creat-
ing and applying styles in Dreamweaver, which is covered in Chapter 6.

Using internal versus external style sheets

In CSS, you have the option of creating internal, external, or inline styles. You
can even use a combination of these options, or attach multiple external style
sheets to the same web page. Here’s an explanation of these options:

1~ Internal styles: If you create internal styles, the CSS code is stored in the
<head> area at the top of the HTML page, and you can apply the styles
on only that page. If you're just creating a one-page website or styles
used on only one page, an internal style sheet is fine, but for most sites,
external style sheets offer many advantages.

1~ External styles: If you save your styles in an external style sheet, they're
stored in a separate file with a . css extension. You can attach external
style sheets to any or all pages in a website in much the same way that you
can insert the same image into multiple pages. You can also attach mul-
tiple external style sheets to the same page. For example, you can create
one style sheet for styles that format text and another for layout styles.
You can also create external style sheets for different purposes, such as
one for print and one for screen display. For a web designer, external style
sheets offer two big advantages: They enable you to create new pages
faster and more easily and to update styles across many pages at once.

+~ Inline styles: Inline styles are created within a document at the place
that a style is used and apply only to the element to which they’re
attached in the document. Inline styles are generally considered the
least useful of the three style sheet options because to change the
defined style you must change the code that contains the element,
which means you lose the benefits of making global updates and creat-
ing clean, fast-loading code. For example, creating one style for all your
headlines and saving it in an external style sheet is more efficient than
applying the style formatting options to each headline separately.
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At the top of the CSS Designer panel, shown in Figure 5-5, you find the
Sources panel with a drop-down list that makes it easy to specify whether
you want to save each new style that you define in an internal or external
style sheet. The options are

1 Create a New CSS File: Launches the Create a New CSS File dialog box,
where you can enter a name, specify a few settings, and click OK to both
create and attach a new external style sheet.

1~ Attach Existing CSS File: Launches the Create a New CSS File dialog box,
making it easy to browse and select any .css file already on your com-
puter’s hard drive.

1~ Define in Page: Adds <style> tags to the top of the open HTML file,
where new styles can be saved in an internal style sheet.

55 Designer
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Figure 5-5: When you create new styles you
can choose to save them in internal or external
style sheets.

You can attach multiple external style sheets to the same HTML page and you
can use internal and external style sheets in the same document. When you
create new styles, it’s important that you select the name of the style sheet in
the Sources panel (refer to Figure 5-5) where you want each new style saved.
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<P If you're creating a style that you're likely to use on more than one page in
your site, saving the style to a new or an existing external style sheet is your
best choice. If you save a style in an internal style sheet and later want to add
it to an external style sheet, you can move the style by dragging the style
name in the Selector panel to the name of the style sheet list you want to
move it into in the Sources panel.

Looking at the code behind the scenes

Even if you prefer not to look at the code behind your web pages, it’s helpful
to have at least some familiarity with different kinds of tags, CSS, and other
code that Dreamweaver creates for you when you design web pages. For
example:

#container {
width: 780px;
margin-right: auto;
margin-left: auto;
}
.caption {
font-family: Verdana, Geneva, sans-serif;
font-size: .8em;
font-style: italic;
font-weight: bold;
}
hl {
font-family: Arial, Helvetica, sans-serif;
font-size: 1.3em;

}

These examples show what the CSS code in an internal or external style sheet
would look like in Dreamweaver for the following styles:

 An ID style created with the ID selector, named #container, and
defined as 780 pixels wide with the left and right margins set to auto
(a cool trick for centering a CSS design, covered in Chapter 6).

1~ A style created with a class selector, named . caption, and defined as
Verdana, Geneva, sans-serif, small, italic, and bold.

1~ A style created with a tag selector to redefine the HTML tag <h1> as
follows: Arial, Helvetica, sans-serif, large, and bold. (Note: Because
the heading tags already include bold formatting, it’s not necessary to
include bold in the style definition.)
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Introducing the CSS Designer Panel

The CSS Designer panel provides a great place to create, attach, view,
manage, organize, and edit CSS styles. To open the CSS Designer panel,
choose Window=>CSS Styles. If you've set your layout options to one of the
compact layouts or you’'ve diminished the size of the panels in the right side
of the workspace, you need to click the small double-arrow at the top of the
panel to expand and view the panel.

The CSS Designer panel, a new feature in version CC, combines all
Dreamweaver CSS tools in one collection of panels. In Figure 5-6, you see

the panels docked on the right side of the page and expanded to take up

two columns of space. Like other panels in Dreamweaver, the CSS Designer
panel can be adjusted in a number of ways by clicking and dragging the top,
bottom, or side of the entire panel set or any of the individual panels, such as
the Properties panel, shown in the far right in Figure 5-6.
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Figure 5-6: The CSS Designer panel, docked on the right side of the screen in the Designer
layout, provides easy access to all CSS features.
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Identifying and selecting styles

At the top of the CSS Designer panel, you can view all the style sheets cur-
rently applied to any open page in Dreamweaver. In Figure 5-6, an internal
style sheet (indicated by the <style> tag) is selected in the Sources panel.
For comparison, refer to Figure 5-5 to see an external style sheet, named
main.css, selected in the Sources panel.

When you select a style sheet name in the Sources panel, a list of all style
rules defined in that style sheet appears in the Selectors panel, just below the
Sources and Media panels.

If you don’t see any style rules listed in the Selectors panel, you probably
haven’t defined any styles in the selected style sheet. Also note that before
you can create a style, you must create or attach a style sheet in the Sources
panel. You find step-by-step instructions for creating a style sheet as you
create styles in Chapter 6.

Reviewing CSS Selector Options

\\3

After you determine what selector type is best for your style — and decide
whether you want to save it in an external or internal style sheet — you’re
ready to move on to the CSS rule options and define the color, size, and other
formatting options you want to include in your style. You find instructions for
creating style rules in Chapter 6. This section continues the overview to help
you better understand your choices before you start creating a style.

In previous versions of Dreamweaver, most features that are now included

in the CSS Property panel were located in a separate CSS Rule Definition
dialog box. Although the new CSS Property panel includes a few new visual
tools that can help you better understand how CSS properties work, all these
choices can seem a bit daunting at first. As you go through the following sec-
tions, keep in mind that my goal is to give you an overview of the options

in each category of the CSS Property panel so that you'll have a better
understanding as you go through the instructions for using these options in
Chapter 6. Again, don’t feel that you have to memorize the details of each fea-
ture; you can always refer to this section when you'’re creating styles.

Also remember that you don’t have to specify any of the settings in this
panel. When you leave an option blank, you let the default browser settings
(or other styles) already applied to the page take control. For example, if you
don’t specify a text color when you define a style, any text formatted with the
style remains black (the default color in most web browsers) unless another
style applied to the text contains formatting instructions for a different color.

141
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In most cases, you select only a few options from one or two categories in the
CSS Property panel for each new style you create. I've included the full list
here so you can appreciate all your choices.

Not all options in the CSS Property panel are supported by all the web brows-
ers in use today, so the way styles are displayed on a web page can vary
depending on the browser. Similarly, some CSS options aren’t included in
Dreamweaver because they’re not commonly supported. The following sec-
tions describe the options in each category offered in the CSS Property panel.
Remember, if you know how write a CSS rule, you can always edit the CSS
code in Dreamweaver’s Code view.

The Layout options

At the top of the CSS Designer Properties panel (see Figure 5-7) you find the
CSS properties commonly used to create page layouts. You use these options
to specify height, width, alignment, positioning, and spacing. As you can read
in Chapter 6, these settings are ideal for creating page layouts with class and
ID styles to do things such as align images and position <div> tags to create
multicolumn layouts.

You can use the Layout options in the CSS Property panel to set these values:

1~ Width: Specify a width for any element that can have its dimensions
specified, such as a <div> tag. Size options are pixel (px), point (pt),
pica (pc), percent (%), em, rem, ex, and ch. (See the “Comparing CSS
size options” sidebar, later in this chapter, for the basics of sizing with
ems, exs, and percentages on the web.)

1~ Height: Specify a height for any element that can have its dimensions
3 specified.

The Height field is often left empty to enable elements (such as <div>
tags) to expand to fit their contents.

»* Min and Max Width: Specify minimum and maximum widths for <div>
tags and other block elements. These options are useful when you
specify the width as a percentage of the browser window. For example,
you can set the width of your design to take up 80 percent of the browser
window, and then set a Max Width of 1000 px to prevent your layout from
getting stretched wider than 1000 pixels, even on a very large monitor.

»* Min and Max Height: Specify minimum and maximum heights for <div>
tags and other block elements.
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Figure 5-7: The top portion of the Layout
options in the CSS Property panel.

1 Margin: Set the amount of space around an element (refer to Figure 5-7).
Margins can be used to create space between the edge of an element
and other elements on the page, such as between an image and text or
between two <div> tags. You can set the margin separately for the top,
right, bottom, and left. Padding is measured in pixels, points, inches,
centimeters, millimeters, picas, ems, exs, and percentages.

1~ Padding: Sets the amount of space within the borders of an element
(refer to Figure 5-7). For example, you can use padding to create space
between the borders of a <div> tag and its contents. You can set pad-
ding separately for the top, right, bottom, and left. Padding is measured
in pixels, points, inches, centimeters, millimeters, picas, ems, exs, and
percentages.
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Setting padding and margin spacing can be tricky. When you add margin
and padding to an element, such as an image or <div> tag, you increase
the overall size of that element and the amount of space it requires in
the layout. For help on setting these options to best fit your designs, see
Chapter 6.

1~ Position: As shown in Figure 5-8, the Position option, available from the

lower part of the Layout section of the Properties panel, alters the way
elements are positioned on a page. As you can read in Chapter 6, posi-
tioning can dramatically change the way block-level elements (such as
table, list, header, paragraph, and <div> tags) appear in a browser.

Positioning is always determined relative to something else, such as
another element on the page or the browser window. How you set up
positioning depends on where your element is on the page — and on
whether the element is inside another element (such as the <h1> tag
inside the <div> tag). The Position drop-down menu includes

e Inherit: You do not need to specify this default option. Unless
another option is selected, each element inherits the positioning of
its parent element.

Static: Place the content at its location within the flow of the docu-
ment. By default, all HTML elements that can be positioned are
static.

Absolute: Use the top and left coordinates to control the posi-
tion of an element relative to the upper-left corner of the browser
window or the upper-left corner of an element that contains the
element. (For example, the positioning of an AP Div contained
within another AP Div is based on the position of the first AP Div.)

¢ Fixed: Position an element relative to the top-left corner of the
browser. The content of an element using fixed positioning
remains constant even if the user scrolls down or across the page.

Relative: Use a position relative to the point where you insert the
element into the page or relative to its container.

+~ Float: Align elements, such as images and <div> tags, to the left or right

of a page or other container causing text or other elements to wrap
around it. Click the icons in the Float field, as shown in Figure 5-8, to
specify the following four options: Inherit, Right, Left, or None.

1~ Clear: Prevent floating content from overlapping an area to the left or

right, or to both sides of an element. This option is useful when a floated
element, such as a <div> tag used to create a sidebar, overlaps another
block-level element, such as a <div> tag used to create the footer of a

page.
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Figure 5-8: The bottom portion
of the Layout options in the
CSS Property panel.

1 Overflow-x and -y: Tell the browser how to display the contents of an
element if the container, such as a <div> tag, can'’t fit the element’s
entire height or width. Overflow options are

e Visible: Keep content, such as an image or text, visible, even if it
expands beyond the defined height or width of a container.

e Hidden: Cut off the content if it exceeds the size of the container.
This option doesn’t provide scroll bars.

* Scroll: Add scroll bars to the container regardless of whether its
content exceeds the element’s size.

e Auto: Make scroll bars appear only when the content of a con-
tainer exceeds its boundaries.

+~ Display: Indicate if, or how, to render an element in a browser. For
example, you change the positioning of an unordered list from horizon-
tal to vertical by choosing Inline or hide an element, rendering it invis-
ible, by choosing None. You can use the Display option with a scripting
language (such as JavaScript) to change the display of elements dynami-
cally. For example, you can cause an element to appear on a page only
when a user clicks a button — and then make the element disappear
when the button is clicked again.
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1~ Visibility: Control whether or not the browser displays an element. The
Visibility options are

e Inherit: The element has the visibility of the element in which it’s
contained (the default).

e Visible: The element is displayed.
e Hidden: The element isn’t displayed.

e Collapse: For use with HTML tables. Collapse can be used to
remove a column or row without affecting the rest of the table
layout.

<P An important difference exists between setting the Display to None and set-
ting the Visibility to Hidden. When you set Visibility to Hidden, the element
in not displayed on the page but still takes up the same amount of space. In
contrast, if you set Display to None, the element is not rendered at all.

v Z-Index: Control the position of an element on the Z-coordinate, which
controls the stacking order of elements in relation to each other. Higher-
numbered elements overlap lower-numbered elements. (Note: This setting
works only on elements that use absolute or relative positioning settings.)

1~ Opacity: Control the opacity level for an element from 0.0 (fully trans-
parent) to 1.0 (fully opaque). For example, if you enter .5 in the opacity
field, the opacity of an element will be reduced to 50 percent.

The Text panel

The Text panel features a collection of options that control the display of (you
guessed it) the text in your pages. You can access the Text panel options by
scrolling down the Property panel until you get below the Layout options, or
by clicking the T icon at the top of the panel (see Figure 5-9).

The Text panel includes the following formatting options:

1~ Color: Set the text color. You can click the color well and choose a
color, use the eyedropper to sample any color on the screen, or enter
a hexadecimal color code in the color field. If you enter a hexadecimal
color code, include the beginning pound sign (#). For example, you
would enter #ffffff for white. You can also abbreviate these codes with
shorthand hex notations, such as #fff for white.

+~ Font-Family: Define a font family or a series of families. You can add
fonts from your local hard drive or from Adobe TypeKit by choosing
Manage Fonts in the bottom of the drop-down list and launching the
Manage Fonts dialog box, shown in Figure 5-10. (For an explanation of
why Dreamweaver includes font collections — and a look at how to
create new ones — see the upcoming section, “Why so many fonts?”.)
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1~ Font-Style: Enter Normal, Italic, or Oblique. However, italic and oblique
are rarely different in a web browser, so stick with italic unless you have
a specific reason not to.

1~ Font-Variant: Change text to small caps. Test your designs carefully
because this attribute is not supported by all browsers.

1~ Font-Weight: Make text appear bold by selecting Bold or Bolder from
the drop-down list. You can also enter a number between 100 and 900
to more precisely control how bold the text appears (100 is a light
bold, 900 is a dark bold). To remove bold formatting, choose Normal or
Lighter.

~ Font-Size: Define the size of the text. You can choose a specific numeric
size or a relative size. Size options are pixel (px), point (pt), pica (pc),
percent (%), em, rem, ex, and ch. Pixels, ems, and percentages are the
most commonly used options for text sizes. (For more on these options,
see the upcoming sidebar, “Comparing CSS size options.”)

v~ Line-Height: Specify the height of the line on which the text is placed.
(The spacing between lines of text is called leading.) Much like text
size, you can specify line height in a variety of ways, including pixels,
ems, and percentages. It is good practice on the web to add line height
because increasing space around your text makes it easier to read on a
computer screen. (For more on these options, see the upcoming side-
bar, “Comparing CSS size options.”)

1~ Text-Align: Left align, right align, center, or justify your text by clicking
the corresponding icon (refer to Figure 5-9). The first icon, for Inherit, is
the default. For example, you could center the text in the footer of your
web page by including Text-Align set to Center in the definition of a style
you apply to the <div> tag at the bottom of the page. (You find details
about styling <div> tags to create footers in Chapter 6.)

1~ Text-Decoration: Specify whether text is underlined, overlined (a line
appears over the text), displayed with a strikethrough (Line-Through),
or displayed with the blink effect (which makes text appear to flash on
and off). You can also choose None, which is frequently used to remove
the underline from linked text.

Use the decoration options sparingly, if at all. Links are underlined auto-
matically; if you underline text that isn’t a link, you risk confusing view-
ers. Overlined and strikethrough text can be hard to read, so use these
options only if they enhance your design. And by all means, resist the
blink effect; it’s distracting and can make the screen difficult to read.

1 Text-Indent: Specify the amount that text will be indented from the left
side of the page by entering a number in one of the size options, such as
pixels, ems, or percentages. (For more on these options, see the upcom-
ing sidebar, “Comparing CSS size options.”)
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Why so many fonts?

You may have heard that you can now use any font you want on your web
pages, thanks to the latest version of Cascading Style Sheets, CSS3. This
statement is true (at least for anyone using the latest web browsers) but with
some limitations: You must have the legal right to publish the font, and the
font must be hosted on a web server. In Chapters 6 and 7, you find detailed
instructions for using the @font-face options with the included font collec-
tions as well as hosted web services, such as Google Web Fonts.

To help ensure that your text appears as you intend, Dreamweaver includes
collections of the most common fonts on Windows and Macintosh comput-
ers (popular fonts that your visitors are most likely to have). These fonts are
grouped in families, such as

» Gotham, Helvetica Nue, Helvetica, Arial, sans serif

1 Cambria, Hoefler Text, Liberation Serif, Times, Times New Roman,
Times, and serif

When you apply a collection of fonts, the browser displays the formatted
text in the first font available in the list. For example, if you choose the font
collection that starts with Gotham and your visitors have Gotham on their
hard drives, they see your text in Gotham. If they don’t have Gotham, the
text is displayed in the next font on the list — in this case, Helvetica Nue. If
they don’t have that font either, the text is displayed in Helvetica. And if they
don’t even have Helvetica (which is more common on Macintosh comput-
ers), the browser uses Arial (which is common on Windows computers).
And finally, if they don’t have any of the fonts on the list, the browser looks
for any serif font. (Serif describes fonts, such as Times, that have those little
curly things on the edges of letters; sans serif means no curly things, which is
what you get with a font such as Arial.)

You can create your own font collections using the Manage Fonts dialog
box (refer to Figure 5-10), which is accessible by selecting the Manage
Fonts option at the bottom of the Font-Family drop-down list in the Text
panel in the CSS Designer panel. This dialog box is covered in more detail in
Chapters 6 and 7.

In the early days of the web, the only way to ensure that text appeared in

the font you wanted was to create the text as a graphic in a program such as
Photoshop or Fireworks, and then insert the graphic with the text into your
page. That’s still not a bad option for special text, such as logos. For all other
text, however, don’t save text in an image because graphics take longer to
download than text, text saved in a graphic is harder to update later, and
search engines can’t read the text in an image.
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Comparing CSS size options

When you create CSS styles, you can specify
sizes for fonts and other elements in so many
ways that confusion (and frustration) can setin
pretty quickly. When you design web pages, you
can choose from many size options, but these
are the most popular:

1~ Pixels: Pixels are an easy choice because
they offer many designers a familiar size
option. In addition, if you specify the text size
in pixels, the size won't change (although
the display size may change between Mac
and Windows computers). Pixels are espe-
cially useful when you're working with com-
plex style sheets because you don't have to
worry about the cumulative effect of rela-
tive sizes, but that's why so many of us are
now moving on to rems.

+~ Percent-based relative sizes: Many design-
ers use percentages to make text larger
or smaller relative to a base text size. For
example, if you define the text in a caption
style as 90 percent, it would appear at 90
percent of the size of the rest of the text on
the page. You might then make headlines
150 percent and subheads 125 percent.
This system is easy to understand but it is
no longer the best choice.

+* Em: For some time, the most popular option
among experienced web designers (and
anyone who wanted to follow good stan-
dards on the web), was the em size. Em is
based on the amount of space taken up by
the capital letter M in the font face speci-
fied in a style. Expressing the size of your
text using ems may seem complex (espe-
cially when you're new to web design), but
this option is ideal on the web because the
size is adjusted relative to the displayed text
size. Ems work much like percentages but
they adapt even better to different font face
sizes and do a better job of maintaining a
good display when users change their font
size settings.

1~ Ex: Similar to em, the ex option is based on
the size of a lowercase x in the specified
fontface. The em size is generally preferred.

1~ Small, medium, and large relative sizes:
Although these relative sizes were popu-
lar in the early days of the web, most web
designers today prefer to use ems, pixels, or
percentages.

The problem with relative sizes, like ems or per-
centages, is that they are cumulative. If | setthe
size of all text on the page to 80 percent of the
default size, and then | set the size of my cap-
tions at 75 percent, the captions will be 75 per-
cent of the 80 percent of the default size, which
is a lot smaller than 80 percent of the default
size. The same problem exists with ems and
exs. If you're creating one simple size, you're
fine, but if you're applying multiple styles on a
page (as most of us do), the cascading effect of
styles causes a problematic cumulative effect.

One of the new options in CSS version 3 is the
rem (root em) size option. The key to using rems
is to set a base font size. In theory, you can
specify any base font size, but in practice, many
designers choose 62.5 percent. That seemingly
arbitrary size enables you to specify rems in
a way that corresponds nicely to pixels. For
example, with the base font size set to 62.5 per-
cent, 1.4rem is equivalent to 14 pixels, a popular
size for the text used throughout a web page,
and 2.4rem is equivalent to 24 pixels.

Here's how these basic styles look when you
use rem:

62.5%; 1}
body { font-size: 1.4rem; }
hl { font-size: 2.4rem; }

html { font-size:

Note: Like many of the other new CSS3 features
in use on the web, not all web browsers support
rems. As of this writing, you can expect good
results in most popular browsers, including
Safari 5+, Chrome 1+, Firefox 3.6+, and Internet
Explorer 9+.
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The Text-Shadow section of the Text panel

The Text-Shadow section of the Text panel provides tools for adding text
shadows, one of the newest CSS properties included in the CSS3 definition.
You find step-by-step instructions for using these options in Chapter 7. The
Text-Shadow options are shown in Figure 5-11. The most popular options are
the following:

1~ H-shadow: Add a shadow to your text on the horizontal axis. First
choose a size option, and then enter a number in the field. For example,
enter 2px, to add a horizontal shadow that is 2 pixels wide.

1~ V-shadow: Add a shadow to your text on the vertical axis. First choose
a size option, and then enter a number in the field. (See the sidebar
“Comparing CSS size options.”)

+ Blur: Control the amount of blur in the shadow. The larger the number,
the more the shadow is spread out, or blurred.

~ Color: Enter a hexadecimal color code to specify the color of the
shadow, or use the eyedropper to sample any color on the screen.

text-shadow

h-shadow
w-shadow
blur

color

text-transform
letter-zpacing
word-zpacing

white-zpace

vertical-align

Figure 5-11: The Text-Shadow and
other options at the bottom of the
Text section in the CSS Designer
Properties panel.

The features at the bottom of the Text panel, which are not as common as the
other Text panel options, are as follows:

1 Text-Transform: Change the case of your text. Options are Capitalize
(which capitalizes the first letter), Uppercase, and Lowercase. Click the
corresponding icon to set this property.

1~ Letter-Spacing: Defines the amount of white space inserted between
letters. Size options are pixel (px), point (pt), pica (pc), percent (%),
em, rem, ex, and ch. (See the preceding sidebar “Comparing CSS size
options.”)
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1 Word-Spacing: Defines the amount of white space inserted between
words. Size options are pixel (px), point (pt), pica (pc), percent (%),
em, rem, ex, and ch. (See the preceding sidebar “Comparing CSS size
options.”)

1~ White-Space: Tell the browser how to handle line breaks and spaces in
a block of text. Your options are Inherit, Normal, Nowrap, Pre, Pre-line,
or Pre-wrap. Nowrap is especially useful because it prevents elements
from being separated if they must wrap to fit within a browser window
or another container.

1~ Vertical-Align: Align inline elements, such as text and images, in relation to

the elements that surround them. You can set a numeric value or choose
Baseline, Sub, Super, Top, Text-Top, Middle, Bottom, and Text-Bottom.

The Border panel

The Border panel defines the appearance of borders around images, tables,
<div> tags, and other elements. As shown in Figure 5-12, you can specify
border settings on one, two, three, or four sides of an element.

m T Q’ = || Show Set

border-collapse

barder-spacing

border-color : . HB3ATC
border-top-___ : L HB33ATC
border-right. ... : . #B33a7C
border-bott._. : L HB3ATC
border-left-___ : L HB39ATC
border-width : 14 px
border-top... : 14 px
border-right... : 14 px
border-bott. . : 14 px
border-left... : 14 px

border-style :  none
border-top-... : none
border-right.__ :  none —
border-bott... : rone
border-left-_. : rone
border-radius

Figure 5-12: The Border section in
the CSS Designer Properties panel.
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You can use the border settings to create dividing lines between <div> tags
that create columns or add separating lines above or below elements. The
Border panel options are

1~ Border-Collapse: Specify whether table borders are combined into a
single border or detached as they appear in standard HTML when you
use the <table> tag. The choices are Collapse, Separate (the default),
and Inherit.

~ Border Spacing: Set the spacing between borders of adjacent table cells
when the Border-Collapse option is set to Separate.

1~ Border Color: Specify the border color for all four sides of an element
by entering a hexadecimal color or by clicking the color well and using
the color picker.

~ Border Top, Right, Left, and Bottom Color: Specify different colors for
any or all borders of an element.

1 Border Width: Specify the width, or thickness, of the border. You can
choose thin, medium, or thick, or you can specify the size in pixels, ems,
or any of the other size options.

~ Border Top, Right, Left, and Bottom Width: Specify different widths for
any or all of the borders of an element.

1 Border Style: Choose from any of the border style options, including
Solid, Dashed, or Double.

~ Border Top, Right, Left, and Bottom Style: Specify different border
styles for any or all borders of an element.

+~ Border Radius: Create rounded corners on your borders. Click to place
your cursor in any of the four fields located near the corners of the
border preview box and enter a number to specify the amount of the
radius. You can choose from any of the CSS size options by using the
drop-down list.

The Background panel

Using the Background panel in the CSS Designer panel (see Figure 5-13), you
can specify a background color or image for a style — and control how the
background is displayed on the page. You can use background style settings
for any element of your web page that can display a background — including
the <body> , <div>, heading, and image tags.
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backgroun. .. H#CCCCCC

background-image
v url A fgallen3..
backaround-p...
size
background-clip
repeat : -
origin
attachrent

4

Figure 5-13: The Background section
in the CSS Designer Properties panel.

For example, you could alter the <body> tag to include background settings
that apply to the entire page, or you could create a style with the class or ID
selector and specify a background that appears only behind an individual
<div> tag. By including the background in the class or ID style of a <div>
tag, you can limit the background to appear on-screen only where the <div>
tag is used. Note that the Background option works with an image only if you
first set a margin around the image.

You can choose from these Background options:

1~ Background-Color: Specify the background color of a defined style using
one of several methods. You can click the color well and select a pre-
defined color or create a custom color. Or use the eyedropper to sample
any color on the screen. Finally, you can enter a hexadecimal color
code — make sure to include the #, as in #000000 for the color black
or #ffffff for the color white. You can also use abbreviated hexadecimal
colors, such as #000 or #fff for black and white.

1 Background-Image: Select an image to serve as the background in your
style definition. Enter any URL to an image on your computer or on the
Internet, or click the folder icon to browse your hard drive and select an
image.

1~ Background-Position: Specify the position of the background image from
the left and top of the parent element by entering a number in each field.
This option is visible only if you click the small arrow next to the URL
field in the Background section to reveal the additional fields that follow.

1~ Size: Select the measurement in pixels, ems, or another option, and then
enter the size you want for the background. Leaving the Size field set to
auto (the default) displays the image at actual size.



Chapter 5: Introducing Cascading Style Sheets

1 Background-clip: Specify whether the background begins the border,
the padding, or the content of a box element, such as a <div> tag.

1 Background-Repeat: Click the corresponding icon to specify how and
whether the background image repeats, or tiles, across and down the
page. Background images tile by default, so you must choose an option
if you don’t want your background to repeat or you want to specify how
it repeats. Also note that if the image is larger than the element to which
it is applied, only as much of the image as will fit in the display area
of the element will be visible. For example, if you use a 600-pixel-wide
image as the background of a <div> tag that is set to 300 pixels wide,
only half the image will be visible. The Repeat options, listed in order of
the appearance of their icons, follow:

e Inherit: Unless another option is selected, each element inherits
the behavior of its parent element. This default option does not
need to be specified.

e Repeat: The background image repeats vertically and horizontally
in the background of the element.

* Repeat-X: The background repeats horizontally, but not vertically,
in the background of the element.

e Repeat-Y: The background repeats vertically, but not horizontally,
in the background of the element.

* No-Repeat: The background is displayed once at the top left of the
element.

v Origin: Specify whether the origin of the background begins at the border,
the padding, or the content of a box element, such as a <div> tag.

1~ Attachment: Determine how the background behaves when the page is
scrolled. The options are

¢ Inherit: Unless another option is selected, each element inherits
the behavior of its parent element. This is a default option and
does not need to be specified.

e Fixed: The background remains glued to one place in the viewing
area and doesn’t scroll out of sight, even when the web page is
scrolled.

e Scroll: The background scrolls along with the web page.

+ Gradient: Click the color well next to Gradient to open Dreamweaver’s
new visual gradient selector, shown in Figure 5-14.
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Huehlinks background-image
Hwrapper » ull /A Agalerydd.
Hoontainer backaground-p..
body size
body td.th background-clip
repeat : o
origin
attachment
» gradient E linear-gradient(180de...
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N
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Figure 5-14: The gradient selector opens when you click the
color well next to Gradient in the Background panel.

The Box-Shadow panel

The Box-Shadow options (see Figure 5-15) make it possible to add shadows
to <div> tags and other box elements. The options are

1~ H-shadow: Add a shadow to your text on the horizontal axis. First
choose a size option, and then enter a number in the field. For example,
enter 2px to add a horizontal shadow that is 2 pixels wide.

1~ V-shadow: Add a shadow to your text on the vertical axis. First choose a
size option, and then enter a number in the field. (See the previous side-
bar “Comparing CSS size options.”)

+~ Blur: Control the amount of blur in the shadow. The larger the number,
the more the shadow is spread out, or blurred.

1~ Spread: Control how far the shadow spreads away from the box element.
1 Color: Enter a hexadecimal color code to specify the color of the shadow.

1~ Type: Display the shadow in the inset or outset style.
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box-shadow

h-shadow
v-shadow
blur
spread
colar © T
type -

Figure 5-15: The Box-Shadow section
of the CSS Designer Properties panel
includes options for adding shadows
to box-level elements.

The List panel

The List panel can be used to define the size and type of bullets displayed
with list tags. Use the icons at the top of this section to specify whether the
bullet should be inside or outside the list. Use the drop-down list next to
List-Style-Type to select the style of the bullet. The options are Disc, Circle,
Square, Decimal, Lower-Roman, Upper-Roman, Lower-Alpha, Upper-Alpha,

or None (see Figure 5-16). Choose None if you want to use the list tag with

no bullet, a common option when you’re formatting a list of links in a naviga-
tion bar (covered in Chapter 6). If you want to use a custom bullet made with
your own graphic, choose URL from the drop-down list next the List-Style-
Image field and then click the Browse button to select an image.

list-style-position

ligt-stple-image

list-shyle-type
besder :  14pux none HEIALTC

Figure 5-16: The List options are
at the very bottom of the CSS
Designer Properties panel.

The CSS Transitions panel

The CSS Transitions panel, shown in Figure 5-17, provides access to the New
Transition dialog box, also shown in Figure 5-17. Use these features to create
and manage CSS3 transitions, which enable you to add gradually changing
interactive effects to elements. For example, you can use a CSS3 transition to
slowly change the background color of a <div> tag from red to blue.
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Figure 5-17: Click the plus sign in the top left of the CSS Transitions
panel to open the New Transition dialog box, shown on the right.

The CSS Transitions panel is not grouped with the other CSS Designer panels,
but you can dock it there after it’'s opened. To open the CSS Transitions
panel, choose Window=>CSS Transitions. To open the New Transition dialog
box and create a new transition, click the small plus sign in the top-left
corner of the CSS Transitions panel.

The Transition category has the following options:

1~ Target Rule: The CSS style definition, or rule, that contains the proper-
ties you want to change with the transition.

 Transition On: Choose any option from the drop-down list to specify the
action that will trigger the transition. For example, choose Hover if you
want the transition to begin when a user rolls a cursor over the element.

1 Property drop-down list: Specify whether the same transition will apply
to all properties defined in the target rule or whether each property will
have a different transition.

1~ Property: Specify which CSS property you are targeting with the
effect. Click the plus sign (+) to add a property or the minus sign (-) to
remove one.

+~ End Value: Enter the final value you want used when the transition is
complete.

1 Choose Where to Create the Transition: Specify whether the transition
should be saved in an internal or an external style sheet.
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Switching between CSS and HTML Mode
in the Property Inspector

The Property inspector, which is accessible from the bottom of the
Dreamweaver workspace, displays the properties available to any selected
element on the page. Thus, the options in the Property inspector are different
when an image is selected than when text is selected, for example.

When nothing is selected, or when you select text on a page, the Property
inspector is split into two sections: HTML and CSS. In Figure 5-18, you see
the HTML mode of the Property inspector; Figure 5-19 shows CSS mode.
Note that buttons on the left side of the Property inspector make switching
between these two modes easy.

rrrrr

GImL] Formt o 7] cls Hone Bz oEEza o
B css D Norne - Link 2] Target -
Page Properties List Item...

Figure 5-18: The HTML mode of the Property inspector.

SPHTML  Targeted Rule  <New Iriine Style= v | Font & DefadtFont v - -

B css EditRule CcssPanel sree TE v -]
Page Properties.

Figure 5-19: The CSS mode of the Property inspector.

If you're new to CSS and HTML, understanding the differences between these
two modes can be a little confusing. Essentially, if you use a formatting icon
such as bold in HTML mode, Dreamweaver adds the HTML <strong> tag,
which makes text appear bold in most web browsers. If you use the same
icon in CSS mode, Dreamweaver automatically creates a style rule that
includes the bold formatting option.

In CSS mode, you can also choose to edit existing styles to add new format-
ting options to styles that are already applied to text, images, or other ele-
ments on a page. You can edit an existing style by simply selecting the style
in the Targeted Rule drop-down list and then using the Font, Size, and other
fields in the Property inspector to make changes or additions.
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Whenever you edit an existing style that has already been applied to ele-
ments on a page, the changes you make to the style are applied automatically
anywhere the style is used. This feature is wonderful when you want to
change several things at once but can be problematic if you want to make an
element (such as a heading) appear one way on one page and another way
somewhere else.

Anytime you want to create or edit a style, use the Property inspector in

CSS mode. On the other hand, to apply an existing style to an element on the
page, make sure you're in HTML mode. For example, to align an image with a
class style or apply an ID style to a <div> tag, you need to be in HTML mode.
To apply a style in HTML mode, select the image, text, or other element in
the page where you want to apply the style and then use the Class or ID drop-
down lists to select the style; Dreamweaver automatically applies it.

Similarly, to apply an HTML tag, such as the <h1> tag, you should be in
HTML mode. But you create or edit a CSS rule for the <h1> tag in CSS mode.
Of course, you don’t have to create or edit styles with the Property inspector.
Consider this a shortcut method; you may still prefer to use the CSS Designer
panel (covered in detail previously in the chapter) to make significant
changes to a style.
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Creating and Editing CSS Styles

In This Chapter
Using class and tag selectors
Creating page layouts with CSS and Div tags
Understanding the box model
Using Dreamweaver’s CSS layouts
Creating custom CSS layouts
Styling unordered lists for links
Testing and editing CSS
Comparing margins and padding
Aligning elements

thher you’re new to CSS or you've been strug- o T P
gling (I mean designing) with styles for years, -
Dreamweaver’s many CSS features offer welcome assis- o

tance. If you've used the CSS tools in previous versions
of Dreamweaver, beware that the CSS features were
redesigned in version CC. Although the basic rules of
CSS remain the same, the way you define style rules

in Dreamweaver has changed dramatically.

This chapter walks you through the process of
creating and applying styles with the class, tag, and
ID selectors using Dreamweaver’s new CSS Designer
panel. You also find instructions for customizing the
CSS layouts included with Dreamweaver. And you dis-
cover not only how to create styles for text, but also how
to position and align images, text, and other elements on a
web page. Finally, you discover how Dreamweaver makes it easy
to edit, rename, and even remove styles.
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If you're new to CSS or Dreamweaver, | recommend that before you start this
chapter you at least skim through Chapter 5, where you find an introduction
to CSS and a review of the new CSS Designer panel and how you can use it to
create, apply, and edit styles in Dreamweaver.

Brace yourself: You're getting into some of the most complex web design
features that Dreamweaver offers, but you're also getting into the core of web
design today. If you want to design web pages that can be edited and main-
tained efficiently, look good in a variety of screen sizes, and meet the latest
web standards, CSS is clearly your best option.

Organizing Style Sheets

SMBER
é‘,\“

One of the first decisions to make when you create new styles is whether to
save the style information in an internal or an external style sheet. In an inter-
nal style sheet, the style rule is saved at the top of the same HTML document
where you want to apply the style. In an external style sheet, new styles are
saved in a separate document that can be attached to any or all files in your
website.

External style sheets offer the greatest advantages because using one set of
styles across many pages is more efficient than creating styles for each page in
your site. That said, sometimes internal style sheets are a good choice, such as
when you're creating a style that will apply only to elements on one page.

The following sections walk you through the process of creating, attaching,
moving, copying, and editing styles in internal or external style sheets. In the
first section, you find out how to create internal and external style sheets.
The remaining exercises in this chapter work the same way whether you save
styles in an internal or external style sheet. (For more on the differences and
relative advantages of internal and external style sheets, see Chapter 5.)

This chapter focuses heavily on the features in the CSS Designer panel, which
is new in Dreamweaver CC and replaces nearly all CSS features in previous
versions of Dreamweaver. In Chapter 5, you find a detailed review of all sub-
panels in the CSS Designer panel. Use that chapter as a reference if you need
to check on a specific feature. In this chapter, you find step-by-step exercises
designed to show you how the different sections of the CSS Designer panel
work together.

If the CSS Designer panel is not already open, you’'ll need to open it before
following along with any of the exercises. To open this feature-rich panel set,
choose Window=>CSS Styles.
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Creating an internal style sheet

Internal style sheets are saved in the same HTML file where they are applied.
Thus, you don’t create a file when you create an internal style sheet, as

you do when you create an external sheet (covered in the next section).
Instead, when you create an internal style sheet, you simply add <style>
tags within the <head> tags at the top of the HTML file you have open in
Dreamweaver. Then, when you create styles, you save the new style rule
definitions within the <style> tags in your file.

Creating a new internal style in Dreamweaver requires just two steps. First
click the plus (+) icon in the Sources panel at the top of the CSS Designer
panel, shown in Figure 6-1. Then select Define in Page from the drop-down
list. You're done. Dreamweaver inserts the <style> tags into the code in
your file, and lists the internal style sheet in the Sources panel with the
<style> tag, which is also visible in Figure 6-1.

ALL SOURCES Creake A Mew C55 File
Aktach Existing £33 File
Define in Page %

<style=

Figure 6-1: Select Define in Page from the CSS Designer
Sources panel to create a new internal style sheet.

Creating an external style sheet

At the very top of the CSS Designer panel, you find the Sources panel. This

panel displays the name or names of any style sheets available to the open
page. This same panel is used to create or link to style sheets as you create
or apply styles.

To create an external style sheet, first create and save a new HTML file or
open an existing file in Dreamweaver, and then follow these instructions:

1. Click the plus (+) icon in the Sources panel at the top of the CSS
Designer panel, shown in Figure 6-2.

A drop-down list opens with three options: Create a New CSS File, Attach
Existing CSS File, and Define in Page.
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ALL SOURCES Create A Mew C35 File
attach Existing £33 File

@Media Define in Page

Figure 6-2: You can create a new external style
sheet using the Sources panel.

. Choose the Create a New CSS File option from the drop-down list.

The Create a New CSS File dialog box opens.

. Enter a name for your new style sheet file, as shown in Figure 6-3.

You can name style sheets anything you like, as long as you don’t include
spaces or special characters other than the hyphen (-) or underscore ().

Create a New CSS File (=2

FilefURL: [ miy-styles| | [ Browse... |

Add as: (=) Lirk
() Impart

» Conditional Usage {Optional)

[ Help | [ cancel || oK L\@J

Figure 6-3: Name your new external style sheet in the
Create a New CSS File dialog box.

. Select the Link option.

Link is considered the best practice in most cases and is selected by
default in Dreamweaver.

For the most part, the Import option is used only when would want to
apply multiple external style sheets to the page but only want to link to
one style sheet. In that case, you could use the Import option to associ-
ate multiple style sheets with one.
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5. Click the arrow next to Conditional Usage to view additional settings.

The Conditional Usage settings are used to set up media queries for style
sheets. To learn how, and when, to use media queries, see Chapter 8.

6. Click OK.

The style sheet is saved and linked to the HTML page you have open in
Dreamweaver. Note: If you'’re working on a new HTML page, make sure
that you've saved the page; otherwise, you’ll be unable to create and
link a new CSS file.

\“gN\BEI? After you create an external style sheet, you can link that same style sheet
& to as many pages as you like by following the steps in the exercise that imme-
diately follows. You can also add as many style rules as you like to any exter-
nal style sheet, which is covered in various exercises that follow on creating
class, tag, and other types of styles.

Attaching an external style sheet to a page

After you've created an external style sheet, you can attach it to any web
page. In the step-by-step instructions that follow, you can use any of the pre-
defined style sheets included in Dreamweaver (as I do in this exercise), or
you can use these instructions to attach any style sheet you create using the
steps in the previous exercise. Begin by opening the page to which you want
to attach the style sheet and then follow these steps:

1. Click the plus (+) icon in the Sources panel at the top of the CSS
Designer panel and choose Attach Existing CSS File from the drop-
down list (refer to Figure 6-2).

The Attach Existing CSS File dialog box opens.

2. Click the Browse button and locate the CSS file in your local site
folder.

You can also enter a URL if you want to use a remote CSS file located on
another website, but it’s most common to use a style sheet contained in
the website you're working on.

3. Select the Link or Import option.

If you're attaching a style sheet to an HTML file, your best choice is
almost always to choose Link, which is the default. Choose Import if you
want to create one master external style sheet that contains references
to other style sheets, an advanced option that enables one style sheet to
refer to another.
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4. (Optional) Choose options from the Conditional Usage section.

Use the Conditional Usage features to define a media query as you
attach your style sheet. Media queries are covered in Chapter 8.

5. Click OK.

The dialog box closes, and Dreamweaver sets the link to the style sheet
by adding a line of code to the top of the HTML file. After you link an
external style sheet, any applicable styles are automatically applied to
the content in the page in Dreamweaver and the selector names of the
styles defined in the style sheet become visible in the Selectors panel of
the CSS Designer panel set.

You can attach multiple style sheets to the same HTML page, and you can
use internal and external style sheets in the same document. For example,
you can save your text styles in one style sheet, save your layout styles in
another, and then attach both to the same document — which makes all

the defined styles available to the page. Similarly, you create different style
sheets for different purposes, such as one for printing the file and another for
browser display.

Moving and copying styles
After you attach an external style sheet to a document, you can move, copy,
and edit styles as follows:

1 Moving styles: You can move styles from one style sheet to another
with click-and-drag ease. First, in the Sources panel, select the name of
the style sheet with the styles you want to move. Then, in the Sources
panel, drag the name of any style in that style sheet onto the name of the
style sheet you want to move it into. In Figure 6-4, 'm moving an hlstyle
from the internal style sheet, identified in the Sources panel with the
<style> tag, into an external style sheet named new-styles.css. If
you’ve attached more than one external style sheet to a document, you
can also move styles from one external style sheet to another using the
same click-and-drag technique.

1~ Copying styles: You can copy styles from one document to another by
right-clicking (Control-clicking on a Mac) a style name in the Sources
panel and choosing Duplicate. This makes a copy of the style, which you
can then edit or move into another style sheet.
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Figure 6-4: Move styles from an internal to an
external style sheet.

1~ Editing styles: You edit styles in an external style sheet the same way
you edit styles in an internal style sheet — by first selecting the name of
the style sheet in the Sources panel, then selecting the style name in the
Sources panel, and finally editing the style definition in the Properties
panel. If you want to edit a CSS file used in a website on a server, you
must first download the file to a local hard drive and save it in your
site’s root folder. (You find detailed instructions for editing CSS files in
the next section. You find instructions for uploading and downloading
files in Chapter 4.) Note: Any changes you make to a style in an external
style sheet are applied automatically to all the files to which the external
style sheet is attached.

When you edit an HTML page linked to an external style sheet, you must
upload both the HTML file and the CSS file to your server before the style
changes become visible on your website online. Be sure to save the CSS file
when you finish editing it!
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Editing styles in code view

Although you don‘t ever have to look at the code
in your CSS files, Dreamweaver does include a
great text editor that color-codes CSS selectors
and properties to make them easier to read, as
you see in this figure.

In Dreamweaver, you can open .css files by
double-clicking them or by choosing File=>Open
and then double-clicking the name. The style
sheet opens in Code view. When you view an
external style sheet using the Code view editor,

DW File Edit View Insert Modify Format Commands  Site
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you can still use the CSS Designer panel to edit
or review the styles in the style sheet — even
if the style sheet isn't linked to an HTML page.

If you prefer, you can also edit the code by hand
in Code view. The figure shows an example of
a style sheet opened in Dreamweaver’'s Code
view. Note that the CSS Designer panel dis-
plays all relevant style information and gives
you access to the CSS editing tools.
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Creating Style Rules

Get ready to create your first styles. Whether you're creating styles using
class, tag, or ID selectors, most of the steps are the same.

As you go through the steps to create a style in Dreamweaver, you may be
surprised by the number of options in the many panels in the CSS Designer
panel group. However, you will use only a few of the available options to
create most styles.

CMBER . - .
S You can always refer to Chapter 5 for more detailed descriptions of the differ-
& ) . . -
ent selector types as well as the many options in the Properties panel in the
CSS Designer panel, which you can use when you create or edit styles.

Defining styles with the tag selector

You can create completely new styles using the call or ID selectors, but you
can also create styles that change the formatting of existing HTML tags.
These styles are created using the fag selector, which is also known as the ele-
ment selector (because HTML tags are also called HTML elements). When you
define a style using the tag selector, you can alter the appearance, position,
and other features of any existing HTML tag.

Many HTML tags already include formatting options. For example, the head-
ing tags include formatting to style text using a large bold font. When you
create a style with a tag selector, you have to consider the formatting options
already associated with that tag. Any options you define will either be added
to the existing formatting or override the formatting. For example, in the
steps that follow, I create a CSS rule for the <h1> tag, which is displayed
using the Times font in most web browsers. In the rule, I change the font by
selecting the Gotham font collection included in Dreamweaver. That means
Gotham will override Times when the <h1> tag is used in my page. If I want
my headlines to be bold, I don’t need to include bold in the style definition
because bold is in the default style of the <h1> HTML tag. In this case, if I
don’t want headlines to be bold, I need to add a style rule that removes the
bold formatting by setting the Font-Weight to Normal.

You may ask, “Why would I redefine the <h1> tag instead of just creating a
new headline style using the class or ID selector?” Although you can define a
new class style instead of redefining an HTML tag, sometimes using an exist-
ing HTML tag is better. Heading styles are especially important on the web
because text formatted in an <h1> tag is well recognized as the most impor-
tant text on a page. Among other things, text formatted in an <h1> tag may
get special consideration from search engines.
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When you create a style for an existing HTML tag, you don’t need to apply
the style itself the way you do with class and ID styles, covered later in this
chapter. Wherever you've used the HTML tag, the style definition settings are
applied. Thus, in the exercise that follows, as soon as I create a style that
redefines the font face, color, and formatting for the <h1> tag, any text that is
already formatted with the <h1> tag will automatically change to reflect the
new style. Similarly, any time I use the <h1> tag again, it will format the text
using the formatting I've defined in the new tag style.

To create a style that redefines an HTML tag (such as the <h1> tag) with the
tag selector, first create a file or open an existing one and then follow these
steps:

1. In the Selectors panel of the CSS Designer panel, select the style sheet
to which you want to add the new style.

If you haven’t yet created or attached a style sheet to the page, see the
earlier exercises in this chapter for instructions on how to complete this
required initial step.

2. If you want to target the style to a specific media type or screen size,
choose or define a media query in the @Media panel.

Using media queries with styles is optional. If you do not specify a media
query, Dreamweaver will use the Global property and your style will
work in all media formats and screen sizes. (You find more on media
queries in Chapter 8.)

3. Click the plus sign (+) in the Selectors panel.
A new selector is added to the Selectors panel.

When you click the plus sign (+) to create a new selector, a few

things can happen, depending on what’s already on the page open in
Dreamweaver. The first time you create a style in a blank web page,
Dreamweaver enters body in the Selectors panel, as shown in Figure 6-5.
If you're working on a page with text or other content that is formatted
with HTML tags or styles, Dreamweaver may add a compound selector
based on the elements surrounding whatever you've selected with your
cursor. For example, if your curser is resting in a headline formatted
with an <h1> tag, and that headline is inside a <div> tag styled with an
ID style named #container, Dreamweaver will add a compound selec-
tor, like this: #container hl.Remember, you can always change any
selector name by double-clicking to select the name in the Selectors
panel, and then editing or replacing the name with whatever you want to
use for your selector.
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Figure 6-5: Click the plus sign in the Selectors
panel to create a new style.

. In the Selectors panel, double-click the selector name. Begin to enter
the name of the HTML tag, and then select the tag from the drop-down
list that appears.

You can enter the name of any HTML tag to create a style using the tag
selector. As you can see in Figure 6-6, as you type an HTML tag, a drop-
down list appears with tags that begin with the same letter you've typed.
Selecting the desired tag from the list rather than typing the entire tag
name yourself is good practice because you avoid typos.

. In the Properties panel, specify the settings you want in your style
rule.

For this example, I redefined the <h1> tag to use the Gotham font collec-
tion, instead of the default browser font, and changed the text color to
red. As you see in Figure 6-7, the font and color are immediately applied
to the text in the page formatted with the <h1> tag.
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Figure 6-6: Dreamweaver includes code hints
for HTML tags.
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Figure 6-7: When you create a style using the tag selector, the formatting you define in the
style rule is immediately applied to any content formatted with the HTML tag.
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If you want to be able to use the same HTML tag with different formatting in
different parts of the same page, you can create compound styles, as
described in the “Creating compound styles” sidebar. Compound styles are
handy, for example, if you want text formatted with the <h2> tag to look dif-
ferent in the main part of your page than it does in a sidebar.

Creating styles with class and 1D selectors

Class and ID selectors have many similarities and one key difference. ID
styles can only be used once per page but class styles can be used as many
times on the same page as you like.

Class and ID styles have the following similarities:

»” You can name styles created with the class and ID selectors anything
you like. Seriously, you can name a style Fred if you like, although most
of us prefer to use names that have some meaning, such as footer for
the name of the style that goes at the foot, or bottom, of the page. You
should not include spaces or special characters in style names, although
the underscore and hyphen are okay. The use of all lowercase is a
common but not required practice.

» You can apply class and ID styles to any element on a page, but they are
most commonly applied to header tags, div tags, unordered list tags,
paragraph tags, image tags, and the new HTMLS5 tags.

1~ Using styles created with the class and ID selector is a two-step process.
First, you create a new style using the class or ID selector and give it a
name; then you apply the style to an element on the page.

In this section, you find step-by-step instructions for creating styles with

the class and ID selectors. In the next section, you see how to format text

and other elements by applying a style created with the class or ID selector.
These same instructions can be used to create and apply any class or ID style
in Dreamweaver.

To define a new class or ID style, create and save a new document or open an
existing file, and then follow these steps:

1. If you'’re defining a new style you want to apply to an existing ele-
ment, click to place your cursor over the element that you want to
format with the new style.

Although this step is not required (you can create styles for elements
that are not yet on the page), Dreamweaver automatically creates selec-
tor names based on the page element that your cursor is currently
selecting. In the example shown in this exercise, my cursor is inserted at
the beginning of the headline text.
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2. In the Selectors panel of the CSS Designer panel, select the name of
style sheet to which you want to add the new style.

If you haven’t created or attached a style sheet to the page, see the ear-
lier exercises in this chapter for instructions on how to complete this
required initial step.

&

If you want to target the style to a specific media type or screen size,
define a media query in the @Media panel.

If you don’t specify a media query, Dreamweaver will use the Global
property and your style will work in all media formats and screen sizes.
(You find more on media queries in Chapter 8.)

-

In the Selectors panel, click the plus sign (+).

A new selector is added to the Selectors panel. In Figure 6-8, Dreamweaver
has added a compound selector name, which includes all the styles
already applied to the headline where my cursor was resting when [
started to define the style. (To learn more about using compound styles,
see the sidebar, “Creating compound styles,” later in this chapter.)
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Figure 6-8: Click the plus sign to create your new style.
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5. Double-click the selector name, and edit or replace it with the name
you want to use for your style.

You can name class and ID styles anything you like, as long as you
don’t use any spaces or special characters other than the hyphen (-) or
underscore ().

If you want to create a style using the class selector, you must begin
the style name with a dot, or period. If you want to use the ID selector,
the style name must begin with a pound sign (#). See Chapter 5 for a
detailed explanation of the differences between class and ID styles.

6. In the Properties panel, specify the settings in your style rule, as
shown in Figure 6-9.

For this example, I created a style called . quote-style. I defined the
rule using the following settings in the Text section of the Properties
panel:

e For the Color field, I clicked the color well (the square icon) and
selected a dark blue color. Sticking to the default color swatches
in the color well is the quickest way to choose a color, but you
can also create custom colors by clicking the icon that looks like a
rainbow-colored globe in the upper-right corner of the color well
and selecting a color from the system color picker.

In the Font-Family field, I chose the Baskerville font collection from
Dreamweaver’s font list. To format your text with almost any font
using the new font embedding options in CSS3, see Chapter 7.

In the Font-Style drop-down list, I chose Italic as the font style.

In the Font-Size field, I chose 1.3em for my quote style, which
will make the quote text appear just a little larger than the rest of
the text on the page. You can specify text sizes in pixels, percent-
ages, ems, and several other measurements. (For an explanation
of options, see the section “Understanding CSS size options,” in
Chapter 5.)

e [n the Line-Height field, [ chose 1.3em to provide more space
between the lines of text, to compensate for the larger size I set in
the Font-Size field.

In this example, I chose to define the style using the class selector (indi-
cated by the period at the beginning of the name) so that I could apply
the style to more than one quote on the same HTML page. As you see

in the exercise that follows, class and ID selectors are easy to apply to
content after you create them because Dreamweaver adds these styles
to the Class and ID drop-down lists in the Property inspector, located at
the bottom of the workspace.
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Figure 6-9: Define style rules using the options
in the Properties panel.

Applying class and 1D styles

Defining class and ID styles in Dreamweaver is the time-consuming part.
Applying them after you define them is the time-saving part. How you apply a
style depends on the kind of style you've created. To apply a class or ID style in
Dreamweaver, create a new file or open an existing one and follow these steps:

1. Click and drag to select the text or other element to which you want to
apply a style.

In this example, shown in Figure 6-10, I've selected the text to the left of
the photograph.
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2. In the Property inspector (with the HTML features displayed), select
the style from the Class or ID drop-down list.

Note that in the example, I'm selecting a style from the Class drop-down
list and Dreamweaver provides a preview of the style by formatting the
way the name appears in list based on the style definition. (For example,
in Figure 6-10, the . quote-style style name is displayed as italic and
blue in a large size.) When you choose a style, the selected element (in
this case, the text to the left of the image) changes to reflect the applica-
tion of the style. Figure 6-10 shows the quote style created in the preced-

ing section applied to the text.
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Resetting HTML elements with CSS

Because not all browsers interpret HTML and CSS in the same way, many
web designers begin designing pages by creating styles that remove any
border, padding, or margins included in an HTML tag by defining a style that
sets those values to 0 (as you see in the following example).

Resetting common HTML tags to remove any padding or margins means that
all your tags start with the same blank slate. In this way, you help ensure that
any styles you create will be displayed more consistently across different
web browsers.

In the CSS layouts included in Dreamweaver, you find styles that reset
common tags, including the heading and list tags. In this example, I've set the
border, padding, and margins to 0 to ensure a more consistent display across
different web browsers:

hl, h2, h3, h4, h5, h6, p, ul, ol, 1i, {
border:0; margin:0; padding:0;

Creating Layouts with CSS and Div Tags

The key to understanding how CSS works in a page layout is to think in terms
of designing with a series of infinitely adjustable containers, or boxes. Indeed,
this approach to web design is commonly called the box model.

Think of the box model this way: First you use HTML tags, such as the <div>
(division) tag or <p> (paragraph) tag, to create boxes around each section of
your content. Then you use CSS to style each box, using CSS rules to control
the position, width, and alignment of each box by specifying such settings as
Width, Margin, Padding, Float, and Border. The combined effect is one beauti-
ful page, created by combining CSS styles with HTML tags.

Although you can use any HTML tag as part of your page layout, the <div>
tag is used most often to create the boxes for main sections of a page, such
as the banner area, commonly used at the top of a page, the main content
area, the sidebars, and the footer. Think of <div> tags as generic containers
designed to contain text, images, or other content. Essentially, <div> tags
create divisions on the page, separating one section of content from another.
Unlike other HTML tags, <div> has no inherent formatting features. Unless
CSS is applied to a <div> tag, it’s invisible on a page when viewed in most
web browsers; yet the tag has a powerful purpose because you can easily
format with CSS any content surrounded by opening and closing <div> tags.
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Splitting the view

If you're creating a series of <div> tags to
position content on a web page, you may find
it easier to keep track of the <div> tags if you
use Dreamweaver's Split view, as shown in
the figure. Split view enables you to see Code
view and Design view simultaneously. To split
the workspace area, choose View=>Code and
Design or click the Split button, located just under
the Insert panel at the top of the workspace.

If you select an image, text, or another ele-
ment on a page in Design view, it's highlighted
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Using

3

Adobe uses the box model to create all the CSS layouts included in
Dreamweaver. In these layouts, each <div> tag on the page has a corre-
sponding style. As a result, to change the size or positioning of the header,
footer, or any of the other main areas of the page separated by <div> tags,
you need to edit the corresponding style. You find detailed instructions for
how to identify and edit these styles in the sections that follow.

Dreamweaver’s CSS Layouts

Dreamweaver includes two CSS layouts designed with HTML5 tags that you
can customize to create a seemingly infinite variety of page designs. These
layouts give you a head start when you create a new page, and they're
designed to work well in a variety of web browsers, so they can help you
avoid common problems caused by the different ways web browsers dis-
play HTMLS5 and CSS. For all these reasons, | recommend starting your
design work in Dreamweaver with a CSS layout chosen in the New Document
window, especially if you want to use HTMLS5.

One of the challenges with CSS is that it continues to change and design
features are introduced with each new version. Unfortunately, browser
support — which can make the difference between a beautiful web page and
a jumbled, unreadable design — hasn’t always kept up, and the companies
that make browsers haven’t always agreed on how to display CSS. (You find
more about browser differences and testing in Chapter 4.)

To help you get around the problems caused by browser differences, Adobe
dedicated the equivalent of decades of time (at least in Internet years) to
designing CSS layouts with HTML5 that display well in many different web
browsers, even older versions of browsers.

Before you rush off to check out these cool CSS layouts in Dreamweaver, let
me warn you: They’re not much to look at when you first open them. They’re
intentionally designed with the most basic of formatting options and a dull
green color scheme — but fortunately color styles are some of the easiest
styles to alter in CSS.

No matter what your experience level, the following sections are designed to
help you appreciate how Dreamweaver’s CSS layouts work and to help you
create your own page designs by customizing the layouts step by step. You
find out how to change the width of columns, the formatting styles for text,
and the alignment of any element on the page in one of Dreamweaver’s lay-
outs. If you’re new to CSS, altering one of these layouts may seem confusing
at first; trust me, altering an existing layout is much easier than creating a
design from scratch.
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Creating a new page with a CSS layout

To create a new page using one of Dreamweaver’s CSS layouts, follow these
instructions:

1. Choose Filez>New.
The New Document dialog box appears.

2. Choose Blank Page from the left column and HTML from the Page
Type column in the middle.

Alternatively, you can choose an option in the bottom part of the Page
Type section that corresponds to the programming language used on
your site, such as ASP.NET, PHP, or ColdFusion, and then progress to

Step 3. (If you're not familiar with these programming options, stick with
HTML.)

3. In the Layout section, select either CSS layout.

For this example, I chose 2 Column Fixed, Right Sidebar, Header and
Footer. In Figure 6-11, note that when you select a CSS layout, a preview
of the layout is displayed at the top right of the dialog box.

New Document =
Page Type: Layout:
[ stenkPage - g‘gL
- eSS "3 column fixed, header and footer [y
L Fhio Grd Layout = sass
= Scss
= Javascrpt
Starter Templates Rl
= oML e
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= Lbrary tem
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Two colmns, allwidths in pixels, with right
sidebar, header and footer
DocType: | HTMLS -
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Attach CS5 fie =
) i (o e

Figure 6-11: When you select the name of a CSS layout, a preview
appears in the top-right corner.
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4. From the Layout CSS drop-down list, choose the type of style sheet you
want to create as you design the page:

e Add to Head creates an internal style sheet and includes all the
styles for the layout in the header area of the new document.

* Create New File creates a new external style sheet with all the
page styles as you create the new document with the design.

e Link to Existing File adds the style sheet information for the new
document to an existing external style sheet.

Note: You can always change how the style sheet is set up later by
moving styles from an internal style sheet to an external one or from one
external style sheet to another. (You can find instructions for creating
external style sheets and moving styles at the end of Chapter 5.)

5. Click Create.
The new page is created and opened in the main workspace.
6. Choose Filer>Save to save the page and styles.

If you saved the styles in an external style sheet, a second box prompts
you to save the style sheet separately. If the styles are contained in an
internal style sheet, they’re saved automatically when you save the page.

Save all the pages of a website, including external styles sheets, in your
local site folder. (For more about defining a website and specifying a
local site folder in Dreamweaver, see Chapter 2.)

Editing the styles in a CSS layout

After you create a new page with a CSS layout, you have a seemingly infinite
number of options for editing it, but first you have to determine which styles
in the style sheet correspond to the elements you want to edit.

The steps in the following sections explain how to edit the overall design
of a page created with a Dreamweaver CSS layout. I've broken the process
into several step lists to help you follow along more easily. Note: The steps
assume you're proceeding through the sections in order.

As you can probably imagine, you can edit the styles in a CSS layout in many
ways to create your own designs, but the process [ explain in the following
sections should serve you well as you get started with any of these layouts.

After you adjust the existing styles to get the basic page design the way you
want it, you can create as many additional styles as you desire.



NBER
‘x&
&

Chapter 6: Creating and Editing CSS Styles 183

Checking out the available styles and making basic edits

You can use these same basic instructions with any CSS layout included in
Dreamweaver. To edit styles in a CSS layout, follow these steps:

1. Open a page file that’s based in a Dreamweaver CSS layout, and
choose Window=>CSS Styles (or click the CSS Designer tab to expand

the panel).

The CSS Designer panel opens or expands.

2. Click to select the name of the style sheet in the Sources panel at the

top of CSS Designer.

All the styles associated with the new page are listed in the Selectors
panel, as shown in Figure 6-12.

To change any element in the design of this page, you edit the corre-

sponding style.
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Figure 6-12: Alter the formatting options in a CSS layout by editing the corresponding style
definition in the CSS Designer panel.
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3. Select the name of any style listed in the CSS Designer Selectors panel.

The corresponding CSS rules defined for the style are displayed in the
Properties panel, at the bottom of the CSS Designer panel (refer to
Figure 6-12). Clicking through the list of styles and reviewing their cor-
responding rules is a good way to get a quick overview of the design and
to see where the various page-formatting options are stored.

The HTML5 header, .nav, and footer tags control the main sections of the
page. For example, the header style, which is shown in Figure 6-12, includes
a rule that makes the background color green. Thus, to change the color of
the header area at the top of the page, you change the background color
setting in the header rule. (You find detailed instructions for editing the
header and other main styles in this CSS layout in the “Customizing content
areas” section, later in this chapter.)

Editing page-wide settings
To edit page-wide settings — such as the background color of the page or the

main font face, size, and color of the text used throughout the page — follow
these steps:

1. In the CSS Designer Selectors panel, select the style named body.

The properties defined in the selected style rule are displayed in the
Properties panel, as shown in Figure 6-13.

2. Click the T icon at the top of the Properties panel, and change or add
your desired font and other text settings.

You can change the font face, size, style, and weight. To change the
space between lines of text, change the line height.

3. Scroll down to the Background area of the Properties panel and use
the color well in the Background-Color field to specify a color for the
entire background of the page.

Alternatively, you can enter any hexadecimal color code in the
Background-Color field or use the eyedropper to sample any color on
the screen. To add a background image, click in the URL field in the
Background section and then click the Browse button that appears and
select the image that you want to serve as the background. Use the
Background-Repeat icons to specify how the background image should
repeat (if at all) on the page.

4. Make any other changes or additions to the style rule.

Changes to style rules in the Properties panel are automatically saved and
applied to content formatted with the rule.
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Figure 6-13: Define page-wide settings in the

style for the <body> tag.

Creating compound styles

Compound styles make it possible to create
more specific styles. Of the many uses for com-
pound styles, one of my favorites is the capabil-
ity to create tag styles that appear differently in
different parts of the same page.

When you redefine a tag (as with the unordered
list and link tags), the new style applies to all
uses of that tag within a page, unless you define
the tag as a compound style by including the
name of its container in the style name.

For example, in the “Creating a Navigation
Bar from an Unordered List of Links” section,
instead of creating a new tag style with just

the name of the <ul> tag, | created a com-
pound style called #navbar ul to redefine
the <ul> tag onlywhen it's contained within a
<diwv> tag with an ID of navbar.

When you create compound styles like this,
make sure you separate each style name by
a single space. In this example, | also cre-
ated styles for the <1i> and <1ink> tags in
the same way, creating styles with the names
#navbar a:link, #navbar a:hover,
and #navbar ul 1i.You can create com-
pound styles with multiple tags and style names
to create more specific CSS rules.
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Customizing content areas

To change the width or other settings of the main content areas, which con-
trol the overall size of the page and the header, footer, and sidebar, follow
these steps:

1. To change the width of the entire main design area:

a. Click the .container style in the Selectors panel of the CSS
Designer panel.

The properties of the . container style rule are displayed in the
Properties panel, where you can also edit the style.

b. Change the size in the Width field or type a new number for
your desired page width.

The width of the page design is automatically changed based on
the size you entered. When you alter the width of the .container
style, as [ did here, you change the width of the entire design
because all the <div> tags and other elements are contained in
the <div> formatted with the . container style — and they’re all
set to expand to fill the . container <div>. (For more on the best
width for a web page, see the sidebar “How wide should [ make my
web page’s design?”)

2. To alter the size of the content area of the page, select the style named
.content and specify the size and other options you desire in the
Properties panel.

If you change the width of the content area in a layout that includes a
sidebar, you must change the width of the sidebar as well. For example,
in the layout used in this exercise, the content section is 780 pixels wide
and the sidebar is 180 pixels wide, and they fit perfectly in the 960-pixel-
wide container. Thus, if you increase the width of the content style by 30
pixels, you’ll need to decrease the width of the sidebar by 30 pixels so
that the total remains 960 pixels.

3. To change the background color of any style on the page, click the
name of the corresponding style and change the settings in the
Background section of the Properties panel.

For example, in the CSS layouts in Dreamweaver, the sidebar is defined
in a style named . sidebarl. Thus, to change the background color, |
clicked . sidebarl in the Selectors panel, selected the Background cat-
egory in the Properties panel, and then clicked the color well (as shown
in Figure 6-14) and selected the color [ wanted. Similarly, to change the
background color of the header, select the style named header in the
Selectors panel and use the color well in the Properties panel.
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Figure 6-14: Change the background color in
the Properties panel.

4. To add an image to the header:

a. Select the placeholder image labeled Insert Logo and press the
Delete or Backspace key.

b. Choose Insert ~Image~>Image and select an image using the
Select Image Source dialog box.

5. Replace text and insert images in the sidebar and main content areas.

You can add or replace text and insert images in any page created from
a CSS layout, just as you would in any other web page.

6. Choose File>Save All to save the page and styles.
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A\

You can combine CSS layouts with Dreamweaver’s template features to
create a template — a page design you can use to create additional pages
without repeating all the steps to customize the styles for each page. (As you
discover in Chapter 9, Dreamweaver’s template features offer many advan-
tages when you’re designing a site with more than a few pages; for example,
you can make changes that affect many pages at once.)

Here’s a related tip: If you intend to use the design as a template, make sure
you save your styles in an external style sheet so you can edit the style rules
outside the template. (Find instructions for creating external style sheets and
for moving internal styles into an external style sheet in Chapter 5.)

Creating a Navigation Bar from an Unordered
List of Links

A\

Here’s a great CSS trick for turning a bulleted list (or unordered list) into a
navigation bar with a simple rollover effect. Using a bulleted list for naviga-
tion bars is a well-accepted convention for websites that meet current acces-
sibility standards. A bulleted list is a logical choice for navigation elements;
even if the style rules are removed, the links still stand out from the rest of
the elements on the page and are clearly grouped together in a list.

In Figure 6-15, for example, you see how the links, which are contained in an
unordered list, appear without styles applied to them. In Figure 6-16, those
same links are still contained in the unordered list, but the application of the
styles changes their appearance dramatically.

To see how any web page looks without its styles applied when using
the Firefox web browser, as shown in Figures 6-15, choose Viewr>Page
Styler>No Style.

Thanks to CSS, you can gain the benefits of styling a list of links with the
unordered list tag and still format your links with any style you choose. For
the same reason, most designers use the heading tags to format headlines
and then create styles to change the way they appear. Formatting a list of
links with the unordered list tag adds meaning to the code, but you don’t
have to keep those boring bullets, and you can align your links horizontally
or vertically. CSS applied to text also enables you to create a rollover effect
because you can change the style of the different link states, as you see in the
following exercise.

You can use the following steps to add a list of links to any CSS layout
included in Dreamweaver, as well as to any custom CSS layout you create
yourself.
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Figure 6-16: The same page shown in Figure 6-15 but with styles applied.
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A\

To create a navigation bar using CSS to redefine the unordered list and link
tags, follow these steps:

1. Click to place your cursor where you want to create your navigation

bar in the page.

When you’re creating a list of links to serve as your navigation bar,
it’s good practice to position those links at the top or side of the page,
where visitors to your site can find them easily.

. Enter the text you want to serve as the links, separating each by press-

ing the Return or Enter key to create a paragraph return.

To format the links as an unordered list, separate each line of text that
you want to link with a <p> tag.

You can type any text you want, but the general recommendation is to
keep the main navigation links in your site very short. For example, use
a single word when possible (such as Home) instead of something longer
(such as The front page of the site).

. Create links by selecting each piece of text in turn, clicking the

Hyperlink icon in the Common Insert panel, and then selecting the
page you want to link to or entering a URL.

Essentially, you set these links as you would set any other links in your
site. (You find detailed instructions for creating a variety of different
types of links, including links to other websites and e-mail links, in
Chapter 2.)

. Drag to select the entire set of links, and then click the Unordered List

icon in the Property inspector, as shown in Figure 6-17.

A bullet point appears at the beginning of each link. If any link isn’t set
off with a separate bullet, click to delete the space between it and the
link before it, and then press Return or Enter to separate the links with a
paragraph return (which will be automatically converted into a bullet in
the unordered list).

. To add a <div> tag around a list of links (or any other content that is

already on a page), select the content and then click the Div icon in
the Common Insert panel.

The Insert Div dialog box opens.

Adding a <div> tag around the unordered list of links is helpful if you
want to add formatting, such as the background color that fills the entire
navigation row in this example.
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Figure 6-17: Formatting a collection of links as an unordered list.

. Choose Wrap Around Selection from the Insert drop-down list, as
shown in Figure 6-18.

For more precise control over where you add a new <div> tag, you can
choose options from the Insert drop-down list at the top of the Insert
Div dialog box. Choosing the Wrap Around Selection option, for exam-
ple, adds open and close <div> tags to the code before and after the
selected content, in this case, the bulleted list of links.

Insert Div =
Insert: |VWrap around sele = ~
Class: navbar - Carcel
o | .| Help
Newr CS5 Rule

Figure 6-18: Adding a <div> tag around content
to create a class style.

. Enter a name in the Class field or the ID field.

A <div> tag with the class or ID name you entered is added automati-
cally to the page surrounding the list of links.

In this example, I chose to create a class style with the name .navbar
(as shown in Figure 6-18).
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10.

11.

You can create a class or ID style to format the <div> tag that sur-
rounds your list of links. If you plan to have only one navigation bar on
the page, an ID style is a fine option. If you plan to repeat the navigation
bar in more than one place (as I did in this example by adding a naviga-
tion bar to the top and bottom of each page), create a class style so you
can use it twice on the same page. (For more about the differences
between class and ID styles, see Chapter 5.)

. At the bottom of the Insert Div dialog box, click the New CSS Rule

button.

The new CSS rule name is added to the list of style names in the CSS
Designer Selectors panel.

. In the Properties panel, specify your desired settings for color, back-

ground, size, margins, and padding.

The style formatting is automatically applied to the content of the
<div> tag because you applied the style as you created it in Steps 5-7.

To create a compound style that will format the unordered list only
when it is used in the navigation bar, create a compound style that
includes the class name .navbar:

a. Place your cursor anywhere in the bulleted list.
b. Click the plus sign (+) at the top of the Selectors panel.

c. In the Selector Name field, make sure that Dreamweaver auto-
matically entered .navbar ul as the name of a new style in the
Selectors panel.

If the name of the new style is not .navbar ul, double-click to select
the name and change it to .navbar ul. (For an explanation of how
compound styles like this work, see the sidebar “Creating com-
pound styles.”™)

d. In the Properties panel, set the margins and padding to 0.
Create a compound style to redefine the list item tags:

a. Place your cursor anywhere in the bulleted list.

b. Click the plus sign at the top of the Selectors panel.

c. In the Selector Name field, make sure that Dreamweaver auto-
matically entered .navbar ul li as the name of a new style in the
Selectors panel.

If the name of the new style is not .navbar ul li, double-click to
select the name and change it to .navbar ul li.
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d. In the Properties panel, set the Display to Inline.

This step changes the style of the <11> tag and the list of text
changes from vertical to horizontal.

e. Change the List Style Type to None to remove the bullet.
f. Set the left and right margins to 20 pixels.

This step separates the list items from one another in the horizon-
tal list. You can change the setting to create the amount of space
between links that best fits your design.

12. Create a style to redefine the link tag:
a. Click to place your cursor within a link in the navbar.
b. Click the plus sign at the top of the Selectors panel.

Dreamweaver automatically enters a compound style name:
.navbar ul li a:link

c. If you want to change the style name, double-click the name in
the Selectors panel and enter the name you want to use.

You can make compound styles as specific as you choose. For
example, the style .navbar a:1ink will change the appearance
of any links in the .navbar <div>. However, if you create the
style .navbar ul 1i a:link, that style will apply only to links
that appear in the .navbar <div> and inside the unordered list
tags. Because these are the only links | use in the .navbar <div>,
[ don’t need to be so specific; both styles will work the same in this
example.

d. In the Text section of the Properties panel, set Text-Decoration to
None.

This step removes the underline from linked text.

e. Still in the Text section, choose a color from the color well to
specify the color of links when they’re loaded on a page.

Make sure to select a color that provides good contrast with the
background color of the page so that the links are easy to read.

13. Create a new style to redefine the hover-link tag so that the link color
will change when a user rolls a cursor over the link:

a. Click the plus sign at the top of the Selectors panel.
b. In the Selector Name field, enter .navbar a:hover.

Again, [ could create a more specific compound link by entering
.navbar ul li a:hover, but it’s not necessary here.
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Comparing block and inline elements

As a general rule, HTML tags can be divided
into block elements and inline elements. Block
elements, such as the <div> tag, interrupt
the flow of the page, creating a box or block
around which other page elements align. In
HTML, block elements include the paragraph
(<p>) tag, which creates a line break before
and after it's used and doesn't allow anything
to appear alongside it. Heading tags, such as
<h1l>, <h2>, and <h3>, and list tags, such as
<ul>and <ol>, are also block elements.

In contrast, inline elements follow the flow with
text. For example, the <strong> and <em>

tags, which apply bold and italics, respectively,
are inline elements. You can place these ele-
ments one after another, and a new line break
doesn’t appear between each element. They
simply flow with the text. For that reason, the
<span> tag, which is an inline element, is a
good choice for applying styles that you want
to affect a small amount of text within a block,
such as when you want to add a little color to
text contained within <p> tags. Dreamweaver
often adds <span> tags when you apply a
class style to text in the middle of a paragraph.

c. In the Text section of the Properties panel, set Text-Decoration to

None.

This step removes the underline from linked text. If you prefer to
have the underline appear when a user rolls a cursor over a link,

select Underline.

d. Still in the Text section, choose a color from the color well to

specify the link’s color when users roll their cursor over the link.

The more dramatic the color difference between the a: 1ink and
a:hover colors, the more dramatic the rollover effect.

14. Create a new style to redefine the visited link tag so the link color
changes after a user clicks a link:

a. Click the plus sign at the top of the Selectors panel.

b. In the Selector Name field, enter .navbar a:visited.

c. In the Text section of the Properties panel, set Text-Decoration to

None.

d. Still in the Text section, choose a color from the color well to

specify the link’s color after it’s been visited.

If you want the color to remain the same, set the a:visited link
to the same color as the a:1ink.

15. Click the Live button at the top of the workspace or click the Preview
button to view the page in a browser to see the effect of the link
styles, as shown in Figure 6-19.
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Comparing Margins and Padding in CSS

When creating or editing CSS styles, new web designers are often confused
by how and when to use margins and padding. Both settings add space
between elements — for example, a margin between text and an image or a
little padding between the border of a <div> tag and its contents. Here’s how
margins and padding work:

1~ Padding adds space inside an element. Think of padding as a way to add
a cushion around the inside of a box so your content doesn’t bump into
the sides of your box.

1~ Margins add space outside an element. Think of margins as a way to add
space between boxes, on the sides of images, or around any other ele-
ment on a page, so things don’t bump into each other.

Figure 6-20 shows a <div> tag with a corresponding ID style that creates the
thin black border around the <div> tag and defines it as follows:

500 pixels wide

25 pixels of padding inside the <div> tag border

50 pixels of margin spacing outside the <div> tag border

2-pixel border around the entire <div> tag

How wide should | make my web page’s design?

For nearly a decade now, most web designers
have been setting the width of their web pages
to 960 or 960 pixels wide. That size is based on
the most common screen resolution on most
computer desks. If you want your web pages
to look good on computers with monitors set to
1024 by 768, design your pages to take up 960
to 980 pixels and you leave enough room for
the borders of a web browser. This size also

displays well on iPads and many other tablets.
However, if you want your pages to look as
good on tiny smartphone screens as they do on
large monitors, consider creating multiple style
sheets and designing your pages to work at
more than just one fixed width. In Chapter 8, you
find out how to create responsive web designs
that work on small and large screens.
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Figure 6-20: Padding is added to the inside of an element and margins are added to the
outside; both add to the width needed for an element on a page.

Here’s the confusing part:

1~ Padding adds to the specified width. If you specify a width for a <div>
tag (or any other box element) — as I have in Figure 6-20 — the pad-
ding increases the total width. In my example, the <div> tag will fill 550
pixels of space on the page: 500 pixels for the width plus 25 pixels on
each side of padding.

1~ Margins add to the total space taken up by an element in a page. The
margins of the <div> tag style are set to 50 pixels, so the <div> tag
is positioned 50 pixels from the top and left of the page and no other
element will appear on-screen closer than 50 pixels on the right or at
the bottom. Adding margin space prevents elements from bumping
up against each other, but you need to remember, that the <div> tag
will then effectively take up all that space on the page — the combined
width, plus padding, plus margins.

~ Borders add to the specified element width. The ID style for the <div>
tag also includes border settings, which cause the dark border to sur-
round the <div> tag. In this example, I created 1 2-pixel border, which
adds 4 pixels to the width. If you choose the thick border setting, it adds
4 pixels to each side of the <div> tag (8 pixels total).
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Thus the <div> tag fills a total space on the page of 654 pixels:

500 pixel width
50 pixels total of padding (25 pixels on each side)
4 pixels of border

100 pixels total of margin (50 pixels on each side)

Aligning and Centering Elements in CSS

In addition to formatting text, you can use CSS to align elements and position
them in relation to one another on a page. In this section, you find out how
to use floats to align images and other elements, how to use margin settings
to center an element, such as a <div> tag on a page, and how to use the text
alignment option to center text or other elements contained in a <div> tag.

Centering a page layout with CSS margins

Many web page designs are centered on the page so they seem to float
between the sides of the browser window no matter how wide or narrow the
window becomes. This helps create the illusion that the design fills the page,
even if the browser window is much wider than the page design.

Most web page designs created with CSS achieve this effect by creating one
<div> tag that surrounds all the page content and then applying a style to
that <div> tag that includes a style rule that centers that <div> tag. As you
discover in the following step-by-step instructions, creating a style to center
a <div> tag is not as obvious as you might imagine but is easy to implement
after you understand the technique.

Common practice is to use an ID style for the <div> tag that centers your
design, and to name it #wrapper or #container. However, you can achieve
the same effect with class styles named .container or .wrapper. I like to
name the style [ use for this purpose #container because the style contains
all the other tags and content on the page.

<P If your page isn’t already set up with a <div> tag around all your content,
here’s a tip for adding one. First click and drag to select all text, images, and
other content on the page. Then choose Insert=>Layout Objects=>Div Tag. In
the Insert Div Tag dialog box, make sure the Wrap around Selection option is
selected from the Insert drop-down list. Leave the rest of the fields blank and
click OK to add a <div> tag around all the contents of your page, and you're
ready for the steps that follow.
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When margins collapse

A little-understood rule of HTML called Margin
Collapse is not specific to CSS but does affect
how margins in CSS are displayed in a weh
browser. Margin Collapse causes top and
bottom margins between elements to overlap.
The goal of Margin Collapse is to keep elements
that appear one above the other, such as para-
graphs created with <p> tags, from display-
ing with twice as much space as you'd want
between them.

Not doubling the margins is useful with the para-
graph tag, but it can cause confusing problems
when you set margin space above and below
adjacent elements, such as <div> tags, and
the total margin space doesn’t add up the way
you'd expect. For example, suppose that you
have two <div> tags, one above the other, and
have set the bottom margin of the top <div> to
10 pixels and the top margin of the <div> below
it to 20 pixels. You'd expect those pixels to com-
bine to create 30 pixels of space between the

two <div> tags (because you'd get 30 pixels
of space if those same margins were set on the
left and right and the <div> tags were side-by-
side). However, with <div> tags stacked on top
of each other, the Margin Collapse rule causes
the margins to overlap, resulting in a space
that is equal to the larger of the two margins.
In this case, the 10-pixel and 20-pixel margins
combine to take up 20 pixels of space between
the <div> tags, not the 30 pixels of space you
might expect, because 20 pixels is the largest of
the two margins.

The exception to the Margin Collapse rule? (Of
course, there’s an exception to this rule.) If you
add a border or padding in addition to margins
between <div> tags, the Margin Collapse rule
isignored and the margin space will be the total
of the two margins, plus the padding or border
size. Inthat case, the total space created by the
margins will add up just like you might expect.

To center an entire page design, make sure that a <div> tag surrounds all of
the contents of the page, and follow these steps:

1. Click the plus sign in the CSS Designer Selectors panel.

Depending on what is on the page, a new style name or a blank field
where you can enter a style name is added to the Selectors panel.

2. Double-click to select the name that Dreamweaver added to the panel
and change it to the name you want for your new style, or click to
select the blank field and enter a name.

If no name is added, enter the name you desire in the empty field. You
can name the style anything you like, but make sure to enter a period
before the name if you create a class style, or a # sign for an ID style.
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3. In the Properties panel, specify the width, margins, and any other for-

matting settings you want to define.

As shown in Figure 6-21, | set the width for the container <div> tag to
980 pixels. Here’s the trick to centering a <div> tag like this: Set the left
and right margins to Auto. That way, a browser automatically adds an
equal amount of margin space to each side of the <div> tag, effectively
centering it on the page.
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Figure 6-21: To center a <div> tag, set the left
and right margins to Auto.

. Select the ID that surrounds all the content on the page.

To make sure you’ve selected the right <div> tag, click to place your
cursor anywhere in the main part of the page, and then click the <div>
tag listed to the farthest left in the Quick Tag Selector at the bottom of
the workspace.

. With the <div> tag selected, select the name of the style you created

from the ID drop-down list in the Property inspector.

The style rules you defined when you created the style are automatically
applied to the <div> tag. In this example, the result is that the size of
the <div> tag is changed to 980 pixels wide and the <div> tag and all
its contents are centered on the page.
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Not all features work when Dreamweaver is set to Live view. Although Live
view (activated by the Live button at the top of the workspace) is a great way
to preview how your page designs will look in most modern web browsers,
the use of the Live view feature makes many of Dreamweaver’s editing tools
unusable. If, for example, the Property inspector appears dimmed when you
want to use it, make sure that the Live button is deselected.

Aligning the contents of an element

If you want to align the contents of an element, for example, centering text
within a <div> tag, you can use the text align option. This technique is also
useful for aligning a horizontal list of navigation links to the right side of a
page. A common approach to using this option is to create an ID or a class
style that you will apply to an entire <div> tag and include the text align-
ment option as part of the style rule.

Aligning elements with floats

Designers often align an image, a <div> tag, or another element to the left
or right of a web page and then wrap any text or other content around that
element. In Figure 6-22, I've used a style to align the image to the right of the
column so that the text wraps next to it on the left. In the steps that follow,
you find out how to create styles like this one.

CSS offers many advantages when it comes to aligning elements like this, but
the way you set up these styles is not as obvious as you might expect at first
because you use the float option.

After you understand that you can float elements, such as images, to the left
or right side of a page, it’s pretty easy to create styles that accomplish this
goal. In this exercise, you learn to create two styles that are ideal for aligning
images to the left and right of a page, complete with a little margin just where
you need it.

In all my sites, I create two styles like this, one to align images and other
elements to the left, and another to align to the right. It is good practice to
define these two alignment styles using the class selector and to save them
in an external style sheet so that they can be used multiple times in any or
all pages in your site. Note: The CSS layouts included in Dreamweaver CC
already have float styles that you can use to align elements to the right and
left. These class styles are named . £1t1ft (for, you guessed it, float left)
and . fltrt (for float right).
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Figure 6-22: When you align an image to the left or right using floats, adjacent text wraps
around the image.

To create two class styles that you can use to align images and other ele-
ments to the left and right of a page, follow these steps:
1. Click the plus sign in the CSS Designer Selectors panel.

Depending on what is on the page, a new style name or a blank field
where you can enter a style name is added to the Selectors panel.

N

Double-click to select the name that Dreamweaver added to the panel
and change it to the name you want for your new style, or click to
select the blank field and enter a name.

If no name is added, enter the name you desire in the empty field. You
can name the style anything you like, but make sure to enter a period
before the name if you create a class style or a # sign for an ID style.

w

Double-click the new name and edit it as desired.

Although you can name these styles whatever you prefer, alignment
styles are commonly named with the abbreviated fltrt and fltlft, which
stand for float right and float left respectively.
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For example, if you create a style to align elements to the left, you would
name it . f1tlft.

4. In the Properties panel, click the icon that sets Float to Left, as shown
in Figure 6-23.

Froperties

m T O O [+ (] shaw Set

-

float : I%]l., [~ ]

clear
overflowe-x -
overflow-y
display
visibility
Z-indes
opacity

Figure 6-23: To define alignment in a style rule,
select the Float Left or Float Right icon.

5. Use the Margin settings in the Properties panel to create a margin
around the floated element.

It’s good practice to add margin space to the opposite side from the
float setting. For example, if you're creating a style to float an image to
the left, add 5 or 10 pixels of space to the Right margin field. Then, when
you use the style to align an image to the left side of the page, a margin
will also be created between the image and any text or other element
that wraps next to the image.

6. Select the image or other element you want to align in the page.

7. Select the name of the style you created from the Class drop-down in
the Property inspector.

The style rules you defined when you created the style are automatically
applied. If you had selected an image in a page of text, the image would
move to the left side of the page and the text would wrap around it with
a margin between the image and text.
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8. Repeat Steps 1-7, once with the float set to Right and 5 to 10 pixels of
margin space in the Left margin field in the Box category, and again
with the Float set to Left and 5 to 10 pixels of margin space in the
Right margin field in the Box category.

Editing, Renaming, and Removing Styles

After you create and apply a few styles, you're likely to want to go back and
edit some of them. Fortunately, Dreamweaver makes it easy to rename, edit,
and even remove styles, as you learn in the sections that follow.

Editing a style

You can change the attributes of any style after you create it by editing its
style definition. This is where some of the biggest advantages of Cascading
Style Sheets come into play. You can make global changes to a page (or
even to an entire website) by changing a style; when you edit the style, the
changes are applied automatically to every element that uses the style.

One of the reasons why external style sheets are so valuable is that you can
create styles that are used on any or all pages in a site. Beware, however, that
this capability can also lead to problems. If you decide to edit a style when
you use it on a new page, don’t forget that you’ll be changing the formatting
everywhere else you've already used that style.

“&N\BEH s e s .
& You can create new styles by duplicating an existing style, giving it a new
name, and then altering the style definitions. This time-saving trick is useful
when you want to create a new style that’s similar to an existing one.

To edit any existing style (whether it was created using the class, tag, or ID
selector), follow these steps:

1. Open the CSS Designer panel by choosing Window=>CSS Styles.

2. In the CSS Designer Selectors panel, select the name of an existing
style.

The style rules are displayed in the Properties panel.

<P If you want to edit a style that has already been used to format text,
images, or other content in the page open in Dreamweaver, select the
content. The name of the style applied to that content will be displayed
in the Selectors panel, making it easy to find and edit.
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3. Edit the settings for the style to your liking.

e If you edit a style in the CSS Rule Definition dialog box, changes
are applied automatically when you click the Apply button or when
you click OK.

¢ If you edit a style definition in the Properties panel, the changes
are applied automatically as soon as you press the Return or Enter
key or click outside the formatting field in the panel.

Renaming existing styles

You can rename a style in the CSS Designer Selectors panel by double-clicking
to select the name and then typing a new name.

If you change a name in the Selectors panel, you must also change the name
in the corresponding page code, or reapply the style using the Property
inspector — which can get complicated if you've used the style in many
places.

For example, let’s say you create a class style and name it #footer. You then
apply the style to the <div> tag that surrounds the content at the bottom of
your web page using the Property inspector (as I did in the first exercises in
this chapter). Then suppose you decide to change the name of the style to
#copyright because you want to add another <div> that you'll use as the
footer later. Changing the name from #footer to #copyright in the CSS
Designer Selectors panel is easy enough, but then you have to make sure to
update every place you've used that style in your site — either by reapplying
the style using the Property inspector or by changing the name in the code
wherever the style has been applied.

If you want to change the name of a class style, Dreamweaver includes a fea-
ture that updates the corresponding code automatically, but only for class
styles and only if you change the name using the right-click (or Control-click)
option described in the instructions that follow. If you change the name of an
ID style, you must reset the style using the Property inspector, or change the
corresponding references in the code manually using Code view or the Quick
Tag Editor.

Removing or changing a style

If you want to remove or change a style applied to any text, image, or other
element on your page, here are two options:

1~ Select the text, image, or other element. Then open the Class or ID drop-
down lists in the Property inspector and choose None from the top of
the list of styles.
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1~ Select the element, and then right-click (Control-click on a Mac) the
tag that the style is applied to in the tag selector at the very bottom
of the workspace (just above the Properties inspector), as shown in
Figure 6-24. When you right-click the name of a tag in the tag selector,
a list opens with many options; choose the corresponding option for the
selected style. In the example shown in Figure 6-24, I selected the <p>
tag that surrounds the first paragraph and chose the Set Class option to
open a list of all class styles in the site. To change or remove a style this
way, simply select the style you want and it will replace any style that
has already been applied.

For a list of more advanced CSS training resources online and offline, visit
www.DigitalFamily.com/css and look for the article titled “Where to
learn more advanced CSS techniques.”
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Figure 6-24: Right-click the element name in the tag selector to change or remove any style
or HTML tag.
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Designing with CSS3

In This Chapter

Comparing browser support for CSS3
Adding text and drop shadows
Making rounded corners

Using almost any font you want

Wlen most designers learn about the new features in CSS3, including
drop shadows, gradients, and vastly improved font support, their reac-

tion is: “It’s about time!” These long-awaited design improvements provide a
compelling reason to graduate to using CSS3 right away, even though older
web browsers won'’t display all of these fancy new features. The good news is
that if a browser doesn’t support a new CSS rule, such as rounded corners, it
simply ignores the style information. Visitors with older browsers

may see square corners on the borders of your <div> tags e ‘
instead of rounded ones, or common fonts such as Times .| [ wwaw.google.comywebfonts#Quicy
or Arial in place of the more obscure fonts you may

prefer to use in your page designs. J()Ugle web fonts @

[ recommend you start using CSS3 style rules even if
some of your visitors can’t see them because CSS3
is clearly the wave of the future. As people update
their web browsers and new computers replace

old ones, CSS3 will become increasingly well sup- stondard | @import | Javascriot
ported. So why wait? Your most savvy visitors will 3. Add this code to your website:
appreciate the design enhancements and faster
download time today, and everyone else will come
around before too long.

<link href='http:/ffonts.googleapis.confcss?fa

(11
That said, you may not want to add every new CSS3 feature .
to your pages right away (some are better supported than others,
even in the latest browsers). In this chapter, | introduce the most popular
CSS3 features, including adding drop shadows to text and images, creating
rounded corners on <div> tags, and using almost any font you want.
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Comparing Browser Support for CSS3

To help you appreciate how a page designed with CSS3 looks in different web
browsers, | used the latest version of Google Chrome to preview the page
shown in Figure 7-1 and then used Design view in Dreamweaver to preview
the same page in Figure 7-2. Note that Figure 7-1 shows a custom font, drop
shadows, and rounded corners created using new properties available in
CSS3 — Google Chrome is well known for its excellent support of CSS3. In
contrast, Figure 7-2 shows how the page looks in an older web browser that
does not support CSS3 rules, such as Internet Explorer version 6.0. Many web
designers agree that it’s okay to create web pages that don’t look the same in
all browsers, as long as the text is still readable by all your visitors.

Gaudi Park Guell Casa Batlle Casa Milo

Antonio Gaudi
Artist & Architect

Antonio Gaudi

The woices of Barcelona blur in a mix
of Spanish and Catalan in much the
way Gaudi's wark blurs the lines
between architecture and artwork.

From the tiled benches in Guell Park
to the towers over Casa Mila and
Casa Battla, | fell in love with Goudi's
wark on my first trip to Barcelona.

PGI'I( GLIG”

The benches as Lizard fountain in
Park Guell make up part of the
UNESCO Warld Heritage Site know
as, "The Works of Antonio Gaudi."

The park features Gaudi's farmous
Lizard Fountain, as well as benches
and other extraordinary examples of
Gaudi's talent with tiles
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Photo by Charlie Simpson

Figure 7-1: Google Chrome displays all CSS3 features used in this design.
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Figure 7-2: Design view in Dreamweaver displays the page like an old web browser, without

the custom fonts, drop shadows, and other CSS3 features.

To get a better idea of how your pages will look in Dreamweaver, click the
Live view icon at the top of the workspace. When you display a page using
the Live view option, Dreamweaver works much like the Google Chrome and

Apple Safari web browsers.

In Chapters 5 and 6, I cover the basics of CSS. If you're new to working with
style sheets, | recommend that you start with the basics in those chapters
before moving on to the more advanced CSS3 features covered in this chap-
ter. In Chapter 4, you find more tips and resources for testing your web pages

in different web browsers.
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Why so many ways to write CSS3 code?

The World Wide Web Consortium (W3C) is con-
tinually working on CSS and HTML standards.
Because approval of new tags and rules can
take years, many browser companies start
implementing new features before they are
officially approved. When they use a specifi-
cation that isn’t fully approved, browser com-
panies add a special prefix to the new rules to
distinguish them from other code that has been
approved. As a result, you sometimes need to
include different versions of the same style
rules in your code if you want your styles to
work in all the most popular web browsers.

For example, the following code creates a
rounded corner using CSS3. The three lines of
code do the same thing — they set the radius
to 10 pixels. The first line is written for Safari,
the second for Firefox, and the third follows the
currently proposed W3C specification, which

is already supported by a growing number of
browsers. (Note thatin CSS, comments are sur-
rounded by /* */ in the code and the text in
the comments is not required.)

-webkit-border-radius: 10px; /* Safari 3
and 4 */

-moz-border-radius: 10px; /* Firefox 1+ */

border-radius: 10px; /* Internet Explorer
9, safari 5, Chrome */

Some designers shy away from using code until
it's approved, preferring to wait until the stan-
dards are official because the specifications
might change. However, CSS degrades grace-
fully in browsers (a fancy way of saying that if
the browser doesn't support a new CSS rule, it's
ignored), and CSS3 offers so many exciting new
features and so few negative side effects — if
you design your pages carefully —that many of
us agree there is no reason to hold back.

Adding drop and text shadow's

You can enhance your designs and give your pages greater depth by adding
drop shadows to images, <div> tags, and other elements. Adding text shad-
ows makes your words easier to read, especially if your design has a com-
plex background or the foreground and background colors lack contrast, as
shown in Figure 7-3.

Dreamweaver CC provides better support and integration of CSS3 drop
shadows and text shadows from the new CSS Designer panel, covered in this
section.

You can create class or ID styles with text shadows, and you can add text
shadows to existing HTML elements by defining a tag style, such as the head-
ing 1 style [ used in Figure 7-3. The CSS3 code that creates that text shadow is

hl {text-shadow: 2px 2px 2px #000;}



Chapter 7: Designing with CSS3 27 ’

Gaudi
Park Guell
Casa Batlls

Casa Mila

~ Antonio Gaudi
(1St & Architect

3

Photo by iStockphoto.com
Figure 7-3: Text shadows make text more readable, especially
when the text overlaps a background image.

The numbers in the code specify that the text shadow should extend 2 pixels
to the right and 2 pixels below the text with a 2-pixel blur. In addition, the
shadow is created with the color black, specified by the abbreviated hexa-
decimal color code #000.

When creating rules for text shadows you can specify up to four values:

» horizontal and vertical: The first two number values are required
and specify the horizontal and vertical offsets — the distance the drop
shadow extends below the text (vertical) and to the right of the text
(horizontal).

» blur radius: The third value specifies the amount of blur in the
shadow. If you don’t include blur radius, the default is 0, which
makes the shadow appear as a solid color.

1 color: The fourth value specifies the color of the shadow and can be
defined using a hexadecimal color code or an RGBa color code.
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Choosing an RGBa color for the Color option gives you greater control over
the shadow’s appearance because you can add transparency.

You can add a text shadow using the Properties panel at the bottom of the
CSS Designer panel, as shown in Figure 7-4. To do so, follow these steps:

1. Scroll down to the Text-Shadow section of the CSS Designer Properties
panel.

2. Enter the size of the shadow you want to display using the H-shadow
(horizontal) and V-shadow (vertical) fields.

3. Add the amount of blur you want for your text shadow by entering a
size in the Blur field.

4. Click the color well and select the color your want to use in the text
shadow.

wm T O™ - [] Show Set
Antonio Gaudi N 5
Artist & Architect e
blur : 2 px

11

color : |IM #000

Figure 7-4: You can add drop shadows to images, <div> tags,
and other elements using CSS3.

Adding drop shadows to images and divs

In addition to text shadows, CSS3 gives you the power to add shadows to
images, boxes created using <div> tags, and other elements. In Figure 7-5,
for example, I'm using the CSS Designer panel to define a rule that adds a
drop shadow to all images on this page.
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13

Figure 7-5: Add drop shadows to images, <div> tags, and
more by adding a box-shadow rule.
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Style rules that are part of the CSS3 definition, such as drop shadows, are visi-
ble in Dreamweaver only when you select the Live view option. In Figure 7-5,
the cursor is over the Live button, changing the display area from regular
Design view to Live view so that the drop shadows are visible.

The following style adds a drop shadow to all images on a page:
img {box-shadow: 3px 3px 3px 3px #000;}

Much like the text shadow covered in the preceding section, the first two
values specify how much the shadow extends on the x- and y-axis. The third
value describes the amount of blur. The box-shadow rule includes a fourth
setting that specifies the spread radius of the shadow. At the end of the list,
the hexadecimal color code defines the color of the shadow.

Again, much like the text-shadow rule, you can use the Properties panel
in the CSS Designer panel to define a box-shadow rule. Scroll down to the
box-shadow section, and then fill in each of the definition options shown in
Figure 7-5.

By default, drop shadows using the box-shadow rule in CSS3 appear to the
right and below any element to which they are applied. However, you can
specify that the shadow be inset instead of outset by clicking the correspond-
ing icon at the bottom of the box shadow settings, shown in Figure 7-5.

Softening Edges with Rounded Corners

Another popular CSS3 rule, border-radius, enables you to add rounded
corners to the borders of <div> tags and other box elements. Using CSS3,
you can specify how much corners are rounded, and you can apply the style
to any or all corners of an element.

In Figure 7-6, you see a <div> tag with a border and a colored background,
as well as the border-radius style rule applied to the top-left and bottom-
right corners.

You can use the new rem measurement to design rounded corners that

scale with the size of the text. The rem measurement is a popular choice
among designers who value creating pages that look good on small and large
screens and for designs that adapt gracefully when a visitor to a site chooses
to increase the text size to make a page more readable. For more on the rem
and other sizes in CSS, see Chapter 5.
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Rounded Corners
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Figure 7-6: The radius of the rounded corner.

Enhancing Vour Site with Custom Fonts

The few fonts that come installed on most Windows and Mac computers are
woefully inadequate. Serious designers spend hours searching for just the
right font to convey the feeling they want to elicit in a design, which is why so
many of us are excited that CSS3 offers a better solution.

The @font-face option, new in CSS3, enables you to link to any font avail-
able from a web server. Add a little drop shadow and other styling elements
with CSS3, and you can create fantastic font effects without resorting to the
old workaround: using images with styled text created in Photoshop. The @
font-face rule offers many advantages because using text instead of images
on your pages means they load faster and are easier to update.

Using text with the @font-face rule instead of text in an image offers many
advantages, including the following:
1~ Text loads more quickly than images.

1~ Text formatted with HTML and CSS is easier to update than text in an
image.

+ Including keywords in text on a page instead of hiding them in images
can improve your search engine rank.
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1~ Using text in place of images makes your web pages more accessible
to anyone with a disability who uses a screen reader or other special
browser.

1 Text is selectable and resizable.

How does the @font-face rule work?

Using the @font-face rule requires just two steps. First, you use the @
font-face rule to link to a font hosted on a web server. Then, you use that
font in the font-family property in your CSS rule. And finally, you use that
rule to format some or all of the text in your web page.

Armed with those basic instructions, it’s tempting to assume that you can
just upload any font on your hard drive to your web server and link to it with
the @font-face rule. Unfortunately, like so many things on the web, hosting
and using fonts in web pages are more complicated than they should be. For
example, even if you have the rights to host a font on your server, you may
not have all the variations of that font needed to display the letters properly
on Mac and Windows computers or to work in all web browsers.

The solution? Most of us use a font service, such as the following:

1+~ Font Squirrel (www . fontsquirrel . com): Font Squirrel features a col-
lection of free fonts in font kits. You have to download the kits and then
upload and host them on your own server, but the price is right — free.
Font Squirrel also provides a font generator that you can use to create the
four font types you need to support the most popular web browsers. This
service is useful if you have the rights to a font and want to host it yourself.

1 Google Web Fonts (www.google.com/webfonts): The easiest site to
use (as you see in the step-by-step instructions that follow), Google Web
Fonts offers a limited collection of fonts but you can use all their fonts
for free.

v Typekit (www . typekit.com): Adobe Typekit offers a wide range of
high-quality fonts and is the clear choice of many professional design-
ers. You can try this service for free, but if you get much traffic, want to
use all their fonts, or want to use fonts on more than one website, you’ll
have to pay a monthly subscription fee.

These popular services take different approaches to making fonts available to
web designers. Font Squirrel lets you download fonts that you can then upload
to your own web server. (They manage the rights and font options for you.)
Google Web Fonts makes it easy to link to fonts hosted on their server. Typekit
follows a more complicated approach to protect the copyright of font holders.


http://www.fontsquirrel.com
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Much of the confusion among web designers about using the @font-face
rule stems from the fact that the most popular font services take such differ-
ent approaches to managing and using web fonts.

No matter which service you use, the basic concept is the same, but as you
go through the exercise that follows, keep in mind that how you use a web
font depends on the service that hosts the font.

Using custom fonts from the Google Web Fonts site

Follow these steps to add any of the fonts from the Google Web Fonts site to
your pages:
1. Open a web browser and visit www.google.com/webfonts.

2. Search through the fonts available on the site by selecting the type
and style of font you’re looking for, as shown in Figure 7-7.

To narrow your search, use Filters (in the left column). You can change
the text that is displayed in each font by editing the Preview Text field
at the top of the screen.

H Google Web Fonts  x \_

€ - C [ wwwgoogle.com/webfonts = @ e
GOLnge web fonts E«; Mare scripts (sxperimental) About Analytics New to Google Web Fonts?
Word Sertence Paragraph Poster @ Bookmark your Collection % Download your Collection
Showing
622 Preview Text: | Grumpy wizards make tofd]  Size: | 28|+ [pc  Sorting: | Trending |

[Enter yourowntex] gy
font families Font Name
Homsiaon  Grumpy wizards make

The quick brown fox
grum AaBbCCDIERFGyHhIL

Search:

«ake toxic brew for the evil Queen and

Filters: Gabriela, 1 Style by Eduarde Tunni 3 Quickuse [ Pop out

Al categories -

Thickness
Normal 400

Grumpy wizards make toxic brew for the evil Queen and

Slant
Width

B Reset al fters/cearch Merriweather Sans, 4 Styles by Eben Sorkin See all styles (3 Quickuse g Pop out

Script:

Latin -
Normal 400

Styles: Grumpy wizards make toxic brew for the evil Queen and

Show all styles

Sintony, 2 Styles by Eduardo Rodhiguez Tunni See allstyles (3] Quick-use (B Pop out

0 font families in your Collection 2

Figure 7-7: Search the Google Web Fonts collection of free fonts for
your web pages.
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3. Find a font you like, and then click the blue Add to Collection button
in the bottom-right, just below each font name.

4. Click the check boxes next to each of the font styles that you want to
use on your web page.

Most fonts in the Google Font Directory have only one style. Although
you may be tempted to choose all styles, it’s best to select only the ones
you'll use. As Google warns, the more font styles you choose, the longer
it will take to download your web page.

5. Scroll down the page and select the Latin option (for English).

If you need the additional characters for another language, select the
Latin Extended option instead.

6. Scroll further down the page to the blue box with three tabs; click the
first tab to link the font to your website.

Google provides three options: Standard, @import, and JavaScript, as
shown in Figure 7-8. You find detailed descriptions of all three on the
Google site.

B Google Web Fonts % L) SIE] % ]
<« C | [) www.google.com/webfonts#QuickUsePl ace:quickUse/Family: Skranji w @S E =

G()Ugle web fonts @l More scripts (sxperimental) About Analytics New to Google Web Fonts?

he
inthe <head> of your HTML

» See an example

Instructions: Add the font name to your
youd do normally with

4. Integrate the fonts into your CSS:

i

The Google Web Fonts AP will generate the
to do is add the font name to your CSS styles

browser-specific CSS to use the fonts. Al you need
gl

DL { font-family: ‘Metrophobic',
Arial, serif: 00;

font-family: 'Skranii', cursive: font-weight: 4

Quick use: Skranji

Figure 7-8: Copy a snippet of code from the Google Web Fonts site to
link to each font.
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\\3

10.

11.

12.

. Copy the link from the Standard tab field on Google just as you would

copy any other text or code from a web page.

. In Dreamweaver, paste the link into the head area of your web page

between the open <head> and close </head> tags.

. Return to the Google Web Fonts site and at the bottom of the page,

copy the name of the font family.

You can find the name of the font family in the Integrate the Fonts into
Your CSS area.

In your style definition, you must include the name of the font exactly as
Google writes it. I find that copy-and-paste is the best way to make sure
the font name matches.

In Dreamweaver, paste the name of the font family into the CSS rule
where you want to use the font.

Apply the rule to text in your web page.

If you use the font in a Tag selector style, such as the <h1> tag, when
you apply the tag to text, the font will be automatically applied as part
of the rule. If you use the font in a class or ID style, the style must then
be applied to a tag that surrounds the text, such as a <p> tag or a <div>
tag. You discover more about class, ID, and tag styles in Chapter 5.

Publish the page to a web server and then preview the page in a web
browser to see the font.

Note that when you use Google Web Fonts you may not see the font dis-
played in Dreamweaver, even if you use the Live view option. To ensure
that the font works on your page, you may need to transfer the page to

a web server using FTP and preview the page after it’s published online.
You find out more about using Dreamweaver’s FTP features in Chapter 4.



Creating Responsive Designs with
Fluid Grid Layouts

In This Chapter

Future-proofing your site with responsive design
Comparing responsive and adaptive sites
Using Dreamweaver’s fluid grid layouts

Targeting style sheets with media queries

rle biggest challenge of web design today is that your pages are as likely
to be projected on a giant computer monitor as on a tiny cell phone
screen. As a result, creating websites that look good to all visitors is

more complex — and more important — than ever.

When people first started using mobile phones to con-
nect to websites, many of us created special versions
of our sites specifically optimized to work only on
small mobile devices. Today, some sites still use

this approach, creating one simple mobile site

that works in parallel to the main website, but two
other approaches to designing for small and large
screens are available — adaptive and responsive
design.

ark Guell

he benches as
izard fountain in
ark Guell make up ‘ ;
art of the 94

Adaptive design was developed to meet the diverse
needs of a growing number of cell phones with dif-
ferent capabilities and screen sizes. Adaptive design
requires that you create many different versions of each

web page, use complicated programming to detect each

device that visits the site, and deliver a version of each page opti-

mized for the specific size and features of that cell phone visitor. Adaptive
design is complicated, expensive, and generally used only by large, well-
financed websites.
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Fortunately, a new, simpler approach called responsive design is quickly
gaining popularity. With responsive design, you create one web page and then
use multiple sets of CSS rules to change the format and layout based on the
size of the browser window.

Following are two big advantages to responsive design over adaptive design:

1~ Responsive designs are based on screen size, not device capabilities.
Adaptive design requires that you maintain a complex database of the
mobile devices in use on the web, including the screen size and capabili-
ties. Such databases are expensive to create or purchase, and they must
be updated every time a new phone or device comes on the market.
Responsive designs are adjusted based on the size of a browser window,
so it doesn’t matter what type of mobile device your visitor users.

1~ Adaptive design requires complex programming on the server. An
adaptive website requires complex programming — and advanced pro-
gramming skills — to assemble a web page to match the size and capa-
bilities of each device. Responsive design is accomplished with HTML
and CSS, and all adjustments to the page design are done in the web
browser, so there is no need for complex programming on the server.

Understanding Responsive Web Design

The best way to understand how responsive design works is to visit a web-
site designed with this approach, such as the Antonio Gaudi site shown

in Figure 8-2, which is available on my website at www.digitalfamily.
com/g. With the Gaudi website open on your computer, drag the right edge
of the browser window from right to left, slowly making the browser window
smaller, and you’ll see how the page design changes automatically as the
browser window becomes smaller.

Responsive designs are created by combining one well-crafted HTML page
with multiple sets of CSS styles, and then using media queries to target each
set of styles. Media queries are CSS rules that inform a web browser about
which set of styles should be applied to the page when the browser window
is within a specified size. Essentially, media queries cause the styles applied
to a page to change based on the width of the browser window.

When you create responsive designs using the fluid grid layout features cov-
ered in this chapter, Dreamweaver generates three sets of styles and corre-
sponding media queries:


http://www.digitalfamily.com/g
http://www.digitalfamily.com/g

Chapter 8: Creating Responsive Designs with Fluid Grid Layouts

1~ Mobile layout: Targets CSS rules that apply when the browser window
is 480 pixels and below.

~ Tablet layout: Targets CSS rules that apply when the browser window
is 481 to 768 pixels. This layout inherits all styles from the mobile layout
and adds styles that apply to the page only when the browser window is
in the tablet size range.

1~ Desktop layout: Targets CSS rules that apply when the browser window
is 769 to 1232 pixels. This layout inherits all styles from the mobile and
tablet layouts and adds styles that apply to the page only when the
browser window is in the desktop size range.

As you design your fluid grid layouts, remember that you are not creating
three completely different web pages. Instead, you're creating one HTML

file that can respond and adjust to fit each of the target screen sizes defined
in the media queries. That means you need to position all <div> tags and
other elements in your HTML document in a way that they can be reduced,
enlarged, and rearranged to work in all three of the layouts you create. As a
result, one of the biggest complexities as you develop responsive designs is
coming up with a basic page structure that lends itself to working on all three
screen sizes.

In the step-by-step exercises that follow, you create your own fluid grid
layout and design three sets of styles. Before you do, however, look at the
design in Figures 8-1 and 8-2. In Figure 8-1, you see how the same boxes, cre-
ated using the same <div> tags or HTML5 elements, are rearranged to create
the three layouts shown in Figure 8-2.

As you study these designs, consider that only one HTML page is used to create
all three page layouts and that this design follows common best practices:

+~ The mobile version: The smallest version is designed as a single-column
layout, with each box stacked one on top of the other.

~ The tablet version: The midsized version is designed with narrow col-
umns arranged side by side.

1~ The desktop version: The largest version is designed with wide col-
umns, and the images within those columns are aligned so that the text
wraps around each image.

Creating responsive designs requires some planning, and often some trial
and error. However, your reward will be that you create an efficient web
design, meaning you have only one page of content you need to update, yet
that one page looks good on virtually every device anyone may use to visit
your website.
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Figure 8-1: Responsive design makes it possible to turn one HTML document
into three layouts.
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Figure 8-2: This design was created from the HTML layout featured in Figure 8-1.
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Creating mobile websites versus native apps

Many designers are confused by the difference
between a mobile website and an application
and why you should create one or the other.
Here's a quick look at the differences.

Native apps are programs that you download
from the iTunes or Android app stores. Native
apps are programs designed to work on spe-
cific mobile devices, such as iPhones, iPads,
and any of the many tablets and phones that
use Android, Windows Mobile, or other mobile
operating systems.

Mobile websites, in contrast, are similar to other
websites in that you view them in a web browser
while you're connected to the Internet. What
makes a mobile website different than other web-
sites is that it is carefully designed to look good,
and be easily usable, on small mobile screens.

In general, creating a native app is far more
expensive than creating a mobile website for
several reasons, most notably that you have to
create different versions of each native app —
one for iPhones, another for iPads, another for
devices that use Android software, another
for Windows Mobile, yet another Blackberry
devices, and so on.

In contrast, if you design the mobile version of
your website using the responsive design strat-
egy covered in this chapter, you create just one
version of each page, and then design it to work
on all mobile devices, no matter what operating
software they use.

So why does anyone create a native app instead
of a responsive website? Apps enable you to
create more complex programs and they are
the best option when you're creating a highly
interactive game, such as Angry Birds. But
many developers are realizing that apps have
been overhyped by Apple’s “there’s an app for
that” advertising campaign. A growing number
of companies that designed native apps for the
mobile audience are now shifting their focus
and creating mobile websites instead.

| recommend that you create a native app only if
you have a compelling reason, such as the cre-
ation of a video game. For everyone else, your
goal should be to make sure your website works
well on small and large screens, and that s best
done today by taking the responsive approach
to creating websites, covered in this chapter.

Although you can create many kinds of designs, using different combinations
of columns, the basic structure of any responsive site follows this example:
The <div> tags and other elements have to be positioned on the page in
such a way that you can use only CSS to rearrange them to be displayed well
at each size (for mobile phones, tablets, and desktops).

WMBER
\g&
&

Designing Pages with Fluid Grid Layouts

Recognizing the growing popularity of responsive web design, Adobe added
a new feature set to Dreamweaver CS6, and improved it in version CC. The
fluid grid layout features, which are available from the File menu and the New
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Document window, make it easier to create multiple page layouts simultane-
ously by automatically generating three sets of CSS styles and their corre-
sponding media queries when you create a new web page.

Creating a new fluid grid layout

Before you dive into creating a design as complicated as the one shown in
Figures 8-1 and 8-2, consider trying a simpler design such as the one featured
in this series of tutorials. These tutorials are designed to be followed one
after another. Combined, they complete the process of designing one fluid
grid layout. I've broken the steps down into sections to make it easier for you
to understand how the files in each of these layouts work together.

Start by creating a simple, one-column fluid grid layout, following these
instructions.
1. Choose File=>New.

The New Document window opens. Note: Make sure you have com-
pleted the site setup process covered in Chapter 2 before you start
working on a new fluid grid layout.

2. From the left side of the screen, select Fluid Grid Layout.

The New Document window options change to the fluid grid options
shown in Figure 8-3.

New Document =
D Blank Page
Mobile Tablet Desktop
Ly P i Loyeut 480px 768px 1232p%
[ Page from Template
[ Mobie Starters B
8 12
e N
% 25 9% of column width - —_ =t
91 93 S0
Dreamweaver FLid Grid Layouts is a system for designing adaptive DocType: |[HTMLS M
webstes. It contains 3 layouts and typography presets, al based on a NG -
single fLid grid.
——— Attach CSS fle: =
Reset To Default
e =

Figure 8-3: The fluid grid layout options as they appear in the
New Document window.
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10.

. Specify the number of columns you want in each of the three layouts.

To add or remove columns, select the text field over each column in turn
and enter the number of columns you want. In Figure 8-3, I've selected
the text field for the mobile layout, which is set to 4 columns by default.

. Specify the percentage of the browser window you want each layout

to cover.

Select the text field below each layout in turn and enter a number repre-
senting the percentage of space you want the layout to cover when the
design is viewed in a browser window. For example, by default the desk-
top layout is set to take up 90 percent of the available space, but you
could change it to 95 percent to give yourself a little more design space
and reduce the margin space on each side of the layout.

. Change the percent of column width to alter the amount of margin

space between each column.

By default, Dreamweaver sets each margin to take up 25 percent of the
available space.

. Use the drop-down list to specify a doctype.

By default, fluid grid layouts are created using the HTML5 doctype.
Unless you need to change the doctype to be more compatible with
other formatting used in your website, HMTL5 is the recommended
option for responsive web designs.

. Click Create.

The Save As dialog opens ready to save a CSS file.

. Enter a name for your CSS file and click Save.

A new HTML file opens in the Dreamweaver workspace, but is not yet
saved. The CSS file you named is saved and its name becomes visible in
the Files panel.

Note: Unlike the process of creating other types of pages in Dreamweaver,
the CSS file is saved first and the HTML file is saved in a later step.

. Choose File~>Save

The Save As dialog box opens.
Enter a name for your HTML file, and click OK.

The Save As dialog box closes and a notice appears in Dreamweaver
informing you that your fluid grid layout requires two additional files:
boilerplate.css and respond.min.js.



Chapter 8: Creating Responsive Designs with Fluid Grid Layouts 2 2 7

11. Click OK to copy the boilerplate.css and respond.min js files to your
site folder.

All three files are added to the Files panel and you return to your newly
named HTML file open in the Dreamweaver workspace, as shown in
Figure 8-4.

12. Give the page a title by entering text in the Title field at the top of the
workspace.

And that completes the process of creating a new set of files for your fluid
grid layout. Continue through the rest of the exercises in this chapter to add
content and format your designs.
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Figure 8-4: When you create and save a new fluid grid layout, four files are saved and added
to the Files panel.
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Adding fluid elements to a layout

After you create a fluid grid layout, the next step is to add <div> tags or
other elements to make up the sections of the design. You have two options
when you design pages in Dreamweaver CC: use <div> tags or use HTML5
tags. Both work similarly in these fluid layouts, but using HTML5 tags, such
as the <header> and <footer> tags, has some advantage, because the tags
add additional meaning and structure to your web page.

To add <div> tags, HTMLS5 tags, and other elements to a fluid grid layout,
follow these instructions:
1. Choose Insert=>Structurec>Navigation.
Alternatively, you can click Navigation in the Structure Insert panel.

. Select the Insert as Fluid Element check box in the Insert dialog box,
as shown in Figure 8-5.

When you use the fluid grid layout features, you must select this option
when you add tags.
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Figure 8-5: You must select the Insert as Fluid Element
check box when you insert tags in a fluid grid layout.

. In the Insert dialog box, select whether you want to use the class or
ID selector to create a new style for the tag you’re inserting and then
enter a name for the new style.
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Even when you insert HTML5 tags, you must create a corresponding class
or ID style that can be used to format the element in all three layouts.

Class style names must begin with a dot (.) and ID style names must
begin with the pound sign (#).

. Click OK.

The tag is added to the layout, forming a new box in the layout, and the
corresponding style name is added three times to the CSS layout.

. Select the initial <div> tag that was included in the layout and then

click the small trash can icon that appears at the bottom right of the
<div> tag to delete it.

Although you can keep the initial <div> tag included in fluid grid lay-
outs, or you can rename the style applied to it, I find it simplest to just
delete it and add my own elements and styles.

. Choose Insert=>Structure->Article.

The Insert Article dialog box opens (similar to the Insert Header dialog
box; refer to Figure 8-5).

7. Select the Insert as Fluid Element check box in the Insert dialog box.

8. In the Insert dialog box, select whether you want to use the class or ID

10.

selector to create a new style for the tag you are inserting and enter a
name for the new style.

. Click OK.

The tag is added to the layout, forming a new box in the layout, and the
corresponding style name is added three times to the CSS layout.

Add as many elements as you want for your layout by repeating
Steps 6-9.

I added five HTML5 elements to my fluid grid layout by clicking their
corresponding icons in the Structure Insert panel: one navigation, one
header, two articles, and one footer, as shown in Figure 8-6.

Note that in the code, as shown in Figure 8-6, Dreamweaver adds the
prefix fluid- to the name of each style you create for your fluid grid
layouts.
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Figure 8-6: A series of HTMLS5 tags has been inserted into the page to make up the basic
structure of a fluid grid layout.

Positioning elements to create three layouts

in one fluid grid

What makes fluid grid layouts so powerful is that you can change the posi-
tion and size of elements so that they are arranged differently for each of
the three layouts, creating designs that are optimized for mobile, tablet,
and desktop screens. To change an element’s width or position, you use
Dreamweaver’s visual tools.

Editing the mobile layout

Dreamweaver sets up the styles in such a way that they cascade through
each of the three layouts. That means you should get the mobile design the
way you want it first. Then move on to the tablet layout and change only the
elements that you want to appear differently on the tablet. Finally, view the
page as it will appear on a desktop computer and, again, change only the ele-
ments that you want to be displayed differently in the largest version.
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To edit the mobile layout, follow these instructions.

1. Select the Mobile Size option at the bottom of the workspace, as

shown in Figure 8-7.

The workspace area changes to display the page in the mobile preview,
formatted with the corresponding set of styles.

Note: The three small icons at the bottom right of the workspace pro-
vide access to the mobile, tablet, and desktop previews. When you
switch from one to the other, you change not only the size of the display
area but also the corresponding set of styles applied to your page.

w W W 577 x 457+
Mobile size (480 x 8003_]

Tite

Target M

Figure 8-7: These three small icons
provide access to the Mobile, Tablet,
and Desktop View options.

. Add text and images to the elements in your fluid grid layout just as

you would add content to any other page in Dreamweaver.

You can copy and paste text as well as apply HTML tags and CSS format-
ting following the instructions in the earlier chapters of this book.

. Select an element in the design area.

The corresponding CSS style is displayed in the Selectors panel, where
you can edit it. In this example, I selected the header.

. Create, edit, and apply styles to text and images as you would in any

other page design in Dreamweaver.

I specified a height for the header and added a background image, as
shown in Figure 8-8.

After you have finished working on the mobile design, move on to the
next lesson to edit the tablet design. Note that you can always come
back and edit the mobile design further by clicking the Mobile icon at
the bottom right of the Document window.

Styles that you want to apply to all three layouts should be created
when the mobile layout is selected because these styles will apply to all
three designs unless overridden by another style created in the tablet or
desktop layouts.
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Figure 8-8: Fluid grid layouts work best when you design the mobile

version first.

Editing the tablet layout

After you get the mobile layout the way you want it, move on to the tablet

size layout and edit the styles that apply to that layout.

To edit the tablet layout, follow these instructions.

1. Select the Tablet Size option, at the bottom right of the workspace.

The workspace area changes to display the page in the tablet preview,

formatted with the corresponding set of styles.

2. Select an element that you want to change into a column and use the
handles on the right side to drag the column to the desired width.

Dreamweaver provides a collection of visual editing tools that make it
easier to adjust the size and positioning of fluid grid elements, such as

the column I'm creating in Figure 8-9.

If you drag the handle of any fluid grid element from left to right, you
add margin space that forces the element to stay to the right of the
layout. If you drag a handle from right to left, you resize the element, as
I'm doing in Figure 8-9.
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Figure 8-9: Drag the handles on any fluid grid element to
resize it.

3. Select a resized element that you want to reposition, and then click
the Move Up a Row arrow (labeled in Figure 8-9).

The element moves up and aligns itself next to the element above it, as
you see in Figure 8-10. In this example, I created two columns by first
reducing the width of each element by half (using the drag features cov-
ered in Step 2), and then using the Move Up a Row arrow on the second
element to bring it up to the right of the first element.
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Figure 8-10: Use the Move Up a Row/Starts New Row arrows
to create multiple column designs.
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4. To move an element down, click the Starts New Row arrow (labeled in
Figure 8-9).

In Figure 8-10 my cursor is hovering over the Starts New Row arrow,
which would reverse the action I took in Step 3.

Note: Click each of the four icons labeled in Figure 8-9 to hide an ele-
ment, move it up or down, duplicate or delete it.

When you use the visual tools covered in Steps 2—4 to resize and reposition
elements, Dreamweaver adds corresponding style definitions to the CSS, but
only for the set of styles that affect the Tablet design. As you see in the desk-
top exercise that follows, the columns that I created for the tablet layout will
not affect the desktop layout.

Editing the desktop layout

After you get the mobile and tablet layouts the way you want them, move on
to the desktop size layout and edit the styles that apply to the largest of the
three layouts.

To edit the desktop layout, follow these instructions.

1. Select the Desktop Size option at the bottom right of the workspace.

The workspace area changes to display the page in the desktop preview,
formatted with the corresponding set of styles.

2. Select a Swap arrow in the middle of any two elements to switch the
positions of the two elements.

In Figure 8-11, the Articlel and Article2 elements can be swapped by
simply clicking the Swap arrow between them.

Park Guell

iThe benches as Lizard fountain in Park Guell make up part of the UNESCO World '
Heritage Site know as, "The Works of Antonio Gaudi."

iThe park features Gaudi's famous Lizard Fountain, as well as benches and other
iextraordinary examples of Gaudi's talent with tiles.

[ Swap ARTICLE articlel with ARTICLE article2 |

lAntonio Gaudi

[The voices of Barcelona blur in a mix of Spanish and Catalan in much the way

fRandi's winrk hlirs the lines hatwean architectire and arhwark
[« il

v
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Figure 8-11: Click the Swap arrow between elements to
switch them.
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3. Format the text, images, and other elements as desired for the desktop
design.

All other visual formatting options covered in the preceding exercise, in
which you created a tablet layout, are available. For example, you can
drag the handle from right to left to resize an element in the desktop
layout, just as you did in the tablet layout.

4. Choose Filer>Save All to save all the files in the fluid grid layout.

When you’re editing a fluid grid layout, you’re making changes to the
HTML file as well as to an external style sheet. Using the Save All option
ensures that you have saved all the necessary files before you preview
them or publish your site to a web server.

Switching among layouts to continue editing

It’s good practice to design fluid grid layouts in the order of the three preced-
ing exercises: first the mobile version, then the tablet version, and finally the

desktop version. You can, however, switch among these three layouts as you
refine your designs.

Keep in mind the following few general rules and best practices:

» Fluid grid layouts are created using media queries. Those media queries
act as dividers between each of the sets of styles that format the mobile,
tablet, and desktop layouts.

v~ If you study the corresponding styles that format these fluid grid lay-
outs, you will find three sets of styles, each using the same names. Thus,
when you edit styles, you need to take care that you're editing the styles
that correspond to the layout you want to work on: Select the corre-
sponding element in the workspace with the targeted layout displayed.

1~ If you view the corresponding styles that are automatically created in
code view, you will see that widths and other sizes are specified to the
fourth decimal point, for example, width: 48.2758%. Resist the urge to
round off these numbers. If you change these numbers in code view,
Dreamweaver will no longer automatically adjust them for you. These
sizes are set as percentages so that the layout will adjust fluidly.

» When you create styles that you want to apply to all three layouts, first
select Any Media from the @Media panel in the CSS Designer panel, as
shown in Figure 8-12.

235



236 Part II: Creating Page Designs with Style

bailerplate. css

My-CE3E C3% -

ahdedia
AN MEDIA
only zoreen and [ min-width ; 487px ]

only zoreen and [ min-width © FE9ps |

0

img. object, embed, video

[v]

.k img

Fluid

FluidList
_gridCaontainer
.nay

header

Figure 8-12: All the styles that correspond to
these fluid grid layouts are available from the
CSS Designer panel.

Creating Custom Media Queries

When you create pages using fluid grid layout features, Dreamweaver auto-
matically creates the corresponding media queries for you, but you can
create your own custom media queries and use them to target your own
CSS rules.

Many large, complicated websites, such as the Boston Globe, use six or more
media queries to target different screen sizes. Visit www.BostonGlobe.com
on your computer and then drag the edge of the browser window from right
to left, slowly making the browser window smaller, and you’ll see how the
media querie